CFX96™ and CFX384™ Real-Time PCR Detection Systems

Instruction Manual

Catalog # 184-5384
# 185-5384
# 184-5096
# 185-5096
LICENSE NOTICE TO PURCHASER

Bio-Rad Real-time thermal cycler CFX96 or CFX384 is licensed real-time thermal cycler(s) under Applera’s United States Patent No. 6,814,934 B1 for use in research and for all other fields except the fields of human diagnostics and veterinary diagnostics.

This CFX96 or CFX384 detection module, when combined with a C1000 thermal cycler for which the applicable real-time thermal cycler royalty fee has been paid, constitutes a real-time thermal cycler licensed under U.S. Patent No. 6,814,934 and corresponding claims in any Canadian counterpart patent thereof owned by Applera Corporation, for use solely in research and all applied fields except human and veterinary in vitro diagnostics. These license rights are effective only if this detection module is combined with a Bio-Rad thermal cycler for which the applicable real-time thermal cycler royalty fee has been paid and not with any other thermal cycler. No rights are conveyed expressly, by implication or estoppel to any patents on real-time methods, including but not limited to 5’ nuclease assays, or to any patent claiming a reagent or kit. For further information on purchasing license rights, contact the Director of Licensing at Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California, 94404, USA.

This product is covered by one or more of the following U.S. patents, their foreign counterparts, or their foreign patents pending, owned by Eppendorf AG: US Patent Nos. 6,767, 512 and 7,074,367. No rights are conveyed expressly, by implication or estoppel to any patents on PCR methods, or to any patent claiming a reagent or kit.

Bio-Rad’s Hard-Shell® plates are covered by one or more of the following U.S. patents, patents pending, or their foreign counterparts, owned by Eppendorf AG: US Patent Nos. 7,347,977, 6,340,589, 6,528,302 and US application 2007246858, 20080084004, 20030180192 and 20060120927.
Bio-Rad Resources

Bio-Rad provides many resources for scientists. The following websites contain useful information about running PCR and real-time PCR experiments:

- **Gene Expression Gateway (www.bio-rad.com/genomics/)**
  This site provides rich technical resources on a wide variety of methods and applications related to PCR, real-time PCR, and gene expression

- **Life Science Research website (discover.bio-rad.com)**
  This site includes links to technical notes, manuals, product information, and technical support.

Table 1 lists other Bio-Rad resources and how to locate what you need:

### Table 1. Bio-Rad resources

<table>
<thead>
<tr>
<th>Resource</th>
<th>How to Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Bio-Rad Laboratories</td>
<td>Find local information and contacts on the Bio-Rad website by selecting your</td>
</tr>
<tr>
<td>representatives</td>
<td>country on the home page (<a href="http://www.bio-rad.com">www.bio-rad.com</a>). Find</td>
</tr>
<tr>
<td></td>
<td>the nearest international office listed on the back of this manual.</td>
</tr>
<tr>
<td>Technical notes and literature</td>
<td>Go to the Bio-Rad website (<a href="http://www.bio-rad.com">www.bio-rad.com</a>) or Gene</td>
</tr>
<tr>
<td></td>
<td>Expression Gateway (<a href="http://www.bio-rad.com/genomics/">www.bio-rad.com/genomics/</a>). Type a</td>
</tr>
<tr>
<td></td>
<td>search term in the Search box and select Literature to find links to technical</td>
</tr>
<tr>
<td></td>
<td>notes, manuals, and other literature.</td>
</tr>
<tr>
<td>Technical specialists</td>
<td>Bio-Rad's Technical Support department is staffed with experienced scientists</td>
</tr>
<tr>
<td></td>
<td>to provide customers with practical and expert solutions.</td>
</tr>
<tr>
<td></td>
<td>To find local technical support on the phone, contact your nearest Bio-Rad</td>
</tr>
<tr>
<td></td>
<td>office. For technical support in the United States and Canada, call 1-800-424-6723 (toll-free phone), and select the technical support option</td>
</tr>
</tbody>
</table>

Writing Conventions Used in this Manual

This manual explains how to safely set up and operate the CFX96 system or the CFX384 system. The manual uses the writing conventions listed in Table 2.

### Table 2. Conventions used in this manual

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIP:</td>
<td>Provides helpful information and instructions, including information</td>
</tr>
<tr>
<td></td>
<td>explained in further detail elsewhere in this manual</td>
</tr>
<tr>
<td>NOTE:</td>
<td>Provides important information, including information explained in</td>
</tr>
<tr>
<td></td>
<td>further detail elsewhere in this manual</td>
</tr>
<tr>
<td>WARNING!</td>
<td>Explains very important information about something that might damage</td>
</tr>
<tr>
<td></td>
<td>the researcher, damage an instrument, or cause data loss</td>
</tr>
<tr>
<td>X &gt; Y</td>
<td>Select X and then select Y from a toolbar, menu or software window</td>
</tr>
</tbody>
</table>

For information about safety labels used in this manual and on the CFX96 system or the CFX384 system, see, “Safety and Regulatory Compliance” on page iii.
Safety and Regulatory Compliance

For safe operation of the CFX96 system or the CFX384 system, we strongly recommend that you follow the safety specifications listed in this section and throughout this manual.

Safety Warning Labels

Warning labels posted on the instrument and in this manual warn you about sources of injury or harm. Refer to Table 3 to review the meaning of each safety warning label.

Table 3. Meaning of safety warning labels

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>CAUTION: Risk of danger! This symbol identifies components that pose a risk of personal injury or damage to the instrument if improperly handled. Wherever this symbol appears, consult the manual for further information before proceeding</td>
</tr>
<tr>
<td><img src="image" alt="Hot Surface" /></td>
<td>CAUTION: Hot surface! This symbol identifies components that pose a risk of personal injury due to excessive heat if improperly handled</td>
</tr>
</tbody>
</table>

Instrument Safety Warnings

The warning labels shown in Table 4 also display on the instrument, and refer directly to the safe use of the CFX96 system or the CFX384 system.

Table 4. Instrument Safety Warning Labels

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Warning about risk of harm to body or equipment. Operating the CFX96 or CFX384 real-time PCR detection system before reading this manual can constitute a personal injury hazard. For safe use, do not operate this instrument in any manner unspecified in this manual. Only qualified laboratory personnel trained in the safe use of electrical equipment should operate this instrument. Always handle all components of the system with care, and with clean, dry hands</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Warning about risk of burning. A thermal cycler generates enough heat to cause serious burns. Wear safety goggles or other eye protection at all times during operation. Always allow the sample block to return to idle temperature before opening the lid and removing samples. Always allow maximum clearance to avoid accidental skin burns</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Warning about risk of explosion. The sample blocks can become hot enough during the course of normal operation to cause liquids to boil and explode</td>
</tr>
</tbody>
</table>

NOTE: For information about the C1000™ thermal cycler, refer to the C1000 thermal cycler instruction manual.
Safe Use Specifications and Compliance

Table 5 lists the safe use specifications for the CFX96 system or the CFX384 System. Shielded cables (supplied) must be used with this unit to ensure compliance with the Class A FCC limits.

**Table 5. Safe Use Specifications**

<table>
<thead>
<tr>
<th>Safe Use Requirements</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>Indoor use Ambient temperature of 15—31°C. Relative humidity maximum of 80% noncondensing</td>
</tr>
<tr>
<td>Altitude</td>
<td>Up to 2,000 meters above sea level</td>
</tr>
</tbody>
</table>

**REGULATORY COMPLIANCE**

This instrument has been tested, and found to be in compliance with all applicable requirements of the following safety and electromagnetic standards:

- EN 61326-1:2006 (Class A) Electrical equipment for measurement, control and laboratory use. EMC requirements, Part 1: General requirements

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.
Table of Contents

Bio-Rad Resources ............................................................... ii
Writing Conventions Used in this Manual ............................... ii
Safety and Regulatory Compliance ........................................ iii

Chapter 1. System Installation .............................................. 1
Unpacking the Optical Reaction Module ................................ 1
System Requirements ......................................................... 1
System Overview ............................................................. 2
Setting up the system ......................................................... 3
Installing CFX Manager Software ......................................... 6
Running Experiments ......................................................... 9

Chapter 2. Introduction to CFX Manager Software ..................... 11
Main Software Window ..................................................... 11
Startup Wizard ............................................................... 15
Detected Instruments Pane ................................................ 16
Instrument Properties Window ............................................ 18
Software Files ............................................................... 20
Tips and Tricks ............................................................... 20

Chapter 3. Running Experiments .......................................... 21
Experiment Setup Window .................................................. 21
Protocol Tab ................................................................. 22
Plate Tab ................................ ......................................... 23
Start Run Tab ............................................................... 24
Run Details Window ......................................................... 25
Instrument Summary Window .............................................. 28

Chapter 4. Protocols .......................................................... 31
Protocol Editor Window ..................................................... 31
Protocol Editor Controls ................................................... 33
Temperature Control Mode ................................................. 37
Protocol AutoWriter ......................................................... 37
# Table of Contents

## Chapter 5. Plates
- Plate Editor Window ........................................ 41
- Select Fluorophores Window .................................. 45
- Experiment Settings Window .................................. 48
- Well Groups Manager Window ................................ 50
- Plate Spreadsheet View Window ............................... 51

## Chapter 6. Stand-Alone Operation
- Control Panel .................................................. 53
- Main Menu ...................................................... 54
- Experiment Setup ............................................. 55
- Exporting Data for Analysis .................................. 61
- Creating a Data File .......................................... 64
- Setting Up Email .............................................. 65

## Chapter 7. Data Analysis Overview
- Data Analysis Window ........................................ 69
- Data Analysis Menu Bar ....................................... 71
- Quantitation Tab ............................................... 72
- Data Analysis Settings ....................................... 73
- Well Selectors .................................................. 75
- Charts ............................................................ 78
- Spreadsheets .................................................... 79

## Chapter 8. Data Analysis Windows
- Quantitation Tab ............................................... 81
- Quantitation Data Tab ......................................... 85
- Melt Curve Tab ................................................ 87
- Melt Curve Data Tab .......................................... 89
- End Point Tab .................................................. 91
- Allelic Discrimination Tab ................................... 93
- QC Tab .......................................................... 95
- Reports for Data Files ......................................... 97

## Chapter 9. Gene Expression Analysis
- Gene Expression .............................................. 101
- Plate Setup for Gene Expression Analysis ................. 102
- Gene Expression Tab ......................................... 102
- Experiment Settings Window ................................ 107
- Gene Study ...................................................... 109
- Gene Study Data Spreadsheet ................................. 112
- Gene Study Report Window ................................... 113
- Frequently Asked Questions ................................. 114
- Gene Expression Calculations ............................... 115
Table of Contents
1 System Installation

Read this chapter for information about setting up the CFX96 or CFX384 system:

- Unpacking the optical reaction module (below)
- System requirements (page 1)
- System overview (page 2)
- Setting up the system (page 3)
- Installing CFX Manager software (page 6)
- Running experiments (page 9)

Unpacking the Optical Reaction Module

Your CFX96 or CFX384 optical reaction module shipment includes these components:

- Optical reaction module
- USB cable
- CFX Manager™ software installation CD
- Instruction manual
- CFX Manager software quick guides for system installation, protocol, plate, data analysis, and gene expression analysis

Remove all packing materials and store them for future use. If any items are missing or damaged, contact your local Bio-Rad office.

System Requirements

To operate the CFX96 or CFX384 system, use the following power sources and cables:

- **Input power.** 100—240 VAC, 50—60 Hz
- **Indoor use.** Ambient temperature of 15—31°C. Relative humidity maximum of 80% (non-condensing)
- **USB cable.** If the CFX96 system is going to be controlled by a computer via a USB cable, the provided cable from Bio-Rad is sufficiently shielded for use.

NOTE: For a full list of the safety and compliance requirements for this instrument, see “Safety and Regulatory Compliance” on page iii.
System Overview

The CFX96 system or CFX384 system includes two components:

- **Optical reaction module.** This module includes an optical system to collect fluorescent data and a thermal cycler block.
  
  NOTE: The serial number of the CFX96 or CFX384 module is located on the back.

- **C1000™ thermal cycler base.** The C1000 base includes a user interface to control the system when running in stand-alone mode and the power button and ports (both on back panel) to connect to a computer.

![Image of CFX96 system](image1)

**Figure 1. Front view of the CFX96 system.**

When open, the CFX96 or CFX384 system includes the features shown in Figure 2.

![Image of CFX96 system inside](image2)

**Figure 2. Inside view of the CFX96 system.**

⚠️ **WARNING!** Avoid touching the inner lid or block: These surfaces can be hot.
• **Inner lid with heater plate.** The heater lid maintains temperature on the top of the consumable to prevent sample evaporation. Avoid touching or otherwise contaminating the heater plate. Never poke anything through the holes; the optics shuttle system could be damaged.

• **Block.** Load samples in this block before the run

• **Close button.** Press this button on the inside of the lid to close the motorized lid

**WARNING!** Prevent contamination of the instrument by spills, and never run a reaction with an open or leaking sample lid. For information about general cleaning and maintenance of the instrument, see “Instrument Maintenance” (page 133).

The back panel of the C1000 chassis includes these features (Figure 3):

• **Power switch.** Press the power switch to turn on the power to the system

• **Power input.** Plug in the power cord here

• **Ethernet port.** Connect an ethernet cable to email run logs and stand-alone data files

• **USB connections.** Use these ports to connect the CFX96 system or CFX384 system to a computer or to connect an S1000™ thermal cycler

![Figure 3. Back panel of C1000 thermal cycler.](image)

**WARNING!** Avoid contact with the back panel of the C1000 during operation.

**Setting up the system**

The CFX96 or CFX384 real-time PCR detection system should be installed on a clean, dry, level surface with sufficient cool airflow to run properly. The CFX96 system or CFX384 system can be run in two modes: stand-alone or software-controlled. If you are running the system under software-controlled mode, make sure there is sufficient space for a computer during setup.

To insert the CFX96 or CFX384 optical reaction module into the reaction module bay of the C1000 chassis, follow these instructions:

1. Place the C1000 chassis in a suitable location with the locking bar down. Remove any previously installed reaction modules.
2. Lift the optical reaction module using the handle indents above the side air vents (Figure 4).

![Figure 4. Lifting the optical reaction module into the C1000 chassis.](image)

3. Position the module in the reaction module bay of the C1000 chassis, leaving about 2 cm of space in the front. When in the chassis bay, the optical module should be covering the Bio-Rad logo in front of the bay of the C1000 chassis.

4. Reach around and pull up the locking bar of the C1000 until it is flush with the sides of the module bay. This action moves the module forward, locking it into place (Figure 5).

![Figure 5. Locking the optical module into place.](image)
5. Check that the module is completely and evenly seated in the C1000 base. As shown in Figure 6, check the space around the bottom of the module. There should be no extra space between the module and the base; the space should be even.

NOTE: If the space between the module and C1000 base is uneven, reinstall the module starting from Step 2 (page 4).

6. Plug the power cord into the back of the C1000 base (Figure 3 on page 3), and into an appropriate three-pronged electrical outlet.

7. Press the power switch on the back panel of the C1000 thermal cycler to start the system.

8. Follow the instructions in the C1000 front panel to remove the red shipping screw from the inner heater lid (Figure 7). Turn the screw counterclockwise to lift it out of the hole.

### Shipping Screw Status

- **Shipping Screw is inserted.**
  
  1. Open Optical Module lid -- press manual button below the Bio-Rad logo.
  2. Remove RED Shipping Screw from hole adjacent to left side of well B1
  4. Press F1 (Screw Removed) to confirm Shipping Screw has been removed.

To check/remove the shipping screw status follow the instructions above.

### Figure 7. Instructions to remove the shipping screw.
NOTE: If the shipping screw is not removed at this step, it will be detected by CFX Manager software. Follow the instructions in the software to remove the screw (page 19).

TIP: The shipping screw must be in place when the module is shipped. Save this screw in a safe place for future shipping.

9. Remove the shipping plate from the thermal cycler block to operate.

### Installing CFX Manager Software

CFX Manager software is run on a PC computer with either the Windows XP or Windows Vista operating system and is required to analyze real-time PCR data from the CFX96 system or CFX384 system. This software can also be used to control the CFX96 system or CFX384 system in software-controlled mode. Table 6 lists the computer system requirements for the software on Windows XP and Windows Vista.

#### Table 6. Computer requirements for CFX Manager software

<table>
<thead>
<tr>
<th>System</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows XP Professional SP2 and Above or</td>
<td>Windows XP Professional SP2 and Above</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Home Premium and above</td>
<td>Windows Vista Home Premium and above</td>
</tr>
<tr>
<td>Drive</td>
<td>CD-ROM drive</td>
<td>CD-RW drive</td>
</tr>
<tr>
<td>Hard drive</td>
<td>10 GB</td>
<td>20 GB</td>
</tr>
<tr>
<td>Processor speed</td>
<td>2.0 GHz</td>
<td>2.0 GHz</td>
</tr>
<tr>
<td>RAM</td>
<td>1 GB RAM (2 GB for Windows Vista)</td>
<td>2 GB RAM</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1024 x 768 with true-color mode</td>
<td>1280 x 1024 with true-color mode</td>
</tr>
<tr>
<td>USB</td>
<td>USB 2.0 Hi-Speed port</td>
<td>USB 2.0 Hi-Speed port</td>
</tr>
<tr>
<td>Internet browser</td>
<td>Internet Explorer</td>
<td>Internet Explorer</td>
</tr>
<tr>
<td>Software</td>
<td></td>
<td>Microsoft Office Suite</td>
</tr>
</tbody>
</table>

NOTE: Running a CFX96 or CFX384 system with CFX Manager Software on a PC computer with a Windows 64-bit Operating Systems is not supported due to incompatible USB Drivers. A PC computer with a 64-bit processor (like Intel) on a 32-bit Windows Operating System is supported.

#### To install CFX Manager software:

1. The software must be installed on the computer by a user with administrative privileges. Make sure you are logged in with administrative privileges.

2. Place the CFX Manager software CD in the computer’s CD drive.
3. The software launch page should appear automatically. Double-click **Install Software** on the software launch page (Figure 8).

![Figure 8. Software installation screen.](image)

TIP: Click the **Documentation** button to find searchable PDF copies of the instrument manuals and other documentation.

4. Follow the instructions on screen to complete installation. When completed, the Bio-Rad CFX manager software icon will appear on the desktop of the computer.

5. If the launch page does not appear automatically, double-click on (CD drive)\Bio-Rad CFX, then open and follow instructions in the Readme.txt file. See “Installing the Software Manually” on page 136.

**Installing the Drivers**

If the CFX96 system or CFX384 system is going to be run in **Software-controlled mode**, drivers must be installed on the computer. Use only the supplied USB cable, which is sufficiently shielded to prevent data loss.

**To install the system drivers:**

1. Connect the C1000 chassis to the computer by plugging a USB cable into the USB 2.0 A port located on the back of the chassis (Figure 3 on page 3), and then connecting the cable into the USB 2.0 B port located on the computer.

2. If it is not already turned on, turn on the system using the power switch on the back of the C1000 chassis. Follow the instructions in the **Found New Hardware Wizard** that launches after the instrument is first detected by the computer.
3. On the first screen, select **Yes, this time only** to instruct the Windows operating system to connect to Windows Update to search for software (Figure 9). Click **Next**.

![Figure 9. Found New Hardware Wizard.](image)

4. Instruct the wizard to **"Install the software automatically."** Click **Next** to continue installing the drivers (Figure 10).

![Figure 10. Software (Driver) installation screen.](image)

5. Click **Finish** at the software installation completion screen when the drivers are installed.
Running Experiments

Recommended Plastic Consumables

Run only 384-well plates in the CFX384 system. For optimal results, Bio-Rad recommends the following consumables for the CFX384 system (catalog numbers are provided in bold):

- **HSP-3805.** Low-profile 384-well Hard-Shell® plates with clear shell and white wells
- **HSP-3866.** Low-profile 384-well Hard-Shell plates with black shell and white wells
- **MSB-1001.** Microseal ‘B’ adhesive seals, optically clear

The CFX96 system accepts both low profile 0.2 ml plates and tubes. For optimal results, Bio-Rad recommends the following consumables:

- **MLL-9601.** Low-profile 96-well unskirted plates with clear wells
- **MLL-9651.** Low-profile 96-well unskirted plates with white wells
- **HSP-9601.** Hard-Shell 96-well skirted plates with white shell and clear wells
- **HSP-9655.** Hard-Shell 96-well skirted plates with white shell and white wells
- **TLS-0801.** Low-profile 0.2 ml 8-tube strips without caps, clear wells
- **TLS-0851.** Low-profile 0.2 ml 8-tube strips without caps, white wells
- **TCS-0803.** Optical flat 8-cap strips, for 0.2 ml tubes and plates
- **MSB-1001.** Microseal ‘B’ adhesive seals, optically clear

Loading the Block

To load your reactions in the block, follow these suggestions:

- Click the **Open Lid** button located on software’s Start Run tab (see “Start Run Tab” on page 24), or press the lid button on the front of the system (Figure 1) to start opening the motorized lid.
  
  **WARNING!** The lid moves slowly at first, and then increases speed when it opens or closes.

- Place the 0.2 ml microplate or tube strips with sealed lids in the block. Check that the tubes are completely sealed to prevent leakage. For optimal results load sample volumes of 10–25 μl for the CFX96 system and load sample volumes of 5–20 μl for the CFX384 system.

  **NOTE:** For accurate data analysis, check that the orientation of reactions in the block is exactly the same as the orientation of the well contents in the software Plate tab (see "Plate Tab" on page 23). If needed, edit the well contents before, during, or after the run. As shown in Figure 11 on page 10, rotating the microplate by 180° causes the software to expect the reading for well H3 to be an empty A10 well.
WARNING! When running the CFX96 system, always balance the tube strips or cut microplates in the wells (Figure 12). For example, if you run one tube strip on the left side of the block, run an empty tube strip (with caps) on the right side of the block to balance the pressure applied by the heated lid.

WARNING! Be sure that nothing is blocking the lid when it closes. Although there is a safety mechanism to prevent the lid from closing if it senses an obstruction, do not place anything in the way of the closing lid.
2 Introduction to CFX Manager Software

Read this chapter for information about getting started with CFX Manager software.

- Main software window (below)
- Startup Wizard (page 15)
- Detected Instruments pane (page 16)
- Instrument Properties window (page 18)
- Software files (page 20)
- Tips and tricks (page 20)

Main Software Window

For instructions about running the system, refer to one of the CFX Manager software quick guides that ships with the system:

- Installation quick guide
- Protocol quick guide
- Plate quick guide
- Data Analysis quick guide
- Gene Expression Analysis quick guide

TIP: See the software Help for more guides about running experiments.

Get started in the main software window by using these features (Figure 13):

- **Status bar.** View the current software and instrument status (page 12)
- **Menu bar.** Select software commands (page 12), such as creating or opening files
- **Toolbar buttons.** Click these buttons (page 14) to open software files, the Startup Wizard (page 18), the Experiment Setup window (page 21)
- **Detected Instruments pane.** View a list of attached instruments (page 15)
• **Startup Wizard window.** Access common software commands (page 16)

![Image of Startup Wizard window]

**Figure 13. The main software window.**

**Status Bar**

The status bar at the bottom of the main software window shows the status of the software. View the left side of the status bar (Figure 14) to see the current status of instruments.

![Image of left side of status bar]

**Figure 14. Left side of status bar in main software window.**

View the right side of the status bar (Figure 15) to see the current user name, date, and time.

![Image of right side of status bar]

**Figure 15. Right side of status bar in the main software window.**

Click and drag the right corner of the status bar to resize the main window.

**Menu Bar**

The menu bar of the main software window provides the items listed in Figure 16:

![Image of menu bar]

**Figure 16. Menu bar in the main software window.**
Select the commands shown in the menu bar (Table 7).

**Table 7. Menu bar items in the main software window**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>New</td>
<td>Create a new protocol, plate, experiment, or Gene Study</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Open existing files, including protocol (.prcl), plate (.pltd), data (.pcrd), and Gene Study (.mgxd) files, stand-alone run files (.zpcr)</td>
</tr>
<tr>
<td></td>
<td>Recent Data Files</td>
<td>View a list of the ten most recently viewed data files, and select one to open in Data Analysis</td>
</tr>
<tr>
<td></td>
<td>Repeat an Experiment</td>
<td>Open the Experiment Setup window with the protocol and plate from a completed run to quickly repeat the run</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Exit the software program</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Application Log</td>
<td>Display the application log for the software</td>
</tr>
<tr>
<td></td>
<td>Run Reports</td>
<td>Select a run report to review from a list</td>
</tr>
<tr>
<td></td>
<td>Startup Wizard</td>
<td>Open the Startup Wizard</td>
</tr>
<tr>
<td></td>
<td>Experiment Setup</td>
<td>Open the Experiment Setup window</td>
</tr>
<tr>
<td></td>
<td>Instrument Summary</td>
<td>Open the Instrument Summary window</td>
</tr>
<tr>
<td></td>
<td>Detected Instruments</td>
<td>Show or hide the Detected Instruments pane</td>
</tr>
<tr>
<td></td>
<td>Toolbar</td>
<td>Show or hide the main software window toolbar</td>
</tr>
<tr>
<td></td>
<td>Status Bar</td>
<td>Show or hide the main software window status bar</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>Select User</td>
<td>Open the Select User window to change software users</td>
</tr>
<tr>
<td></td>
<td>Change Password</td>
<td>Change your user password</td>
</tr>
<tr>
<td></td>
<td>User Preferences</td>
<td>Open the User Preferences window</td>
</tr>
<tr>
<td></td>
<td>User Administration</td>
<td>Manage users in the User Administration window</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td>Dye Calibration Wizard</td>
<td>Open the Dye Calibration window to calibrate an instrument for a new fluorophore</td>
</tr>
<tr>
<td></td>
<td>Protocol AutoWriter</td>
<td>Open the Protocol AutoWriter window to create a new protocol</td>
</tr>
<tr>
<td></td>
<td>Ta Calculator</td>
<td>Open the Ta Calculator window to calculate the annealing temperature of primers</td>
</tr>
<tr>
<td></td>
<td>View Block Status Log</td>
<td>View a log of the thermal cycler block</td>
</tr>
<tr>
<td></td>
<td>Application Data Folder</td>
<td>Open the Application Data folder to view software files</td>
</tr>
<tr>
<td></td>
<td>User Data Folder</td>
<td>Open the Data folder to view protocol, plate, and data files</td>
</tr>
<tr>
<td></td>
<td>Properties All Instruments</td>
<td>View properties of all detected instruments, including serial numbers</td>
</tr>
<tr>
<td></td>
<td>Zip Data and Log Files</td>
<td>Choose and condense selected files in a zipped file for storage or to email</td>
</tr>
<tr>
<td></td>
<td>Options</td>
<td>Configure software email settings</td>
</tr>
</tbody>
</table>
Introduction to CFX Manager Software

Table 7. Menu bar items in the main software window (continued)

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Cascade</td>
<td>Arrange software windows on top of each other</td>
</tr>
<tr>
<td></td>
<td>Tile Vertical</td>
<td>Arrange software windows from top to bottom</td>
</tr>
<tr>
<td></td>
<td>Tile Horizontal</td>
<td>Arrange software windows from right to left</td>
</tr>
<tr>
<td></td>
<td>Close All</td>
<td>Close all open software windows</td>
</tr>
<tr>
<td>Help</td>
<td>Contents</td>
<td>Open the software Help for more information about running PCR and real-time PCR</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>View the index in the software Help</td>
</tr>
<tr>
<td></td>
<td>Search</td>
<td>Search the software Help</td>
</tr>
<tr>
<td></td>
<td>Gene Expression Gateway Web site</td>
<td>Open a web site to find information about running PCR and real-time PCR experiments</td>
</tr>
<tr>
<td></td>
<td>PCR Reagents Website</td>
<td>View a website that lists Bio-Rad consumables for PCR and real-time PCR reagents</td>
</tr>
<tr>
<td></td>
<td>PCR Plastic Consumables Website</td>
<td>View a website that lists Bio-Rad consumables for PCR and real-time PCR experiments</td>
</tr>
<tr>
<td></td>
<td>Software Updates</td>
<td>Check for software updates from Bio-Rad</td>
</tr>
<tr>
<td></td>
<td>About</td>
<td>Open a window to see the software version</td>
</tr>
</tbody>
</table>

Table 8. Toolbar buttons in the main software window

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open a Data File" /></td>
<td>Open a Data File</td>
<td>Open a browser window to locate a data file (*.pcrd extension) and open it in the Data Analysis window (page 69)</td>
</tr>
<tr>
<td><img src="image" alt="Open a Gene Study" /></td>
<td>Open a Gene Study</td>
<td>Open a browser window to locate a Gene Study file (*.mgxd extension) and open it in the Gene Study window (page 101)</td>
</tr>
<tr>
<td><img src="image" alt="Create a New Gene Study" /></td>
<td>Create a New Gene Study</td>
<td>Open the Gene Study window (page 101) to add files and create a new study</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
<td>Print the current software window</td>
</tr>
<tr>
<td><img src="image" alt="Startup Wizard" /></td>
<td>Startup Wizard</td>
<td>Open the Startup Wizard that links you to common software functions (page 16)</td>
</tr>
</tbody>
</table>
Startup Wizard

The Startup Wizard automatically appears when CFX Manager software is first opened (Figure 17). If it is not shown, click the **Startup Wizard** button on the main software window toolbar.

**Table 8. Toolbar buttons in the main software window (continued)**

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Experiment Setup" /></td>
<td>Experiment Setup</td>
<td>Open the Experiment Setup window to run an experiment (page 21)</td>
</tr>
<tr>
<td><img src="image" alt="Protocol AutoWriter" /></td>
<td>Protocol AutoWriter</td>
<td>Open the Protocol AutoWriter window to create a new protocol (page 37)</td>
</tr>
<tr>
<td><img src="image" alt="Select User" /></td>
<td>Select User</td>
<td>Open the Select User window to change software users (see “Log in or Select User” on page 121)</td>
</tr>
<tr>
<td><img src="image" alt="User Preferences" /></td>
<td>User Preferences</td>
<td>Open the User Preferences window (page 121)</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Help</td>
<td>Open the software Help window for more information about running PCR and real-time PCR</td>
</tr>
</tbody>
</table>

**Figure 17. Startup Wizard window.**

Options in the Startup Wizard include the following:
• **Create a new Experiment (page 21).** Set up the protocol and plate to begin a new experiment.
  
  NOTE: Select the appropriate instrument in the pull down list to make sure the default plate settings match the instrument to be used for the experiment.

• **Repeat an Experiment.** Set up an experiment with the protocol and plate from a completed run. If needed, you can edit the experiment before the run

• **Open a Data File (page 69).** Open a data file to analyze results

• **Open a Gene Study (page 101).** Open a multi-file gene expression study to analyze results from multiple gene expression experiments

• **Open User Preferences (page 121).** Open the User Preferences window to customize software settings

### Detected Instruments Pane

CFX Manager software runs these 1000-series instruments:

- **CFX96 and CFX384 real-time PCR systems.** Systems include a C1000 thermal cycler and an optical reaction module

- **C1000 thermal cycler.** The most versatile of the instruments run by CFX Manager software. Add and remove these PCR reaction modules to the C1000 chassis in seconds:
  - 96-well fast reaction module, gradient enabled
  - 384-well reaction module
  - Dual 48/48 fast reaction module, gradient enabled

- **S1000 thermal cycler connected to a C1000 thermal cycler.** For more information, see S1000 and C1000 thermal cycler instruction manuals
  
  TIP: Locate PDF copies of the instruction manuals by opening the Documents folder on the CFX Manager software installation CD.

You can simultaneously run up to four instruments with CFX Manager software, including a combination of CFX96 system and CFX384 systems, or a mix of real-time PCR systems and thermal cyclers.

### Viewing Detected Instruments

Connected instruments appear in the Detected Instruments pane (page 17). This list shows each instrument as an icon named with the serial number (default). The list of instruments also shows individual blocks (Block A and Block B) for each dual block reaction module.

  TIP: Right-click any instrument in the Detected Instruments pane to open the Instrument Properties window and rename the instrument.

Figure 18 shows four detected instruments:

- One C1000 thermal cycler (C48FSIM00) with a dual 48/48 reaction module
- One S1000 thermal cycler (S96FSIM01) with a 96-well block, which is connected to the C1000 thermal cycler called C48FSIM00
- One CFX384 system (CFX384SIM03)
• One CFX96 system (CFX96SIM02)

![Diagram of Detected Instruments]

**Figure 18. Instruments listed at the top of the Detected Instruments pane.**

Right-click on the instrument icon or block to select one of these options:

- **View Status.** Open the Run Details window to check the status of the selected instrument block
- **Flash Block Indicator.** Flash the indicator LED on the instrument
- **Open Lid.** Open a motorized lid on the selected instrument block
- **Close Lid.** Close a motorized lid on the selected instrument block
- **Rename.** Change the name of the instrument
- **Properties.** Open the Instrument Properties window
- **Collapse All.** Collapse the list of instruments in the Detected Instruments pane
- **Expand All.** Expand the list of instruments in the Detected Instruments pane

You can also control a block by clicking an instrument block icon in the Detected Instruments pane and then clicking a button in the Selected Instrument pane (Figure 19).

![Diagram of Selected Instrument]

**Figure 19. Buttons at the bottom of the Detected Instruments pane.**

- Click **View Status** to open the Run Details window to check the status of the selected instrument block
- Click **Open Lid** to open the motorized lids on the selected instrument
- Click **Close Lid** to close the motorized lids on the selected instrument
- Click **View Summary** to open the Instrument Summary window
If only one instrument is detected, then the View Summary button does not appear. To view the Instrument Summary window for a single instrument, select View > Instrument Summary.

**Instrument Properties Window**

To open the Instrument Properties window to view information about an instrument, right-click on the instrument icon in the Detected Instruments pane (Figure 18 on page 17). The window includes three tabs (Figure 20):

- **Properties.** View serial numbers and the C1000 thermal cycler name
- **Shipping Screw.** Remove the shipping screw to run the instrument, or install the shipping screw when you want to transport the instrument
- **Calibrated Dyes.** View the list of calibrated fluorophores

![Instrument Properties window](Image)

**Figure 20. Instrument Properties window.**

**Properties Tab**

The default name for an instrument is the C1000 thermal cycler serial number, which appears in many locations, including the Detected Instruments pane (Figure 18).

To rename an instrument for ease of identification, follow these instructions:

- In the Instrument Properties tab, type a name in the Rename box at the top of the Properties tab and hit the Rename button to save the new name
  
  NOTE: In the Detected Instrument pane, right-click the instrument icon and select Rename to open the Instrument Properties window.

The Properties tab displays important serial numbers for the connected instrument, including the thermal cycler and reaction module. The firmware versions are also displayed.
**Shipping Screw Tab**

The Shipping Screw tab includes instructions for installing or removing the red shipping screw. To prevent damage to the optical reaction modules, install the shipping screw any time you ship the CFX96 system or CFX384 system.

NOTE: If the shipping screw is detected by the software, the Instrument Properties window automatically opens with the Shipping Screw tab in front. Follow the instructions to remove the screw.

The information in this tab changes depending on whether the shipping screw is installed or removed. For example, to install the shipping screw, click the **Install Shipping Screw** button and follow the instructions in the tab (Figure 21).

![Figure 21. Instructions for installing the shipping screw.](image)

**Calibrated Dyes Tab**

Open the Calibrated Dyes tab to view the list of calibrated fluorophores and plates for the selected instrument. Click an **Info** button to see detailed information about a calibration.

![Figure 22. Calibrated Dyes tab in the Instrument Properties window.](image)
Software Files

CFX Manager software stores information about experiments in specific files (Table 9):

Table 9. Open these file types with CFX Manager software

<table>
<thead>
<tr>
<th>File Type</th>
<th>Extension</th>
<th>How to View and Edit File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>.prcl</td>
<td>Select in Experiment Setup and edit in Protocol Editor</td>
</tr>
<tr>
<td>Plate</td>
<td>.pltd</td>
<td>Select in Experiment Setup and edit in Plate Editor</td>
</tr>
<tr>
<td>Data</td>
<td>.pcrd</td>
<td>View and analyze in Data Analysis window</td>
</tr>
<tr>
<td>Gene Study</td>
<td>.mgxd</td>
<td>View and analyze in Gene Study window</td>
</tr>
<tr>
<td>Stand-alone pre-data</td>
<td>.zpcr</td>
<td>Contains fluorescence readings from stand-alone operation that is converted into a data file</td>
</tr>
</tbody>
</table>

Tips and Tricks

Tips and tricks for using CFX Manager software are listed below.

- Open any Protocol, Plate, Data, or Gene Study file by dragging it from a folder to an open software window
- Print or export the information shown in many windows by right-clicking a chart, spreadsheet, or well selector
- Change the size of any window by clicking and dragging the edges
- Open the User Preferences window to choose default settings that activate every time you log in to the software
- Add data files to a Gene Study by dragging from a folder to an open Gene Study window
- Open multiple Data Analysis and Gene Study files at the same time
- Click the Settings or Tools menus to find advanced functions
- To add or delete files from the Express Load menu, add or delete the files (.prcl and .pltd extensions) in the ExpressLoad folder, select Tools > User Data Folder in the menu bar of the main software window
- To view all the information loaded into one well in a plate, double-click the well to open the Well Info window
- Right-click any graph or chart to change viewing and data analysis options
- Edit well contents before, during, or after the run
- Select a well group to view and analyze a subset of the wells in the plate. Select each well group by name in the Well Group pull-down menu in the toolbar
3 Running Experiments

Read this chapter for information about running experiments using CFX Manager software:

- Experiment Setup window (below)
- Protocol tab (page 22)
- End point only runs (page 22)
- Plate tab (page 23)
- Start Run tab (page 24)
- Run Details window (page 26)
- Instrument Summary Window (page 28)

Experiment Setup Window

The Experiment Setup window provides quick access to the files and settings needed to set up and run an experiment. To open the Experiment Setup window, follow one of these options:

- Click Create a New Experiment option in the Startup Wizard (page 16)
- Click the Experiment Setup button in the main software toolbar (page 14)
- Select File > New > Experiment in the main software menu bar (page 12)

The Experiment Setup window includes three tabs:

- **Protocol**. Click the Protocol tab to select an existing protocol to run or edit, or to create a new protocol in the Protocol Editor window (page 31)
- **Plate**. Click the Plate tab to select an existing plate to run or edit, or to create a new plate in the Plate Editor window (page 41)
- **Start Run**. Click the Start Run tab (page 24) to check the run settings, select one or more instrument blocks, and begin the run

NOTE: If the protocol currently selected in the Protocol tab does not include a step with a plate read for real-time PCR analysis, then the Plate tab is hidden. To view the Plate tab, add a “Plate Read” (page 34) in at least one step in the protocol.

NOTE: Start a new experiment from a previous run by selecting File > Repeat an Experiment in the main software menu bar. Then select the data file (.pcrd) for the experiment you want to repeat.
Running Experiments

The Experiment Setup window opens with the Protocol tab in front (Figure 23). To open another tab, click that tab or click Prev and Next buttons at the bottom of the window.

![Experiment Setup window, including the Protocol, Plate, and Start Run tabs.](image)

**Figure 23.** Experiment Setup window, including the Protocol, Plate, and Start Run tabs.

**Protocol Tab**

The Protocol tab shows a preview of the selected protocol file loaded in the Experiment Setup (Figure 23). A protocol file contains the instructions for the instrument temperature steps, as well as instrument options that control the ramp rate and lid temperature.

Select one of the following options to select an existing protocol, create a new protocol, or edit the currently selected protocol:

- **Create New button.** Open the Protocol Editor to create a new protocol
- **Select Existing button.** Open a browser window to select and load an existing protocol file (.prcl extension) into the Protocol tab
- **Express Load pull-down menu.** Quickly select a protocol to load it into the Protocol tab
  
  **TIP:** To add or delete protocols in the Express Load menu, add or delete files (.prcl extension) in the ExpressLoad folder. To locate this folder, select Tools > User Data Folder in the menu bar of the main software window
- **Edit Selected button.** Open the currently selected protocol in the Protocol Editor

**End Point Only Runs**

To run a protocol that contains only an end point data acquisition step, select Options > End Point Only Run from Options in the menu bar of the Experiment Setup window. The default end point protocol, which includes two cycles of 60.0°C for 30 seconds, is loaded into the Protocol tab.
Figure 24 shows the default end point protocol.

![End Point Only protocol](image)

**Figure 24. End Point Only protocol.**

To change the step temperature or sample volume for the end point only run, click the **Start Run** tab and edit the **Step Temperature** or **Sample Volume**. Figure 25 shows the step temperature is changed to 55.0°C.

![Change sample volume on Start Run tab](image)

**Figure 25. Change the sample volume on the Start Run tab.**

**Plate Tab**

The Plate tab shows a preview of the selected plate file loaded in the Experiment Setup (Figure 26). In a real-time PCR experiment, the plate file contains a description of the contents of each well, the scan mode, and the plate type. CFX Manager software uses these descriptions for data collection and analysis.

Select one of the following options to select an existing plate, create a new plate, or edit the currently selected plate:

- **Create New button.** Open the Plate Editor to create a new plate
- **Select Existing button.** Open a browser window to select and load an existing plate file (.pltd extension) into the Plate tab
- **Express Load pull-down menu.** Quickly select a plate to load it into the Plate tab

**TIP:** To add or delete plates in the **Express Load** menu, add or delete files (.pltd extension) in the **ExpressLoad** folder. To locate this folder, select **Tools > User Data Folder** in the menu bar of the main software window.
- **Edit Selected button.** Open the currently selected plate in the Plate Editor

![Figure 26. Plate tab window.](image)

### Start Run Tab

The Start Run tab (Figure 27) includes a section for checking information about the run that is going to be started, including the selected protocol and plate files, and a section for selecting the instrument block.

- **Run Information pane.** View the selected Protocol file, Plate file, and data acquisition Scan Mode setting. Enter optional notes about the experiment in the Notes box

- **Start Run on Selected Block(s) pane.** Select one or more blocks, edit run parameters (if necessary), and then click the Start Run button to begin the experiment

![Figure 27. The Start Run tab.](image)
By default, the **Start Run on Selected Block(s) pane** shows the block name, block type and status of each instrument detected by the software. These descriptions can not be edited.

**NOTE:** You can override the Sample Volume loaded in the Protocol file by selecting the volume in the spreadsheet cell and typing a new volume.

**NOTE:** A run ID can be entered for each block by selecting the cell and typing an ID or by selecting the cell and scanning with a bar code reader.

To add or remove run parameters from the spreadsheet in the **Start Run on Selected Block(s) pane**, right-click on the list and select an option in the menu to display. Choose the value to change by clicking the text inside the cell to select it and then typing in the cell, or by selecting a new parameter from the pull-down menu. Editable parameters include:

- **Lid Temperature.** View the temperature of the lid. Override the lid temperature by selecting the text and typing a new temperature

Table 10 shows additional options on the right-click menu in the Start Run on Selected Block(s) pane:

**Table 10. Start Run on Selected Block(s) right-click menu options**

<table>
<thead>
<tr>
<th>Right-Click Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copy selected text</td>
</tr>
<tr>
<td>Copy as Image</td>
<td>Copy an image of the Start Run on Selected Block(s) pane</td>
</tr>
<tr>
<td>Print...</td>
<td>Print the current view of the list of selected blocks</td>
</tr>
<tr>
<td>Print Selection...</td>
<td>Print the column that is currently selected</td>
</tr>
<tr>
<td>Export to Excel...</td>
<td>Export the list of blocks to an Excel spreadsheet file</td>
</tr>
<tr>
<td>Export to Text...</td>
<td>Export the list of blocks to a text file</td>
</tr>
<tr>
<td>Find...</td>
<td>Find text in the list of blocks</td>
</tr>
<tr>
<td>Sort...</td>
<td>Sort up to three columns in the list of blocks</td>
</tr>
</tbody>
</table>

**Buttons for Controlling the Instrument**

Click the following buttons in the Start Run tab to remotely operate the selected instruments:

- **Start Run.** Start the experiment on the selected instrument blocks
- **Flash Block Indicator.** Flash the indicator LED on the selected instrument blocks
- **Open Lid.** Open motorized lid on selected instrument blocks
- **Close Lid.** Close motorized lid on selected instrument blocks

**Run Details Window**

When you click the **Start Run** button, CFX Manager software prompts you to save the name of the data file and then opens the Run Details window. Review the information in this window to monitor the progress of a run.

- **Run Status tab.** Check the current status of the protocol, open the lid, pause a run, add repeats, skip steps, or stop the run
- **Real-Time Status tab.** View the real-time PCR fluorescence data as they are collected
- **Time Status tab.** View a full-screen countdown timer for the protocol
Running Experiments

Figure 28 shows the features of the Run Details window.

![Figure 28. Run Details window.]

### Run Status Tab

The Run Status tab (Figure 28) shows the current status of a run in progress in the Run Details window and provides buttons (page 26) to control the lid and change the run in progress.

- **Run Status pane.** Displays the current progress of the protocol, including the current step, current GOTO repeat, block temperature, remaining hold time for the current step, sample temperature, lid and shuttle temperature
- **Run Status buttons.** Click one of the buttons to remotely operate the instrument or to interrupt the current protocol
- **Run Information pane.** Displays experiment details

### Run Status Tab Buttons

Click one of the buttons listed in Table 11 to operate the instrument from the software, or to change the run that is in progress.

**NOTE:** Changing the protocol during the run, such as adding repeats, does not change the protocol file associated with the run. These actions are recorded in the Run Log.

**Table 11. Run Status buttons and their functions**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open Lid" /></td>
<td>Open the motorized lid on selected instruments</td>
</tr>
<tr>
<td><img src="image" alt="Close Lid" /></td>
<td>Close the motorized lid on selected instruments</td>
</tr>
</tbody>
</table>

**WARNING!** Opening the lid during a run pauses the run during the current step and might alter the data.
The Real-Time Status tab (Figure 29) shows real-time PCR data collected at each cycle during the protocol after the first two plate reads. This tab also shows the well selector and text describing the protocol status at the bottom of the window.

TIP: Click the View/Edit Plate button to open the Plate Editor window. During the run, you can enter more information about the contents of each well in the plate.

**Table 11. Run Status buttons and their functions (continued)**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Repeats</td>
<td>Add more repeats to the current GOTO step in the protocol. This button is only available when a GOTO step is running.</td>
</tr>
<tr>
<td>Skip Step</td>
<td>Skip the current step in the protocol. If you skip a GOTO step, the software verifies that you want to skip the entire GOTO loop and proceed to the next step in the protocol.</td>
</tr>
<tr>
<td>Flash Block Indicator</td>
<td>Flash the LED on the selected instrument to identify the selected blocks</td>
</tr>
<tr>
<td>Pause</td>
<td>Pause the protocol. NOTE: This action is recorded in the Run Log.</td>
</tr>
<tr>
<td>Resume</td>
<td>Resume a protocol that was paused</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop the run before the protocols ends, which may alter your data</td>
</tr>
</tbody>
</table>

**Real-Time Status Tab**

The Real-Time Status tab (Figure 29) shows real-time PCR data collected at each cycle during the protocol after the first two plate reads. This tab also shows the well selector and text describing the protocol status at the bottom of the window.

TIP: Click the View/Edit Plate button to open the Plate Editor window. During the run, you can enter more information about the contents of each well in the plate.

![Figure 29. The Real-time Status tab displays the data during a run.](image)
Replacing a Plate File

During a run, replace the plate file by clicking the Replace Plate button (Figure 29) in the Real-time Status tab. Select the new plate file (.pltd) from the list in the windows browser.

NOTE: CFX Manager software checks the scan mode and plate size for the plate file; these must match the run settings that were started during the experiment.

TIP: Replacing a plate file is especially useful if you start a run with a Quick Plate file in the Express Load folder.

Time Status Tab

The Time Status tab shows a countdown timer for the current run (Figure 30).

![Figure 30. The Time Status tab displays a count-down timer for the current run.](image)

Instrument Summary Window

The Instrument Summary window shows a list of the detected instruments and their status. Open the Instrument Summary by clicking the View Summary button (Figure 19 on page 17) in the Detected Instrument pane.

Figure 31 shows the Instrument Summary window, including the Block Name list and the current status of all detected instruments. Select one or more blocks and click the buttons in the tool bar to change the status of each instrument.

![Figure 31. Instrument Summary window.](image)
Instrument Summary Toolbar

The Instrument Summary toolbar includes buttons and functions listed in Table 12.

**Table 12. Toolbar buttons in the Instrument Summary window**

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Play]</td>
<td>Set Up Experiment</td>
<td>Set up an experiment on the selected block by opening the Experiment Setup window</td>
</tr>
<tr>
<td>![Stop]</td>
<td>Stop</td>
<td>Stop the current run on selected blocks</td>
</tr>
<tr>
<td>![Pause]</td>
<td>Pause</td>
<td>Pause the current run on selected blocks</td>
</tr>
<tr>
<td>![Resume]</td>
<td>Resume</td>
<td>Resume the run on selected blocks</td>
</tr>
<tr>
<td>![Flash]</td>
<td>Flash Block Indicator</td>
<td>Flash the indicator LED on the lid of the selected blocks</td>
</tr>
<tr>
<td>![Open Lid]</td>
<td>Open Lid</td>
<td>Open a selected block motorized lid</td>
</tr>
<tr>
<td>![Close Lid]</td>
<td>Close Lid</td>
<td>Close a selected block motorized lid</td>
</tr>
<tr>
<td>![Hide Selected Blocks]</td>
<td>Hide Selected Blocks</td>
<td>Hide the selected blocks in the Instrument Summary list</td>
</tr>
<tr>
<td>![Show All Blocks]</td>
<td>Show All Blocks</td>
<td>Show the selected blocks in the Instrument Summary list</td>
</tr>
<tr>
<td>![Show]</td>
<td>Show</td>
<td>Select which blocks to show in the list. Select one of the options to show all detected blocks, all idle blocks, all the blocks that are running with the current user, or all running blocks</td>
</tr>
</tbody>
</table>

Right-Click Menu

Right-click in the Instrument Summary window to change the list of options that appear:

- **Block Name.** View the name of the block
- **Type.** View the size and type of the block
- **Status.** View the current status of the block
- **User.** View the current user who is logged in to the software
- **Remaining.** View the time remaining in the current run
• **Copy.** Copy the entire list
• **Copy as Image.** Copy the list as an image file
• **Print.** Print the list
• **Print Selection.** Print only the selected cells in the list
• **Export to Excel.** Export the list as an Excel formatted file
• **Export to Text.** Export the list as a text file
• **Find.** Find text in the list
• **Sort.** Sort the list by selecting up to three columns of data in the Sort window
4 Protocols

Read the following chapter for information about creating and editing protocol files:

- Protocol Editor window (below)
- Protocol Editor controls (page 33)
- Temperature control mode (page 37)
- Protocol AutoWriter (page 37)

Protocol Editor Window

A protocol instructs the instrument to control the temperature steps, lid temperature, and other instrument options. Open the Protocol Editor window to create a new protocol or to edit the protocol currently selected in the Protocol tab. Once a Protocol is created or edited in the Protocol Editor, click OK to load the protocol file into the Experiment Setup window and run it.

Opening the Protocol Editor

To open the Protocol Editor, follow one of these options:

- To create a new protocol, select File > New > Protocol or click the Create New button in the Protocol tab (page 22)
- To open an existing protocol, select File > Open > Protocol, or click the Open Existing button in the Protocol tab (page 22)
- To edit the current protocol in the Protocol tab, click the Edit Selected button in the Protocol tab (page 22)

TIP: To change the default settings in the Protocol Editor window, enter the changes in the Protocol tab in the user Preferences window (page 124)

Protocol Editor Window

The Protocol Editor window (Figure 32) includes the following features:

- Menu bar. Select settings for the protocol
- Toolbar. Select options for editing the protocol
- Protocol. View the selected protocol in a graphic (top) and text (bottom) view. Click the temperature or dwell time in the graphic or text view of any step to enter a new value
• **Protocol Editor buttons.** Edit the protocol by clicking one of the buttons to the left of the text view.

![Figure 32. Protocol Editor window with buttons for editing protocols.](image)

**Protocol Editor Menu Bar**

The menu bar in the Protocol Editor window provides the menu items listed in Table 13.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Save</td>
<td>Save the current protocol</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Save the current protocol with a new name or in a new location</td>
</tr>
<tr>
<td></td>
<td>Close</td>
<td>Close the Protocol Editor</td>
</tr>
<tr>
<td>Settings</td>
<td>Lid Settings</td>
<td>Open the Lid Settings window to change or set the Lid Temperature</td>
</tr>
<tr>
<td>Tools</td>
<td>Gradient Calculator</td>
<td>Select the block type for a gradient step. Choose 96 Wells or 384 Wells</td>
</tr>
<tr>
<td></td>
<td>Run-time Calculator</td>
<td>Select the instrument and scan mode to be used for calculating the estimated run time in the Experiment Setup window</td>
</tr>
</tbody>
</table>

The toolbar (Figure 33) in the Protocol Editor window provide quick access for important functions:

![Figure 33. Protocol Editor toolbar.](image)
Table 14 lists the function of the Protocol Editor toolbar buttons:

<table>
<thead>
<tr>
<th>Toolbar Button and Menus</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Save</td>
<td>Save the current protocol file</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Print the selected window</td>
</tr>
<tr>
<td></td>
<td>Insert Step</td>
<td>Select <strong>After</strong> or <strong>Before</strong> to insert steps in a position relative to the currently highlighted step</td>
</tr>
<tr>
<td></td>
<td>Sample Volume</td>
<td>Enter a sample volume in μl between 0 and 50 (for 96-well block), or between 0 and 30 (for 384-well block) Sample volume determines the Temperature Control mode (page 37). Enter zero (0) to select Block mode</td>
</tr>
<tr>
<td></td>
<td>Run Time</td>
<td>View an estimated run time based on the protocol steps and ramp rate</td>
</tr>
<tr>
<td></td>
<td>Help</td>
<td>Open the software Help for more information about protocols</td>
</tr>
</tbody>
</table>

**Protocol Editor Controls**

The Protocol Editor window includes buttons for editing the protocol. First, select and highlight a step in the protocol by left clicking it with the mouse pointer. Then click one of the Protocol Editor buttons at the bottom left side of the Protocol Editor window to change the protocol. The location for inserting a new step, "Before" or "After" the currently selected step is determined by the status of the Insert Step box located in the toolbar.

**Insert Step Button**

To insert a temperature step before or after the currently selected step:

1. Click the **Insert Step** button.

2. Edit the temperature or hold time by clicking the default value in the graphic or text view, and entering a new value.
3. (Optional) Click the **Step Options** button to enter an increment or extend option to the step (page 36). Figure 34 shows the new step that was inserted after step 2.

![Figure 34. Protocol with inserted step.](image)

**Add or Remove a Plate Read**

To add a plate read to a step or to remove a plate read from a step:

1. Select the step by clicking the step in either the graphical or text view.

2. Click the **Add Plate Read to Step** button to add a plate read to the selected step. If the step already contains a plate read, the text on the button changes, so now the same button reads **Remove Plate Read**. Click to remove a plate read from the selected step.

In Figure 34, notice that the camera icon in the graphic view (top) shows that step 4 includes a plate read.

**Insert Gradient Button**

To insert a gradient step before or after the currently selected step:

1. Insert a temperature gradient step by clicking the **Insert Gradient** button.

2. Make sure the plate size for the gradient matches the block type of the instrument, 96 well or 384 well. Select the plate size for the gradient by selecting **Tools > Gradient Calculator** in the Protocol Editor menu bar.

3. Edit the gradient temperature range by clicking the default temperature in the graphic or text view, and entering a new temperature. Alternatively, click the **Step Options** button to enter the gradient range in the Step Options window (page 36)

4. Edit the hold time by clicking the default time in the graphic or text view, and entering a new time.
Figure 35 shows the inserted gradient step. The temperatures of each row in the gradient are charted on the right side of the window.

**Insert GOTO Button**

To insert a GOTO step before or after the selected step:

1. Click the **Insert GOTO** button.

2. Edit the GOTO step number or number of GOTO repeats by clicking the default number in the graphic or text view, and entering a new value.

Figure 35 shows an inserted GOTO step at the end of the protocol. Notice that the GOTO loop includes steps 2 through 4.

**Insert Melt Curve Button**

To insert a melt curve step before or after the selected step:

1. Click the **Insert Melt Curve** button.

2. Edit the melt temperature range or increment time by clicking the default number in the graphic or text view, and entering a new value. Alternatively, click the **Step Options** button to enter the gradient range in the Step Options window (page 36).

   **NOTE:** You cannot insert a melt curve step inside a GOTO loop.

   **NOTE:** The melt curve step includes a 30 second hold at the beginning of the step that is not shown in the protocol.
Figure 36 shows a melt curve step added after step 6:

![Figure 36. Protocol with inserted melt curve step.](image)

**Step Options**

To change a step option for the selected step:

1. Select a step by clicking on the step in the graphic or text view.

2. Click the **Step Options** button to open the Step Options window.

3. Add or remove options by entering a number, editing a number, or clicking a check box.

   **TIP:** To hold a step forever (an infinite hold), enter zero (0.00) for the time.

Figure 37 shows the selected step with a gradient of 10°C. Notice that some options are not available in a gradient step. A gradient step cannot include an increment or ramp rate change.

![Figure 37. Step option for a gradient.](image)

**NOTE:** A gradient runs with the lowest temperature in the front of the block (row H) and the highest temperature in the back of the block (row A).

The **Step Options** window lists the following options you can add or remove from steps:

- **Plate Read.** Check the box to include a plate read
- **Temperature.** Enter a target temperature for the selected step
- **Gradient.** Enter a gradient range for the step
• **Increment.** Enter a temperature to increment the selected step; the increment amount is added to the target temperature with each cycle

• **Ramp Rate.** Enter a rate for the selected step; the range depends on the block size

• **Time.** Enter a hold time for the selected step

• **Extend.** Enter a time to extend the selected step. The extend amount is added to the hold time with each cycle

• **Beep.** Check the box to include a beep at the end of the step

TIP: When you enter a number that is outside the option range, the software changes the number to the closest entry within the range.

### Delete Step Button

To delete a step in the protocol:

1. Select a step in the graphic or text view.

2. Click the **Delete Step** button to delete the selected step.

**WARNING!** You cannot undo this function.

### Temperature Control Mode

The instrument uses one of two temperature control modes to determine when the sample reaches the target temperature in a protocol.

TIP: The sample volume can be changed before a run by editing the Sample Volume parameter in the Start Run tab (see “Start Run Tab” on page 24).

Enter a sample volume in the protocol editor to select a temperature control mode:

• **Calculated mode.** When you enter a sample volume between 1 and 50 μl (96-well block) or between 1 and 30 μl (384-well block) the thermal cycler calculates the sample temperature based on the sample volume. This is the standard mode

• **Block mode.** When you enter a sample volume of zero (0) μl, the thermal cycler records the sample temperature as the same as the measured block temperature

### Protocol AutoWriter

Open the Protocol AutoWriter to quickly write protocols for PCR and real-time PCR experiments. To open the Protocol AutoWriter, select one of these options:

- Click the **Protocol AutoWriter** button in the main software window toolbar

- Select **Tools > Protocol AutoWriter** from the menu bar in the main software window
Figure 38 shows a protocol (bottom of window) written by the Protocol AutoWriter.

![Protocol AutoWriter window with a new protocol.](image)

**Protocol AutoWriter Overview**

The Protocol AutoWriter window uses information about your reaction to automatically generate a protocol file. Enter the following information about your PCR experiment:

- **Annealing Temperature (Ta) or primer sequence.** Enter the annealing temperature for the primers. If the annealing temperature is unknown, click the Ta Calculator button to enter the primer sequence to calculate the annealing temperature in the Ta Calculator window.
- **Amplicon Length (bp).** Enter the expected length of the PCR product.
- **Enzyme.** Select the DNA polymerase enzyme (iTaq, iProof, or Other) (iTag™ DNA Polymerase; iProof™ high fidelity DNA Polymerase); enter additional information including hot start activation time, and final extension time.
- **Run time and type.** Enter a speed (Standard, Fast, Ultrafast) to adjust the total run time, and select the type of PCR (Real-time PCR or PCR).

The run time for any protocol is influenced by the number of steps and cycles, the incubation time at each step, and the time it takes to reach uniformity at the target temperature. To reduce the overall run time, the Protocol AutoWriter makes one or more of the following changes:

- Reduces the total number of protocol steps
- Reduces the number of GOTO repeats
- Minimizes the hold time in each temperature step
- Minimizes the ramp time between steps by reducing the temperature change from one step to the next
For example, a typical PCR protocol includes the following three sets of steps with a total run time of 1.5 to 2.0 hours:

1. Initial template denaturation and enzyme activation (95°C for 3-10 minutes).
2. Cycles of three temperature steps (30 to 40 cycles): Denaturation of template (94-95°C for 15-30 seconds), annealing of primers (anneal for 15-30 seconds), and extension of product (72°C for 15-60 seconds).
3. Final extension (72°C for 10 minutes).

The Protocol AutoWriter might make these modifications to shorten a typical protocol:
- Change the initial template denaturation and enzyme activation step from 95°C for 3 minutes to 98°C for 30 seconds
- Change the denaturation step in each cycle from 95°C for 30 seconds to 92°C for 1 second
- Combine the annealing and extension steps into a single step at 70°C for 20 seconds

NOTE: Combining the annealing and extension steps imposes limits on the melting temperature of the primers. If the melting temperatures of the primers do not fall within the specified range, adjust the primers. For example, shorten the primers by 2 to 3 basepairs (bp), or redesign them to adjust the melting temperature.

Create a Protocol With the Protocol AutoWriter

Follow these steps to use the Protocol AutoWriter to create a new protocol:

1. Click the Protocol AutoWriter button on the toolbar to open the Protocol AutoWriter window.
2. Enter the Annealing Temperature (Ta) and Amplicon Length in the boxes within the Enter Target Values/Enzymes pane. If you do not know the annealing temperature for primers, click the Ta Calculator button to enter the primer sequences and calculate the annealing temperature. For information about the calculations used in the Ta Calculator see Breslauer et al. 1986.
3. Select an enzyme type from the list of options (iTaq, iProof, or Other).
4. Add parameters in the Additional Parameters (Optional) pane if you want to add a Gradient Range, Hot Start Activation temperature, or Final Extension time in the protocol.
5. Select a protocol speed (Standard, Fast, or Ultrafast) by moving the sliding bar in the Type pane. When you move the sliding bar, the software adjusts the total run time. Select Real-time PCR to tell the software to collect fluorescence data.
6. Review the protocol in the Preview pane and total run time. Make changes as needed.
   TIP: Enter the lid temperature and sample volume before each run by editing the parameters in the Start Run tab (see “Start Run Tab” on page 24).
7. Click OK to save the new protocol, or click Cancel to close the window without saving the protocol.

TIP: To edit a protocol written with the Protocol AutoWriter, open the protocol file (.prcl extension) in the Protocol Editor window (page 31).

NOTE: Bio-Rad Laboratories does not guarantee that running a protocol written in the Protocol AutoWriter window will always result in a PCR product.


5 Plates

Read this chapter for information about creating and editing plate files:

• Plate Editor window (next section)
• Plate size and type (page 44)
• Scan mode (page 45)
• Select Fluorophores window (page 45)
• Well loading controls (page 46)
• Well Groups Manager window (page 50)

Plate Editor Window

A plate file contains run parameters, such as scan mode and fluorophores, and well contents and instructs the instrument about how to analyze the data. Open the Plate Editor window to create a new plate or to edit the plate currently selected in the Plate tab. Once a plate file is created or edited in the Plate Editor, click OK to load the plate file into the Experiment Setup window and run it.

To run a real-time PCR experiment, you must load the minimal required information in the Plate Editor: at least one well must contain a loaded sample type and fluorophore.

TIP: Change the well contents before, during, and after running the experiment. However, the scan mode and plate size cannot be changed during or after the run.

Open the Plate Editor

To open the Plate Editor window (Figure 39), follow one of these options:

• To create a new plate, select File > New > Plate or click the Create New button in the Plate tab (page 23)
• To open an existing plate, select File > Open > Plate, or click the Open Existing button in the Plate tab (page 23)
• To edit the current plate in the Plate tab, click the Edit Selected button in the Plate tab (page 23)
• To open the plate associated with a data file, in the Data Analysis window (page 69), click View/Edit Plate on the toolbar
Figure 39. Plate Editor window.

Plate Editor Window

The Plate Editor window includes the following features:

- **Menu bar.** Select settings for the plate size, plate type, number conventions, and units (page 43)
  
  NOTE: A 96-well plate collects data for up to 5 channels (All Channels scan). A 384-well plate collects data for up to four channels (All Channels scan).

- **Toolbar.** Select settings for the Scan Mode (page 45) or Well Groups (page 50)

- **Plate Loading Guide.** Open the Plate Loading Guide window from the toolbar for a quick overview of instructions to load a plate (page 42)

- **Plate view.** View the current well contents. Load wells by using the plate loading options on the right side of the plate view (Figure 39)

- **Well loading controls.** Choose the contents to load in the wells (page 46) from the controls on the right side of the plate view

The Plate Editor example shows some loaded wells with unknowns (**Unk**) and standards (**Std**) (Figure 39). The bottom of the plate lists the plate type (**BR Clear**) and a selector to View **Target Name** or **Concentration** when wells are loaded with Standard sample type.
Plate Editor Menu Bar

The menu bar in the Plate Editor window provides the menu items shown in Table 15.

Table 15. Menu bar items in the Plate Editor

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Save</td>
<td>Save the plate files</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Save the plate file with a new file name</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Exit the Plate Editor</td>
</tr>
<tr>
<td>Settings</td>
<td>Plate Size</td>
<td>Select a plate size that reflects the number of wells in the instrument block. Choose <strong>384-well</strong> for the CFX384, <strong>96-well</strong> for the CFX96. <strong>NOTE</strong>: Plate Size must be the same as the block size in the instrument on which the experiment will be run.</td>
</tr>
<tr>
<td></td>
<td>Plate Type</td>
<td>Choose the type of wells in the plate that holds your samples, including BR White and BR Clear. For accurate data analysis, the plate type must be the same as the plate well type used in the experiment. <strong>NOTE</strong>: You must calibrate new plate types (page 131).</td>
</tr>
<tr>
<td></td>
<td>Number Convention</td>
<td>Select or cancel the selection for Scientific Notation</td>
</tr>
<tr>
<td></td>
<td>Units</td>
<td>Select the units to show in the spreadsheets when performing quantitation of unknowns versus a standard curve. Select copy number, fold dilution, micromoles, nanomoles, picomoles, femtomoles, attomoles, milligrams, micrograms, nanograms, picograms, femtomoles, attograms, or percent</td>
</tr>
<tr>
<td>Tools</td>
<td>Show Spreadsheet View</td>
<td>Show the plate information in a spreadsheet view for export or printing</td>
</tr>
<tr>
<td></td>
<td>Plate Loading Guide</td>
<td>Show a quick guide about how to set up a plate and load the wells</td>
</tr>
<tr>
<td></td>
<td>Show Well Notes</td>
<td>Select to show this pane in the well loading controls. Enter notes about one or more wells</td>
</tr>
<tr>
<td></td>
<td>Show Collection Name</td>
<td>Select to show this pane in the well loading controls. Select to enter collection names for one or more wells</td>
</tr>
<tr>
<td>Help</td>
<td>Help Contents</td>
<td>Open the Help for more information about plates</td>
</tr>
</tbody>
</table>

Plate Editor Toolbar

The toolbar in the Plate Editor provides quick access to important plate loading functions:

![Plate Editor Toolbar Image]

TIP: To change the default settings in the Plate Editor window, open the User Preferences window and enter the changes in the Plate tab.
Table 16 lists the functions available in the Plate Editor toolbar.

### Table 16. Toolbar items in the Plate Editor

<table>
<thead>
<tr>
<th>Toolbar Item</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Save icon]</td>
<td>Save</td>
<td>Save the current plate file</td>
</tr>
<tr>
<td>![Print icon]</td>
<td>Print</td>
<td>Print the selected window</td>
</tr>
<tr>
<td>![Zoom icon]</td>
<td>Zoom</td>
<td>Increase or decrease magnification in plate view</td>
</tr>
<tr>
<td>![Scan Mode icon]</td>
<td>Scan Mode</td>
<td>Select a scan mode to instruct the instrument what channels to collect fluorescence data from during a run. Select All Channels (default), SYBR/FAM only, or FRET</td>
</tr>
<tr>
<td>![Well Groups icon]</td>
<td>Well Groups</td>
<td>Open the Well Groups Manager window and set up well groups for the current plate</td>
</tr>
<tr>
<td>![Help icon]</td>
<td>Help</td>
<td>Open the software Help for information about plates</td>
</tr>
<tr>
<td>![Plate Loading Guide icon]</td>
<td>Plate Loading Guide</td>
<td>Show a quick guide about how to set up a plate and load the wells</td>
</tr>
</tbody>
</table>

### Plate Size and Type

The software applies these plate settings to all the wells during the experiment:

- **Plate Size.** Select a plate size that represents the size of the reaction module block of your instrument. Choosing the instrument type, CFX96 or CFX384, from the pull down menu option on the Startup Wizard will change the default plate size loaded in the Plate tab of the Experiment Settings window. In the Plate Editor, select the plate size from the Settings menu (see Table 15). Plate size can not be changed during or after the experiment.

- **Plate Type.** Select clear or white wells from the Settings menu. Make sure the fluorophore being used in the experiment is calibrated for the selected plate type. NOTE: CFX96 and CFX384 instruments are factory calibrated for many fluorescent dye and plate combinations. Calibration is specific to the instrument, dye, and plate type. To calibrate a new combination of dye and plate type on an instrument, select **Tools > Calibration Wizard** (see “Calibration Wizard” on page 131).
Scan Mode

The CFX96 system excites and detects fluorophores in six channels. The CFX384 system excites and detects fluorophores in five channels. Both systems use multiple data acquisition scan modes to collect fluorescence data from during a run.

Select one of these scan modes in the Plate Editor window toolbar:

- **All Channels.** Includes channels 1 through 5 on the CFX96 system or channels 1 through 4 on the CFX384 system
- **SYBR/FAM only.** Includes only channel 1, and provides a fast scan
- **FRET.** Includes only the FRET channel and provides a fast scan

Select Fluorophores Window

The Select Fluorophores window lists fluorophores that can be selected to load into the Plate Editor well loading controls. To open the Select Fluorophores window, click the Select Fluorophores button on the right side of the Plate Editor.

**NOTE:** The fluorophores listed depend on the scan mode; when SYBR/FAM only is chosen, only channel 1 fluorophores are shown in the Select Fluorophores window.

**NOTE:** You cannot add or remove fluorophores in this list; you must calibrate the new fluorophores on an instrument in the Calibration Wizard (page 131). After calibration, the new fluorophore is added to the Select Fluorophore window.

Click the **Selected** check box next to the fluorophore name to add or remove the fluorophores to the list on the right side of the Plate Editor window.

In this example, SYBR is selected from the list of available fluorophores (Figure 40).

![Select Fluorophores window](image)

**Figure 40. Select Fluorophores window.**

- Click the **Color** box next to the fluorophore name and select a new color to represent each fluorophore in the Plate Editor window and Data Analysis charts

**NOTE:** Before beginning the run, the software verifies that the fluorophores you specified in the plate are calibrated on that instrument. You cannot run a plate if it includes fluorophores that have not been calibrated on that instrument.
Well Loading Controls

A plate file contains information about the contents of each well loaded with sample for an experiment. After the run, the software links the well contents to the fluorescence data collected during the protocol and applies the appropriate analysis in the Data Analysis window. For example, wells loaded with standard sample type are used to generate a standard curve.

When setting up a gene expression experiment, consider the following guidelines for well contents:

- **Target Name.** One or more targets of interest (genes or sequences) in each loaded well. Each target is assigned to one fluorophore

- **Sample Name.** One identifier or condition that corresponds to the sample in each loaded well, such as “0 hr”, “1 hr”, or “2 hr”

  TIP: Target names and sample names must match between wells to compare data in the Gene Expression tab in the Data Analysis window. Each name must contain the same punctuation and spacing. For example, “Actin” is not the same as “actin”, and “2hr” is not the same as “2 hr”. To facilitate consistency in names, enter them in the Target and Sample Names Libraries in the Plate tab in the User Preferences window (page 125).

Select a well to load contents into by left clicking with the mouse pointer in the plate view. Hold down the mouse button and drag to select multiple wells. The buttons and lists on the right side of the plate view include all the options needed to load the wells (Table 17).

Table 17. Options for loading the plate and wells in the Plate Editor

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Type</td>
<td>After selecting wells, the Sample Type must be loaded first. Select a Sample Type from the pull-down menu to load it in the selected wells, including Unknown, Standard, NTC (no template control), Positive Control, Negative Control, and NRT (no reverse transcriptase)</td>
</tr>
<tr>
<td>Load</td>
<td>Click a Load box to add a fluorophore to the selected wells; each fluorophore corresponds to a target name. To add fluorophores to the Load list, select them in the Select Fluorophores window</td>
</tr>
<tr>
<td>FAM</td>
<td>For gene expression analysis or to distinguish between multiple targets, select a name in the Target Name pull-down menu and press the Enter key to load the target name in the well. To delete a target name, select it, press the Delete key, and press the Enter key</td>
</tr>
<tr>
<td>HEX</td>
<td>TIP: To add a new target name to the pull-down menu in the current plate only, type a name in the pull-down box and press the Enter key</td>
</tr>
<tr>
<td>R0X</td>
<td></td>
</tr>
<tr>
<td>Cy5</td>
<td></td>
</tr>
<tr>
<td>Quasar 705</td>
<td></td>
</tr>
<tr>
<td>Load</td>
<td></td>
</tr>
<tr>
<td>Target Name</td>
<td></td>
</tr>
<tr>
<td>GAPDH</td>
<td></td>
</tr>
</tbody>
</table>
For gene expression analysis or to distinguish between multiple samples, select a **Sample Name** from the pull-down menu to load that sample name in the selected wells. To delete a sample name, select it in the menu, press the **Delete** key on your keyboard, and then press **Enter**.

**TIP:** To add a new sample name to the pull-down menu in the current plate, type a new name in the pull-down box and press the **Enter** key.

To load replicate numbers, selected wells must contain identical well contents. If they do not, the software disables this loading control. Click the **Load** box to add a Replicate # to the selected wells. Click the **Clear Replicate #** button to clear the replicate number from selected cells.

**TIP:** To load multiple replicate numbers across a series of wells, click the **Replicate Series** button.

In the **Replicate Series** pane you can apply a replicate series to a set of selected wells. Enter the **Replicate Group Size** by selecting a number that represents the number of samples (wells) in each group of replicates. Select a **Starting Replicate #** to add replicates.

**NOTE:** You can load replicate groups with replicate numbers progressing from left to right (**Horizontal**), or progressing from top to bottom (**Vertical**).

Enter a concentration to the selected wells with standard sample type by editing or typing a number in the **Concentration** box. To apply the concentration to one fluorophore in the well, select a single fluorophore from the pull-down menu (**<All>**) under the concentration box. To delete a concentration, select it, press the **Back Space** key on your keyboard and then press **Enter**.

Select multiple wells with a Standard sample type to activate the **Dilution Series** button.
To open the Experiment Settings window, follow one of these options:

- In the Plate Editor, click the Experiment Settings button
- While analyzing data in the Data Analysis window, click the Experiment Settings button in the Gene Expression tab

Open the Experiment Settings window to view or change the list of Targets and Samples (Figure 41) or to set the gene expression analysis sample group to be analyzed if Collection Names have been added to the wells.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the <strong>Dilution Series</strong> button to enter a dilution series for the concentration of Standard samples, and load a standard curve. Enter the <strong>Starting Concentration</strong> for the dilution series, the <strong>Replicates from</strong> (starting replicate number) and to (ending replicate number), and the <strong>Dilution Factor</strong> (amount to change the concentration with each replicate group). Select <strong>Increasing</strong> for a dilution series that increases, or select <strong>Decreasing</strong> for a dilution series that decreases. Finally, select the fluorophore used for the dilution series from the pull-down menu and click <strong>Apply</strong>.</td>
<td></td>
</tr>
<tr>
<td>Select <strong>Tools &gt; Show Well Notes</strong> to show this pane. Enter notes about one or more wells by selecting the wells and typing the notes in the pull-down menu. Any notes you add appear in the spreadsheet on the Quantitation Data tab (page 78).</td>
<td></td>
</tr>
<tr>
<td>Select <strong>Tools &gt; Show Collection Name</strong> to show this pane. Enter sample collection information about one or more wells by selecting the wells and typing a collection name in the pull-down menu. Any collection name you add to wells appear in the Gene Expression Analysis window and enables sample grouping options.</td>
<td></td>
</tr>
<tr>
<td>Click the <strong>Experiment Settings</strong> button to open the Experiment Settings window to manage the lists of Targets and Samples, and to set up a gene expression experiment.</td>
<td></td>
</tr>
<tr>
<td>Click the <strong>Clear Replicate #</strong> button to clear the replicates numbers in the selected wells.</td>
<td></td>
</tr>
<tr>
<td>Click the <strong>Clear Wells</strong> button to clear all content in the selected wells. NOTE: Clicking the <strong>Clear Wells</strong> button permanently removes the content of the wells.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 17. Options for loading the plate and wells in the Plate Editor (continued)**

- **Starting Concentration:** 1.00E+06
- **Replicates from:** 1
- **to:** 3
- **Dilution Factor:** 10
- **Increasing**

---

**Experiment Settings Window**

To open the Experiment Settings window, follow one of these options:

- In the Plate Editor, click the **Experiment Settings** button
- While analyzing data in the Data Analysis window, click the **Experiment Settings** button in the Gene Expression tab

Open the Experiment Settings window to view or change the list of Targets and Samples (Figure 41) or to set the gene expression analysis sample group to be analyzed if Collection Names have been added to the wells.
• **Targets.** A list of target names for each PCR reaction, such as genes or sequences of interest. Click the Reference column to assign reference genes in an experiment.

• **Samples.** A list of sample names that indicate the source of the target, such as a sample taken at 1 hour (1 hr), or taken from a specific individual (“mouse1”). Click the Control column to assign the control condition for an experiment.

Figure 41 shows the Targets tab with the analysis settings shown.

![Figure 41. Targets tab in Experiment Settings window.](image1)

Figure 42 shows the Sample Tab with the Analysis Settings shown.

![Figure 42. Samples tab in Experiment Settings window.](image2)

To adjust the lists in these tabs, use the following functions:

- Add a target or sample name by typing a name in the **New** box, and clicking **Add**
- Remove a target or sample name from the list by clicking the **Select to Remove** box for that row, and then clicking the **Remove checked items(s)** button
- Select the target as a reference for gene expression data analysis by clicking the box in the **Reference** column next to the name for that target
• Select the sample as a control sample for gene expression data analysis by clicking the box in the Control column next to the name for that sample.

Click the Show Analysis Settings box in the Experiment Settings window to view or change analysis parameters applied in the Gene Expression tab.

To adjust target parameters:
• Click a cell in the Color column to change the color of the targets graphed in the Gene Expression chart.
• Enter a number for the efficiency of a target. The software will calculate the relative efficiency for a target using Auto Efficiency if the data for a target includes a standard curve. Alternatively, type a previously determined efficiency.

To adjust the settings for a sample in the Samples tab:
• Click a color in the Color column to change the color of the samples graphed in the Gene Expression chart.
• Click a box in the Show Graph column to show the sample in the Gene Expression chart using a color that is selected in the Color column.

**Sample Name Grouping Option**

Loading Collection Names in the wells enables samples to be analyzed in one of four configurations defined by the Sample Name Grouping Option. These options are available from the pull down menu in the Experiment Settings tab.
• Target vs. Sample
• Target vs. Collection
• Target vs. Sample_Collection
• Target vs. Collection_Sample

**Well Groups Manager Window**

Well groups divide a single plate into subsets of wells that can be analyzed independently in the Data Analysis window. Once well groups are set up, select one in the Data Analysis window to analyze the data in an independent group. For example, set up well groups to analyze multiple experiments run in one plate, or to analyze each well group with a different standard curve.

NOTE: The default well group is All Wells.

**Create Well Groups**

To create well groups in the Well Groups Manager window, follow these instructions:
1. Click the Well Groups button in the toolbar of the Plate Editor.
2. Click Add to create a new group. The pull-down menu shows the group name as Group 1 for the first group.
3. Select the wells that will compose the well group in the plate view by clicking and dragging across the group of wells. Selected wells turn blue in color (Figure 43).
4. (Optional) Change the name of the group by selecting the group name in the pull-down menu and typing a new name.
5. (Optional) Create more well groups by repeating steps 1 and 2.

6. (Optional) Delete well groups by selecting the group name in the pull-down list, and clicking the **Delete** button.

7. Click **OK** to finish and close the window, or click **Cancel** to close the window without making changes.

---

**Plate Spreadsheet View Window**

The Plate Spreadsheet View window shows the contents of a plate in the Plate Editor. Open the Plate Spreadsheet View window (Figure 44) by selecting **Tools > Show Spreadsheet View** in the Plate Editor menu bar.

---

**Figure 43. Color of wells in the Well Group Manager window.**

**Figure 44. Plate Spreadsheet View window.**
Open the spreadsheet view to import or export the well contents to Excel or to another tab-delimited format:

- Click **Import Template** to import well contents from a comma delimited file
- Click **Export Template** to export well contents in Excel file (.csv format)

Sort or edit a column by selecting it and using these methods:

- Sort the spreadsheet according to the data in one column by clicking the diamond next to a column name
- Edit the contents of a column that has an asterisk (*) at top by clicking and typing in each well

NOTE: Select the units for the standard curve data in the Quantity column by opening the Plate Editor and selecting **Settings > Units** in the menu bar. After the plate runs, the data from these standards appear in the Standard Curve chart of the Quantitation tab (Data Analysis window) with the units you select. Open the spreadsheet view to import or export the plate contents to Excel or another tab-delimited format.

Right-click on the spreadsheet to select one of these options from the right-click menu:

- **Copy.** Copy the entire spreadsheet
- **Copy as Image.** Copy the spreadsheet as an image file
- **Print.** Print the spreadsheet
- **Print Selection.** Print only the selected cells
- **Export to Excel.** Export the file as an Excel formatted file
- **Export to Text.** Export the file as a text file
- **Find.** Find text in the spreadsheet
- **Sort.** Sort the spreadsheet by selecting up to three columns of data in the Sort window
6 Stand-Alone Operation

Read this chapter for information about running the CFX96 system or CFX384 system in stand-alone mode:

- Control panel (below)
- Main menu (page 54)
- Experiment setup (page 55)
- Exporting data for analysis (page 61)
- Creating a data file (page 64)
- Setting up email (page 65)

Control Panel

The control panel on the C1000 thermal cycler provides access to all the functions needed to run the instrument utilizing the following three components:

- **Liquid crystal display (LCD):** Displays the main menu and other screens
- **Keypad:** Navigate screens and enter commands with these keys
- **USB port:** Connect a USB drive, mouse, or keyboard.

Figure 45 shows the components of the control panel:
The control panel contains five sets of keys with the functions listed in Table 18:

**Table 18. Functions of keys on control panel**

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>COMMAND KEYS</strong></td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>Select and run a protocol</td>
</tr>
<tr>
<td>EDIT</td>
<td>Select and change protocol</td>
</tr>
<tr>
<td>STATUS</td>
<td>View the status of one or more running protocols</td>
</tr>
<tr>
<td>VIEW</td>
<td>Switch between graphic and text view of a protocol</td>
</tr>
<tr>
<td><strong>FUNCTION KEYS</strong></td>
<td></td>
</tr>
<tr>
<td>F1, F2, F3, or F4</td>
<td>Function key buttons’ names and functions change on each screen</td>
</tr>
<tr>
<td><strong>ALPHANUMERIC KEYS</strong></td>
<td></td>
</tr>
<tr>
<td>1 through 9</td>
<td>Enter numbers or letters of the alphabet. Press a key multiple times to switch to each associated letter</td>
</tr>
<tr>
<td>0, INCUBATE</td>
<td>Insert a zero, ( \infty ) (infinity), or start instant incubation</td>
</tr>
<tr>
<td>decimal point (.)</td>
<td>Enter a decimal point</td>
</tr>
<tr>
<td>minus sign (-)</td>
<td>Enter a minus sign</td>
</tr>
<tr>
<td>Protocol AutoWriter</td>
<td>Launch the Protocol AutoWriter</td>
</tr>
<tr>
<td><strong>NAVIGATION KEYS</strong></td>
<td></td>
</tr>
<tr>
<td>RIGHT arrow</td>
<td>Move cursor to the right</td>
</tr>
<tr>
<td>LEFT arrow</td>
<td>Move cursor to the left</td>
</tr>
<tr>
<td>UP arrow</td>
<td>Move cursor up</td>
</tr>
<tr>
<td>DOWN arrow</td>
<td>Move cursor down</td>
</tr>
<tr>
<td>ENTER</td>
<td>Confirm a setting</td>
</tr>
<tr>
<td>BACK</td>
<td>Cancel a function. Delete a letter, number, or word</td>
</tr>
</tbody>
</table>

**Main Menu**

When it starts, the CFX96 system or CFX384 system runs a self-test to verify proper functions, and then displays the main menu. Use the main menu to begin operating the instrument. The main menu provides access to all system operations, displays the date and time, the name of the logged-in user, the system status, the type of reaction module and thermal cycler name, and any attached S1000 thermal cyclers (Figure 46).

**NOTE:** To rename the thermal cycler, open the files library (Files (F2) button) and then select Rename Cycler.
To initiate the functions in the main menu, press the associated function keys (F1 through F4):

- **Log In (F1)**. Log in to the C1000 thermal cycler. Once you log in the button name changes to Log Off
- **Files (F2)**. View the files and folders in the file library
- **Utilities (F3)**. Open the Utilities menu
- **New Protocol (F4)**. Create a new protocol

**Experiment Setup**

The CFX96 system or the CFX384 system can run real-time PCR experiments without a computer. You can export the fluorescence data acquired during a run using the USB thumb key. You can also choose to have the data emailed directly to you if the C1000 base is attached to the internet and the email functionality has been configured (see “Exporting Data Using Email” on page 62). The data requires CFX Manager software for analysis.

**NOTE:** The C1000 thermal cycler stores up to 20 real-time PCR experiment runs.
To create a new experiment:

1. Select **New Protocol** (F4) in the start up screen to open a new protocol template (Figure 47).

   ![Figure 47. Default real-time PCR protocol.](image)

   NOTE: By default, the protocol template contains a plate read step when a CFX96 or a CFX384 optical reaction module is inserted in the C1000 chassis.

   TIP: To change an existing protocol, press the **EDIT** command key to open the file library and select a protocol to edit.

2. To change the target temperature and the hold time in a temperature step, press the arrow keys to navigate between steps and to select a parameter (temperature or time). Press the alphanumeric keys to enter a new number for each parameter you highlight.

   TIP: Connect a computer mouse via a USB port on the C1000 chassis to navigate.

   NOTE: Press the **VIEW** key to switch between graphic and text view of the protocol.

3. (Optional) To insert a new step, select the **Insert** (F1) button. To delete a step, select the **Delete** (F3) button (Figure 47).

4. (Optional) To change step options, select the **Options** (F4) button (Figure 47). In the **Step Options** window, select a parameter to change, including the temperature and time of the step, or add/remove a plate read to the step (Figure 48)

   ![Figure 48. Step Options window.](image)
NOTE: Press the alphanumeric keys to enter a Gradient Range spanning from 1 to 24°C.

TIP: Once a step has a gradient, you can edit the upper and lower temperatures in the graphic or text view without opening the Options screen.

5. The GOTO step instructs the thermal cycler to repeat a set of steps in a loop to create the cycles in the PCR experiment. Select a GOTO step; press the arrow keys to select and then edit the step number in a GOTO step or to change the number of repeats.

**Entering a Protocol Name:**

- When creating a new protocol, you have the option to save it with a name. Use the arrow keys to navigate to the Protocol Name box and then press the alphanumeric keys multiple times to enter a letter or number to type a new protocol name (Figure 47 on page 56).
- Press ENTER to accept the name.

**Changing run parameters:**

- To change the default sample volume, select the sample volume box (Vol) (Figure 47 on page 56). Use the alphanumeric keys to enter a new sample volume in microliters. The sample volume you enter determines the temperature control mode that is used during a run.
  
  TIP: Entering a sample volume from 1 to 50 selects Temperature Control mode, which is the standard mode. Entering zero (0) selects Block mode. Temperature mode is the recommended mode because it most accurately represents the actual sample temperature.

- To change the default lid temperature, select the lid temperature box (LID) by pressing the arrow keys (Figure 47 on page 56). Use the alphanumeric keys to enter a new temperature. For the CFX96 system, use a lid temperature of 105°C; for the CFX384 system use a lid temperature of 95°C.
  
  NOTE: Heating the lid prevents condensation in the sealed reaction vessels.

**Running the Protocol:**

1. To run the protocol, click the Done (F2) button in the Protocol window (Figure 47 on page 56).

  TIP: Alternatively, click the RUN command key to start the run without saving or editing the name of the protocol.
2. Enter a protocol name if you have already not done so, or edit the name previously created in the Protocol window. Use arrow keys to select a destination folder (Figure 49).

![Figure 49. Saving a protocol.](image)

3. Click **Edit Filename** (F1) and type a new name in the box (Figure 50).

![Figure 50. Entering a protocol name.](image)

4. Click **Save** (F2) (Figure 50).
5. Click Run (F2) to continue and run the protocol (Figure 51).

![Figure 51. Protocol successfully saved.](image)

6. Edit the Sample Volume or Lid Temperature that will be used for the run (Figure 52).

7. Enter the Sample ID or User to be recorded in the Run information screen.

![Figure 52. Editing sample volume and lid temperature.](image)

8. Click OK (F1) to proceed.
9. Select a **Scan Mode** to instruct the instrument in which channels to collect fluorescence data during a run (Figure 53).

![Running real time protocol](image)

- **All Channels.** Collects data from channels 1 through 5 on the CFX96 system, or channels 1 through 4 on the CFX384 system
- **SYBR / FAM only.** Collects data only from channel 1 on either system, and provides a fast scan
- **FRET.** Collects data only from the FRET channel on either system and provides a fast scan

10. A default stand-alone data file name is created prior to the run. If you wish to change the name, use the arrow keys to navigate to the **Data File Name** box, then press the alphanumeric keys to enter a letter or number to type a new data file (.zpcr) name.

11. Click the **OK** (F1) button to start the run.

**Running a Previously Saved Protocol**

- To change an existing protocol, press the **EDIT** key to open the file library and select a protocol to edit
- To run an existing protocol, press the **RUN** command key and select a previously saved protocol from the file library

**NOTE:** Press the **RUN** key from any screen to open the file library and select a folder to locate a protocol file to run

**Monitoring a run**

When a run begins, the run status window appears. Review the information in this window to monitor the progress of a run.

- **Status.** Press the **STATUS** command key to check the current status of the protocol, pause the run, cancel a run, skip a step, or access the main menu (Figure 54)
• **Time Status.** Press the **VIEW** command key to see a full-screen count-down timer for the protocol. Press the **VIEW** key again to switch back to the Status screen.

![Figure 54. Monitoring run status.](image)

**Exporting Data for Analysis**

When the run is finished, the fluorescence data needs to be transferred to a computer running CFX Manager software for analysis. The stand-alone data file is automatically saved to the **RT_DATA** folder located in the **SYSTEM** folder (Figure 55).

![Figure 55. RT_DATA folder stores real-time PCR runs.](image)

Data can be transferred to the analysis computer using a USB key, or it can be emailed directly to the computer using the SMTP server once an email connection is configured.

**NOTE:** The C1000 stores up to 20 real-time PCR experiment runs.

**Exporting Data Using the USB Key**

If a USB key has been placed in a USB key port on the C1000 thermal cycler, the data (.zpcr) will automatically be saved to the root directory of the USB key.

If a USB key is not in the thermal cycler at the end of the run, follow these instructions:

1. Press the **Files** (F2) button on the main screen to access the file folders.
Stand-Alone Operation

2. Use the up and down arrow keys to navigate to the RT_DATA folder and then press the right arrow key to open the folder.

3. Select the file using the up and down arrow keys.

4. Press the **Export File** (F1) button to export a copy of the run data (.zpcr) to the USB key, as shown in Figure 56.

![FILE MANAGEMENT: File Library - File](image)

Figure 56. Exporting stand-alone run data to a USB key.

5. Use the arrow keys to navigate to the folder on the USB in which to save the file.

6. Click **Yes** (F1) to confirm the export (Figure 57).

![FILE MANAGEMENT: File Library - File](image)

Figure 57. Confirming export to USB key.

**Exporting Data Using Email**

You can choose to email your data to you directly from the C1000 thermal cycler after the run completes by configuring the email settings (see “Setting Up Email” on page 65).
To send an email with attached data (.zpcr) at the end of a run, follow these instructions:

1. After saving the name of the protocol or selecting a protocol out of the File Library using the **Run** command key, select **Options** (F4) in the Run information screen (Figure 58).

![Figure 58. Run information screen.](image)

2. Using the arrow keys to select the **Send email notification** option (Figure 59).

![Figure 59. Selecting email notification.](image)

3. Click **OK** (F1) to return to the Run information screen.

4. Use the arrow keys to navigate to the **Email Address** box and then use the alphanumeric keys to enter the name of an email address.
5. Click **OK** (F1) to continue to run the assay.

![Image of Run C1000RUN](image)

**Figure 60. Confirming export to USB key.**

### Creating a Data File

The stand-alone run data (.zpcr) data needs to be converted into a data file (.pcrd) by CFX Manager software in order to be analyzed. Follow these instructions to create a data file from a stand-alone run.

1. Click and drag the .zpcr file from the USB key directory over the main software window, or **Select File > Open > Stand-alone Run** from the main software window menu options to select the file name.

2. In the **Run File Processor** window click the **Select Plate** button to import the name of the plate file the software will use to create the data file (Figure 61).

![Image of Run File Processor](image)

**Figure 61. Assigning a plate file.**
NOTE: CFX Manager software checks the scan mode and plate size for the plate file, these must match the current run settings that were started during the experiment.
TIP: Load a Quick Plate file to quickly access data from all the wells.

**Setting Up Email**

After a run, a .zpcr file can be emailed directly to a computer running CFX Manager software. To configure the outgoing email from the C1000 thermal cycler, follows these instructions:

1. Connect an ethernet cable to the port in the back of the C1000 chassis.

2. On the main menu, select **Log In** (F1) to log in to the thermal cycler as the administrator (Figure 46 on page 55).
   
   NOTE: The logged in user name appears under the date and time when you return to the main window.

3. Select **Utilities** (F3) on the main screen (Figure 46 on page 55) to launch the utilities menu.

4. In the Utilities Menu, select 5: **Administrator Settings** (Figure 62).

---

**Figure 62. Utilities Menu.**
5. In the Administrator Settings Menu, select 9: **SMTP Server Settings** (Figure 62).

![Administrator Settings Menu](image)

6. Contact your network administrator for your the SMTP server name. **NOTE**: The SMTP server name is provided by your ISP.

7. Select **Add Server Name** (F1) (Figure 64).

![SMTP Server Information](image)

8. Type the name of the server in the text box using the virtual keypad. **NOTE**: The SMTP server name will use the following nomenclature: SMTP.YourInstitution.com. *Do not use Bio-Rad.com in the name.*
9. Click **Save** (F1) to save the name of the SMTP server (Figure 65).

![SMTP Server Information](image)

---

**Figure 65. Saving server name.**

10. The added server name will appear in the SMTP Server Names pull-down menu, as shown in Figure 66.

![SMTP Server Information](image)

---

**Figure 66. Added server name.**

11. Select **Set Current Server** (F3) to set the current server to be used for email (Figure 66).
12. Use the arrow keys to select the **Test Current Server** button and click the **Enter** navigation button (Figure 67).

![SMTP Server Information](image)

Please contact your Network Administrator for proper SMTP server name information

SMTP Server Names: SMTP.BIO-RAD.COM

Current SMTP Server: SMTP.BIO-RAD.COM

Test Current Server

**Figure 67. Test the current server.**

13. Type an email address in the text box and select **Test Server** (F1) (Figure 68).

![SMTP Server Information](image)

Please contact your Network Administrator for proper SMTP server name information

SMTP Server Names: SMTP.BIO-RAD.COM

Current SMTP Server: SMTP.BIO-RAD.COM

Test Current Server

**Figure 68. Enter email to test the current server.**

14. The C1000 thermal cycler will send an email to the entered address as a test of the SMTP server configuration.

**NOTE:** Some SMTP servers do not allow attachments, and others allow attachments only up to certain sizes. If you will use CFX Manager software or the C1000 chassis to email data files and/or reports, you may want to test your server's ability to email attachments by checking the Test Attachment box, and setting the attachment size in MB with up to 5 megabytes (MB) or more.
7 Data Analysis Overview

Read this chapter for information about data analysis:

- Data Analysis window (below)
- Quantitation tab (page 72)
- Well groups (page 73)
- Data analysis settings (page 73)
- Well selectors (page 75)
- Charts (page 78)
- Spreadsheets (page 79)

Data Analysis Window

During data analysis, changing the way the data are displayed by changing the contents of wells in the Plate Editor never changes the fluorescence data that were collected from each well during the run. Once the module collects fluorescence data you cannot delete those data, but you can choose to remove data from view and analysis.

To change the content of wells after a run, open the Plate Editor by clicking the Edit/View Plate button at the top of the Data Analysis window.

TIP: You can add or edit information about the contents of the well before, during, or after you run the real-time PCR experiment. You must assign the scan mode and plate size before the run, and these parameters cannot change after the run.

CFX Manager software processes real-time PCR data automatically at the end of each run, and opens the Data Analysis window to display these data. Choose one of these methods to open existing data files in the Data Analysis window:

- Drag a data file (.pcrd extension) over the main software window and release it
- Select File > Open > Data File in the main software window to select a file in the Windows browser
- Click the Data Analysis button in the main software window toolbar to select a file in the Windows browser
- Select File > Recent Data Files to select from a list of the ten most recently opened data files
The Data Analysis window displays up to nine tabs (Figure 69). Each tab shows the analyzed data for a specific analysis method:

![Figure 69. All the tabs that can display in the Data Analysis window.](image)

The software only displays a tab in the Data Analysis window if the data are collected in the run and data are available for that type of analysis. For example, the Melt Curve and Melt Curve Data tabs do not appear if the experiment does not include a melt curve step.

**Data Analysis Toolbar**

The toolbar in the Data Analysis window (Figure 70) provides quick access to important data analysis functions.

![Figure 70. Toolbar in the Data Analysis window.](image)

Table 19 lists the functions of buttons in the toolbar.

**Table 19. Toolbar in the Data Analysis window**

<table>
<thead>
<tr>
<th>Toolbar button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save icon" /></td>
<td>Save</td>
<td>Save the current data file</td>
</tr>
<tr>
<td><img src="image" alt="Print icon" /></td>
<td>Print</td>
<td>Print the selected window</td>
</tr>
<tr>
<td><img src="image" alt="Trace Style icon" /></td>
<td>Trace Style</td>
<td>Open Trace Style window</td>
</tr>
<tr>
<td><img src="image" alt="Report icon" /></td>
<td>Report</td>
<td>Open a Report for the current data file</td>
</tr>
<tr>
<td><img src="image" alt="View/Edit Plate icon" /></td>
<td>View/Edit Plate</td>
<td>Open the Plate Editor to view and edit the contents of the wells</td>
</tr>
<tr>
<td><img src="image" alt="Well Groups icon" /></td>
<td>Well Groups</td>
<td>Select a well group name from the pull-down menu. The default selection is All Wells</td>
</tr>
<tr>
<td><img src="image" alt="Help icon" /></td>
<td>Help</td>
<td>Open the software Help site for more information about data analysis</td>
</tr>
</tbody>
</table>
Data Analysis Menu Bar

The menu bar in the Data Analysis window (Figure 71) provides these menu items:

Figure 71. Menu bar in the Data Analysis window.

Table 20 lists the functions of items in the menu bar.

Table 20. Menu bar items in Data Analysis window

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Save</td>
<td>Save the file</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Save the file with a new name</td>
</tr>
<tr>
<td></td>
<td>Repeat Experiment</td>
<td>Extract the protocol and plate file from the current experiment to rerun it</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Exit the Data Analysis window</td>
</tr>
<tr>
<td>View</td>
<td>Run Log</td>
<td>Open a Run Log window to view the run log of those data file</td>
</tr>
<tr>
<td>Settings</td>
<td>Analysis Mode</td>
<td>Select Baseline Subtraction method for the selected well groups in the data</td>
</tr>
<tr>
<td></td>
<td>C(t) Determination Mode</td>
<td>Select Regression or Single-Threshold mode to determine how C(t) values are calculated for each trace</td>
</tr>
<tr>
<td></td>
<td>Baseline Thresholds</td>
<td>Open the Baseline Thresholds window to adjust the baseline or the threshold</td>
</tr>
<tr>
<td></td>
<td>Trace Styles</td>
<td>Open the Trace Styles window</td>
</tr>
<tr>
<td></td>
<td>View/Edit Plate</td>
<td>Open the Plate Editor to view and edit the plate</td>
</tr>
<tr>
<td></td>
<td>Mouse Highlighting</td>
<td>Turn on or off the simultaneous highlighting of data with the mouse pointer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TIP: If the Mouse Highlighting is turned off, then hold down the Control key to temporarily turn on the highlighting</td>
</tr>
<tr>
<td></td>
<td>Display Threshold Values</td>
<td>Display the value of the threshold line in the chart</td>
</tr>
<tr>
<td>Tools</td>
<td>Reports</td>
<td>Open the Report for this data file</td>
</tr>
<tr>
<td></td>
<td>Import Fluorophore Calibration</td>
<td>Select a calibration file to apply to the current data file</td>
</tr>
<tr>
<td></td>
<td>Replace Plate</td>
<td>Replace the current plate file in the data analysis</td>
</tr>
<tr>
<td></td>
<td>Export All Data Sheets to Excel</td>
<td>Export all the spreadsheet views from every tab to a separate Excel formatted file</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td>Open software Help for more information about data analysis</td>
</tr>
</tbody>
</table>
Quantitation Tab

Each tab in the Data Analysis window displays data in charts and spreadsheets for a specific analysis method, with a well selector to select the data you want to show. The Data Analysis window opens with the Quantitation tab (Figure 72) in front. The Amplification chart data in this tab should be used to determine the appropriate analysis settings for the experiment.

NOTE: The Amplification chart shows the relative fluorescence (RFU) for each well at every cycle. Each trace in the chart represents data from a single fluorophore in one well.

![Figure 72. Layout for the Quantitation tab in the Data Analysis window.](image)

NOTE: The software links the data in the panes of each data analysis tab. For example, highlighting a well by placing the mouse pointer over the well in the well selector view highlights the data in all the other panes.

Step Number Selector

The CFX96 system or CFX384 system can acquire fluorescence data at multiple protocol steps; the software maintains the data acquired at each step independent. The software displays the Step Number selector below the Standard Curve chart on the Quantitation tab whenever a protocol contains more than one data collection step. When you select a step, the software applies that selection to all the data that are shown in the Data Analysis window. Figure 73 shows the data collection step number is 3 for all the data.

![Figure 73. Step Number selection in the Data Analysis window.](image)
**Viewing Well Groups in Data Analysis**

Wells in the plate can be grouped into subsets for independent analysis using well groups. When you create well groups in the **Well Groups Manager** window in the Plate Editor (page 50), group names appear in the Data Analysis window within the Well Groups list on the toolbar.

**TIP:** To open the Plate Editor, click the **View/Edit Plate** button in the Data Analysis window toolbar.

By default, the well group **All Wells** is selected when the Data Analysis Window is first opened, with the data in all wells with content shown in the charts and spreadsheets.

Figure 74 shows Group 2 selected in the Well Groups menu. Only the wells in that well group appear loaded with content in the well selector and data only for these wells are included in the data analysis calculations.

![Figure 74. Data Analysis window with Group 2 selected.](image)

**Data Analysis Settings**

The **Amplification** chart data in the Quantitation tab shows the relative fluorescence (RFU) for each well at every cycle. Each trace in the chart represents data from a single fluorophore in one well. These data are used to determine C(t) values for each well on a per fluorophore basis. The software uses one of two modes to determine C(t) values:

- **Regression.** This mode applies a multivariable, nonlinear regression model to individual well traces and then uses this model to compute an optimal C(t) value
- **Single Threshold.** This mode uses a single threshold value to calculate the C(t) value based on the threshold crossing point of individual fluorescence traces
Adjusting the Threshold

In Single-Threshold mode, adjust the threshold for a fluorophore by clicking on the threshold line in the Amplification chart and moving the mouse pointer vertically. Alternatively, specify an exact crossing threshold for the selected fluorophore by following these instructions:

1. Select one fluorophore in the fluorophore selector in the Quantitation tab (Figure 72) by clicking the boxes next to the fluorophore name located under the Amplification chart.

2. Select Settings > Baseline Thresholds in the menu bar to open the Baseline Thresholds window.

3. Adjust the crossing threshold (Figure 75) for the fluorophore by clicking User Defined and entering a threshold number.

4. Click OK to confirm the change and close the window.

Baseline Settings

The software automatically sets the baseline individually for each well. Once you select the wells for analysis, check the baseline settings in these wells. Open the Baseline Thresholds window (Figure 75) to change the default baseline for selected wells. To open this window:

1. Select one fluorophore in the fluorophore selector in the Quantitation tab (Figure 72) by clicking the boxes next to the fluorophore name located under the Amplification chart.

2. Select Settings > Baseline Thresholds to open the Baseline Thresholds window.

To adjust the begin and end baseline cycle for each well:

1. In the Baseline Cycles pane, select one or more wells by clicking the row number, clicking the top left corner to select all wells, holding down the Control key to select multiple individual wells, or holding down the shift key to select multiple wells in a row.

2. Adjust the Baseline Begin cycle and Baseline End cycle for all selected wells or change the Begin and End cycle number at the bottom of the spreadsheet (Figure 75).
3. Click **OK** to confirm the change and close the window.

**Select the Analysis Mode**

Select the Analysis Mode to determine the method of baseline subtraction for all fluorescence traces. Select **Settings > Analysis Mode** to choose one of these three options:

- **No Baseline Subtraction.** The software displays the data as relative fluorescence traces. Some analysis is not possible in this analysis mode, and therefore the software does not display the Gene Expression, End Point, and Allelic Discrimination tabs.

- **Baseline Subtracted.** The software displays the data as baseline subtracted traces for each fluorophore in a well. The software must baseline subtract the data to determine threshold cycles, construct standard curves, and determine the concentration of unknown samples. To generate a baseline subtracted trace, the software fits the best straight line through the recorded fluorescence of each well during the baseline cycles, and then subtracts the best fit data from the background subtracted data at each cycle.

- **Baseline Subtracted Curve Fit.** The software displays the data as baseline subtracted traces, and the software smoothes the baseline subtracted curve using a centered mean filter. This process is performed so that each C(t) is left invariant.

**Well Selectors**

Click the wells in the well selector to show or to hide the data in the charts or spreadsheets throughout the Data Analysis window:

- To hide one well, highlight and click the individual well. To show that well, highlight and click the well again.
- To hide multiple wells, click and drag across the wells you want to select. To show those wells, click and drag across the wells again.
- Click the top left corner of the plate to hide all the wells. Click the top left corner again to show all wells.
- Click the start of a column or row to hide those wells. Click the column or row again to show the wells.

Only wells loaded with content (entered in the Plate Editor) can be selected in the well selector, and their color shows if they are selected. As shown in Figure 76, the well selector shows these three types of wells:

- **Selected, loaded wells (blue).** These wells contain a loaded **Unk** (unknown) sample type. The data from these wells appear in the Data Analysis window.

- **Unselected, loaded wells (light gray).** These wells contain loaded **Std** and **Pos** sample types. The data from unselected wells do not appear in the Data Analysis window.
Data Analysis Overview

- **Empty wells (dark gray).** These wells were not loaded in the Plate Editor window.

![Figure 76. Three well colors appear in a well selector.](image)

**Well Selector Right-Click Menu Items**

Right-click any well selector view to select the items listed in Table 21.

**Table 21. Right-click menu items in the well selectors**

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copy the content of the well to a clipboard, including Sample Type and optional Replicate #</td>
</tr>
<tr>
<td>Copy as Image</td>
<td>Copy the well selector view as an image</td>
</tr>
<tr>
<td>Print...</td>
<td>Print the well selector view</td>
</tr>
<tr>
<td>Print Selection...</td>
<td>Print the current selection</td>
</tr>
<tr>
<td>Export to Excel...</td>
<td>Export the data to an Excel spreadsheet</td>
</tr>
</tbody>
</table>

**Exclude Wells From Analysis**

To exclude any wells from data analysis temporarily, follow these instructions:

**RIGHT-CLICK OPTION**

1. Right-click on the well in the well selector, on a fluorescence trace, or on a point plotted on the standard curve.
2. Choose **Exclude Well XX from Analysis** from the menu options.

![Figure 77. Right-click to exclude a well from analysis.](image)

**NOTE:** Unselect the **Exclude Well from Analysis** from the right-click menu to reinclude the well.

**PLATE EDITOR OPTIONS**

1. Click the **View/Edit Plate** button on the toolbar in the Data Analysis window.

2. Select one or more wells in the well selector view.

3. Click **Exclude Wells in Analysis** (Figure 78) to exclude the selected wells. This checkbox is at the bottom of the Plate Editor controls on the right side of the window.

![Figure 78. Exclude Wells in Analysis checkbox at bottom of the pane.](image)
In Figure 79, one well (under the pointer) was excluded from data analysis in the Plate Editor. Notice that the excluded well is marked with an asterisk (*).

![Figure 79. Excluded well (marked with *) in the Plate Editor.](image)

Alternatively, to permanently remove wells from analysis, clear the contents from wells in the Plate Editor by clicking the **Clear Wells** button.

**WARNING!** You will have to reenter any well content that is cleared.

## Charts

Each chart in the Data Analysis window displays the data in a different graph and includes options for adjusting the data. To magnify an area of the chart, select an area by clicking and dragging the mouse. The software resizes the chart and centers it on the selected area.

TIP: Return the chart to a full view by right-clicking on the chart and selecting **Set Scale to Default** from the right-click menu.

### Common Right-Click Menu Items for Charts

Right-click menu items are available on all charts. Some of the available items are present for all charts, and these items can be used to change how the data are displayed or to easily export the data from a chart (Table 22).

**Table 22. Right-click menu items for charts**

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copy the chart into the clipboard</td>
</tr>
<tr>
<td>Save Image As...</td>
<td>Save the chart image in the selected image file type. Select from these formats: PNG (default), GIF, JPG, TIF, or BMP</td>
</tr>
<tr>
<td>Page Setup...</td>
<td>Preview and select page setup for printing</td>
</tr>
<tr>
<td>Print...</td>
<td>Print the chart</td>
</tr>
<tr>
<td>Show Point Values</td>
<td>Show the point values when the mouse moves over a point on the chart.</td>
</tr>
<tr>
<td>Set Scale to Default</td>
<td>Return to default chart view after magnifying the chart</td>
</tr>
<tr>
<td>Chart Options...</td>
<td>Open the Chart Options window to change the chart, including changing the title, selecting limits for the x and y axes, showing grid lines, and showing minor ticks in the axes</td>
</tr>
</tbody>
</table>
NOTE: Menu items that apply to specific charts are described in the next chapter “Data Analysis Windows” (page 81).

**Spreadsheets**

The spreadsheets shown in Data Analysis include options for sorting and transferring the data. Sort the columns by one of these methods:

- Click and drag a column to a new location in the selected table
- Click the column header to sort the data in Ascending or Descending order

To sort up to three columns of data in the Sort window, follow these steps:

1. Right-click on the spreadsheet to open the menu and select **Sort**.
2. In the Sort window, select the first column title to sort. Sort the data in Ascending or Descending order.
3. Select more than one column title by selecting the title in the pull-down menu. Select **Ascending** or **Descending** to sort the column in that order.
4. Click **OK** to sort the data, or click **Cancel** to stop sorting.

Highlight the data on the associated charts and well selector by holding the mouse pointer over a cell. If you click in the cell, you can copy the contents to paste into another software program.

**Common Right-Click Menu Items for Spreadsheets**

Right-click any spreadsheet view to select the items shown in Table 23.

**Table 23. Right-click menu items for spreadsheets**

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copy the contents of the selected wells to a clipboard. Then, paste the contents into a spreadsheet such as Excel</td>
</tr>
<tr>
<td>Copy as Image</td>
<td>Copy the spreadsheet view as an image file and paste it into a file that accepts an image file such as text, image, or spreadsheet files</td>
</tr>
<tr>
<td>Print...</td>
<td>Print the current view</td>
</tr>
<tr>
<td>Print Selection...</td>
<td>Print the current selection</td>
</tr>
<tr>
<td>Export to Excel...</td>
<td>Export the data to an Excel spreadsheet</td>
</tr>
<tr>
<td>Export to Text...</td>
<td>Export the data to a text editor</td>
</tr>
<tr>
<td>Export to Xml</td>
<td>Export the data to an Xml file</td>
</tr>
<tr>
<td>Export to Html</td>
<td>Export the data to an Html file</td>
</tr>
<tr>
<td>Find...</td>
<td>Search for text</td>
</tr>
<tr>
<td>Sort...</td>
<td>Sort the data in up to three columns</td>
</tr>
</tbody>
</table>
Data Analysis Overview
8 Data Analysis Windows

Read this chapter for more information about the tabs in the Data Analysis window:

- Quantitation tab (below)
- Quantitation Data tab (page 84)
- Melt Curve tab (page 87)
- Melt Curve Data tab (page 89)
- End Point tab (page 91)
- Allelic Discrimination tab (page 93)
- QC tab (page 93)
- Run Information tab (page 96)
- Data file reports (page 97)

Quantitation Tab

Use the data in the Quantitation tab (Figure 80) to set the data analysis conditions, including the baseline settings for individual wells and the threshold settings. The Quantitation tab shows data in these four views:

- **Amplification chart.** Shows the relative fluorescence units (RFUs) for each well at every cycle. Each trace in the chart represents data from a single fluorophore in one well.
- **Standard curve.** This graph is only shown if the experiment includes wells designated as Sample Type Standard. Shows a standard curve with the threshold cycle plotted against the log of the starting quantity. The legend shows the Reaction Efficiency (E) for each fluorophore in the wells with a standard sample type.
- **Well selector.** Selects the wells with the fluorescence data you want to show.
- **Spreadsheet.** Shows a spreadsheet of the data collected in the selected wells.

**Figure 80. Layout for the Quantitation tab in Data Analysis window.**

**Fluorophore Selector**

To select the fluorophore data to display in the Quantitation tab charts and spreadsheets, click the fluorophore selector below the Amplification chart (Figure 81). Click the box next to the fluorophore name to show or hide the fluorophore data throughout the data analysis window.

**Figure 81. Fluorophore selector with FAM selected.**

**Trace Styles Window**

Open the Trace Styles window (Figure 82) to adjust the appearance of traces in the amplification and melt curve charts in the Quantitation and Melt Curve tabs.

To open this window, follow these steps:

1. Select only one fluorophore in the fluorophore selection boxes (Figure 81) under the Amplification chart.

2. Click the **Trace Styles** button in the Data Analysis toolbar, or select **Settings > Trace Styles** in the Data Analysis menu bar.
Figure 82. Trace Styles window.

Use the tools in the Trace Styles window to adjust appearance of traces and preview the changes in the well selector at the bottom of the window.

- Select a specific set of wells by using the well selector at the bottom of the window. Alternatively, select wells that contain one sample type in the pull-down menu in the Wells column, including Unknown, Standard, NTC (no template control), Positive Control, Negative Control, or NRT (no reverse transcriptase control) sample types.
- Click the box in the Color column to select a color for the wells.
- Select a symbol from the pull-down menu in the Symbol column.
- Click Show Contents to show the sample types in each well, or click Show Symbols to show the selected Symbols in each well.
- Click Remove Symbols to remove all the added symbols from all wells.
- Click Restore Default Colors to return to the default trace colors.

Log Scale Option

Click the Log Scale box at the bottom of the Amplification chart to view the fluorescence traces in a semi-log scale, as shown in Figure 83.

Figure 83. Log Scale option selected in Amplification chart.

TIP: To magnify any area of the chart, click and drag the mouse across an area. To return to a full view, right-click and select Set Scale to Default from the menu.
Standard Curve Chart

The software creates a Standard Curve chart (Figure 84) in the Quantitation tab if the data include sample types defined as standard (Std) for one fluorophore in the experiment.

Figure 84. Standard Curve chart.

The Standard Curve chart displays the following information:

- Name for each curve (the fluorophore name)
- Color of each fluorophore
- Reaction efficiency (E). Use this statistic to optimize a multiplex reaction, and equalize the data for a standard curve
  NOTE: The reaction efficiency describes how much of your target is being produced with each cycle in the protocol. An efficiency of 100% means that you are doubling your target with each cycle.
- Coefficient of determination, $R^2$ (written as $R^2$). Use this statistic to determine how correctly the line describes the data (goodness of fit)

Chart Right-Click Menu Options

In addition to the common right-click menu options to copy, print and export charts, Table 24 lists the menu options available only on the Amplification chart.

Table 24. Amplification chart specific right-click menu options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Threshold Values</td>
<td>Display the threshold value for each amplification curve on the chart</td>
</tr>
<tr>
<td>Trace Styles...</td>
<td>Open the Trace Styles window to change trace styles that appear on the Quantitation and Melt Curve tabs</td>
</tr>
<tr>
<td>Baseline Thresholds...</td>
<td>Open the Baseline Thresholds window to change baseline or thresholds of each fluorophore (changes appear in Amplification chart in Quantitation tab)</td>
</tr>
</tbody>
</table>
Quantitation tab Spreadsheet

Table 25 shows the type of data shown in the spreadsheet at the bottom right side of the Quantitation tab:

Table 25. Quantitation tab spreadsheet content

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Fluor</td>
<td>Fluorophore detected</td>
</tr>
<tr>
<td>Content</td>
<td>A combination of the Sample Type (required) and Replicate # (optional) loaded in the Plate Editor</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample Name loaded in the Plate Editor wells</td>
</tr>
<tr>
<td>C(t)</td>
<td>Threshold cycle for each trace</td>
</tr>
</tbody>
</table>

TIP: To make changes to the Content and Sample, open the Plate Editor by clicking the View/Edit Plate button.

Quantitation Data Tab

The Quantitation Data tab shows spreadsheets that describe the quantitation data collected in each well. Select one of the three options to show the data in different formats:

- **Results.** Displays a spreadsheet view of the data
- **Plate.** Displays a view of the data in each well as a plate map
- **RFU.** Choose this spreadsheet to show the RFU quantities in each well for each cycle

TIP: Right-click any spreadsheet for options, including the sort option.

Results Spreadsheet

Select a Results spreadsheet (Figure 85) to see data for each well in the plate.

![Figure 85. Quantitation Data tab with Results spreadsheet selected.](image)

NOTE: All Std. Dev (standard deviation) calculations apply to the replicate groups assigned in the wells in the Plate Editor window. The calculations average the C(t) value for each well in the replicate group.

The Results spreadsheet includes the type of information listed in Table 26.

Table 26. Results spreadsheet content

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Fluor</td>
<td>Fluorophore detected</td>
</tr>
<tr>
<td>Content</td>
<td>Sample type and replicate number</td>
</tr>
</tbody>
</table>
Plate Spreadsheet

Select the Plate spreadsheet to see a plate map of the data for one fluorophore at a time. Select each fluorophore by clicking a tab at the bottom of the spreadsheet. Figure 86 shows the Plate spreadsheet as plate map.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Amplification target name (gene)</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample description</td>
</tr>
<tr>
<td>Threshold Cycle (C(t))</td>
<td>Threshold cycle</td>
</tr>
<tr>
<td>C(t) Mean</td>
<td>Mean of the threshold cycle for the replicate group</td>
</tr>
<tr>
<td>C(t) Std. Dev</td>
<td>Standard deviation of the threshold cycle for the replicate group</td>
</tr>
<tr>
<td>Starting Quantity (SQ)</td>
<td>Estimate of the starting quantity of the target</td>
</tr>
<tr>
<td>Log Starting Quantity</td>
<td>Log of the starting quantity</td>
</tr>
<tr>
<td>SQ Mean</td>
<td>Mean of the starting quantity</td>
</tr>
<tr>
<td>SQ Std. Dev</td>
<td>Standard deviation of the starting quantity</td>
</tr>
<tr>
<td>Set Point</td>
<td>Temperature of sample in the well for a gradient step</td>
</tr>
<tr>
<td>Sample Note</td>
<td>One round of denaturation, annealing, and extension, or one round of annealing and extension steps in a protocol</td>
</tr>
</tbody>
</table>

Table 26. Results spreadsheet content (continued)

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>Sample type and replicate number</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample description</td>
</tr>
<tr>
<td>Copy Number</td>
<td>Starting number of targets in the sample</td>
</tr>
<tr>
<td>RFU</td>
<td>Relative fluorescence units</td>
</tr>
</tbody>
</table>

Table 27. Plate spreadsheet contents
RFU Spreadsheet

Select the RFU spreadsheet to see the RFU readings for each well acquired at each cycle of the experiment. Select individual fluorophores by clicking a tab at the bottom of the spreadsheet. The well number appears at the top of each column, and the cycle number appears to the left of each row (Figure 87).

![RFU Spreadsheet](image.png)

Figure 87. RFU spreadsheet in the Quantitation Data tab.

The RFU spreadsheet includes the type of information shown in Table 28.

Table 28. RFU spreadsheet contents

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well number</td>
<td>Well data, listed by position in the plate for all the loaded wells</td>
</tr>
<tr>
<td>(A2, A3, A4, A5, A6...)</td>
<td></td>
</tr>
<tr>
<td>Cycle</td>
<td>One round of denaturation, annealing, and extension, or one round of annealing and extension steps in a protocol</td>
</tr>
</tbody>
</table>

Melt Curve Tab

For DNA-binding dyes and noncleavable hybridization probes, the fluorescence is brightest when the two strands of DNA anneal. Therefore, as the temperature rises towards the melting temperature (Tm), fluorescence decreases at a constant rate (constant slope). At the Tm, there is a dramatic reduction in the fluorescence with a noticeable change in slope. The rate of this change is determined by plotting the negative first Regression of fluorescence versus temperature (-d(RFU)/dT). The greatest rate of change in fluorescence results in visible peaks and represents the Tm of the double-stranded DNA complexes.

The software plots the RFU data collected during a melt curve as a function of temperature. To analyze melt peak data, the software assigns a beginning and ending temperature to each peak by moving the threshold bar. The floor of the peak area is specified by the position of the melt threshold bar. A valid peak must have a minimum height relative to the distance between the threshold bar and the height of the highest peak.

Open the Melt Curve tab (Figure 88) to determine the melting temperature (Tm) of amplified PCR products. This tab shows the melt curve data in these four views:

- **Melt Curve.** View the real-time data for each fluorophore as RFUs per temperature for each well
- **Melt Peak.** View the negative regression of the RFU data per temperature for each well
- **Well Selector.** Select wells to show or hide the data
- **Peak spreadsheet.** View a spreadsheet of the data collected in the selected well

NOTE: This spreadsheet only shows as many as two peaks for each trace. To see more peaks, click the Melt Curve Data tab (page 89).
Data Analysis Windows

Figure 88. Layout of the Melt Curve tab in the Data Analysis window.

Adjusting Melt Curve Data

Adjust the Melt Curve data by any of these methods:

- Click and drag the threshold bars in the Melt Peak chart to include or exclude peaks in data analysis
- Select Positive in the Peaks pull-down menu to show the spreadsheet data for the peaks above the Melt Threshold line, or select Negative to view the spreadsheet data for the peaks below the Melt Threshold line
- Open the Trace Styles window to change the color of the traces in Melt Curve and Melt Peak charts.
- Select a number in the Step Number selector (page 82) to view the Melt Curve data at another step in the protocol. The list shows more than one step if the protocol includes plate read (camera icon) in two or more melt curve steps
- Select wells in the well selector to focus on subsets of the data
- Select a well group (page 73) to view and analyze a subset of the wells in the plate. Select each well group by name in the Well Group pull-down menu in the toolbar

Melt Curve tab Spreadsheet

Table 29 shows the type of information in the spreadsheet at the bottom right side of the Melt Curve tab.

Table 29. Melt Curve tab spreadsheet contents

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Fluor</td>
<td>Fluorophore detected</td>
</tr>
<tr>
<td>Content</td>
<td>A combination of Sample Type and Replicate #</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample Name loaded in the Plate Editor</td>
</tr>
<tr>
<td>Melt Temp</td>
<td>The temperature of the melt peak for each well. Only the two highest peaks are displayed in this spreadsheet.</td>
</tr>
<tr>
<td>Peak Height</td>
<td>The highest point of the melt peak (-d(RFU)/dT)</td>
</tr>
</tbody>
</table>
Melt Curve Data Tab

The Melt Curve Data tab shows the data from the Melt Curve tab in multiple spreadsheets that include all the melt peaks for each trace. Select one of these four options to show the melt curve data in different spreadsheets:

- **Melt Peaks.** List all the data, including all the melt peaks, for each trace
- **Plate.** List a view of the data and contents of each well in the plate
- **RFU.** List the RFU quantities at each temperature for each well
- **-d(RFU)/dT.** List the negative rate of change in RFU as the temperature (T) changes. This is a first regression plot for each well in the plate

### Melt Peaks Spreadsheet

Select the Melt Peaks spreadsheet (Figure 89) to view melt curve data.

![Figure 89. Melt Peaks spreadsheet in Melt Curve Data tab.](image)

The Melt Peaks spreadsheet (Figure 89) includes the type of information shown in Table 30.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Fluor</td>
<td>Fluorophore detected</td>
</tr>
<tr>
<td>Content</td>
<td>Sample Type listed in the Plate Editor window</td>
</tr>
<tr>
<td>Target</td>
<td>Amplification target (gene)</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample Name listed in the Plate Editor window</td>
</tr>
<tr>
<td>Melt Temperature</td>
<td>The melting temperature of each product, listed as one peak (highest) per row in the spreadsheet</td>
</tr>
<tr>
<td>Peak Height</td>
<td>Height of the peak</td>
</tr>
<tr>
<td>Begin Temperature</td>
<td>Temperature at the beginning of the peak</td>
</tr>
<tr>
<td>End Temperature</td>
<td>Temperature at the end of the peak</td>
</tr>
</tbody>
</table>
**Plate Spreadsheet**

Select the Plate spreadsheet (Figure 90) to view melt curve data in a plate format:

![Plate spreadsheet](image)

Figure 90. Plate spreadsheet in Melt Curve Data tab.

NOTE: To adjust the peak that the software calls, adjust the threshold line in the Melt Peak chart on the Melt Curve tab.

The Plate spreadsheet includes the types of information shown in Table 31.

### Table 31. Plate spreadsheet content

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>A combination of Sample Type (required) and Replicate # (optional)</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample description</td>
</tr>
<tr>
<td>Peak 1</td>
<td>First melt peak (highest)</td>
</tr>
<tr>
<td>Peak 2</td>
<td>Second (lower) melt peak</td>
</tr>
</tbody>
</table>

**RFU Spreadsheet**

Select the RFU spreadsheet to view the fluorescence for each well at each cycle acquired during the melt curve (Figure 91).

![RFU spreadsheet](image)

Figure 91. RFU spreadsheet in Melt Curve Data tab.
Table 32 lists the type of information shown in the RFU spreadsheet.

**Table 32. RFU spreadsheet content**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well number (A1, A2, A3, A4, A5...)</td>
<td>Well position in the plate for the loaded wells</td>
</tr>
<tr>
<td>Temperature</td>
<td>Melting temperature of the amplified target. Plotted as one well per row, and multiple wells for multiple products in the same well</td>
</tr>
</tbody>
</table>

**-d(RFU)/dT Spreadsheet**

Select the -d(RFU)/dT spreadsheet to view the type of data shown in Figure 92.

![-d(RFU)/dT Spreadsheet](image)

**Table 33. -d(RFU)/dT spreadsheet content**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well number (A1, A2, A3, A4, A5...)</td>
<td>Well position in the plate for the loaded wells</td>
</tr>
<tr>
<td>-d(RFU)/dT</td>
<td>Negative rate of change in RFU as temperature (T) changes</td>
</tr>
</tbody>
</table>

**End Point Tab**

Open the End Point tab to analyze final relative fluorescence units (RFUs) for the sample wells. The software compares the RFU levels for wells with unknown samples to the RFU levels for wells with negative controls, and “calls” the unknown as a Positive or Negative. Positive samples have an RFU value that is greater than the average RFU value of the negative controls plus the Cut Off Value.

To analyze the end point data, the plate must contain negative controls, or the software cannot make the call. Run one of these two types of protocols:

- **Run a Quantitation protocol.** Set up a standard protocol. After running the experiment, open the Data Analysis window, adjust the data analysis settings in the Quantitation tab, and then click the End Point tab to pick an end point cycle.
- **Run an End Point Only protocol.** Load the End Point Only protocol in the Plate tab of the Experiment Setup window, select or create a plate, and run the experiment.
The End Point tab shows the average RFU values to determine whether or not the target was amplified by the last (end) cycle. Use these data to determine if a specific target sequence is present (positive) in a sample. Positive targets have higher RFU values than the cutoff level you define.

TIP: To create an end point protocol, open the Protocol tab (Experiment Setup window) and select **Options > End Point Only Run**.

The software displays these data in the End Point tab:

- **Settings.** Adjust data analysis settings
- **Results.** Shows the results immediately after you adjust the Settings
- **Well Selector.** Select the wells with the end point data you want to show
- **Well spreadsheet.** Shows a spreadsheet of the end RFU collected in the selected wells

The Results list includes this information:

- **Lowest RFU value.** Lowest RFU value in the data
- **Highest RFU value.** Highest RFU value in the data
- **Negative Control Average.** Average RFU for the wells that contain negative controls
- **Cut Off Value.** Calculated by adding the tolerance (RFU or Percentage of Range listed in the Settings) and the average of the negative controls. Samples with RFUs that are greater than the cut off value will be called “Positive”. To adjust the cut off value, change the RFU or Percentage of Range

The Cut Off Value is calculated using this formula:

\[
\text{Cut Off Value} = \text{Negative Control Average} + \text{Tolerance}
\]

Select a tolerance by one of these methods:

- **RFUs (default).** Select this method to use an absolute RFU value for the tolerance. The minimum RFU tolerance value is 2. The maximum is the absolute value of the highest RFU value minus the absolute value of the lowest RFU value. The default RFU tolerance value is 10% of the total RFU range
- **Percent of Range.** Select this method to use a percentage of the RFU range for the tolerance. The minimum percent of range is 1 percent. The maximum percent of range is 99 percent. The default percent of range is 10 percent

---

Figure 93. Layout of the End Point analysis tab.
Adjusting the End Point Data Analysis

Adjust the information shown in the End Point tab by following these methods:

- Choose a Fluorophore from the pull-down list to view the data
- Choose an End Cycle to Average value to set the number of cycles that the software uses to calculate the average end point RFU
- Select RFUs to view the data in relative fluorescence units
- Select Percentage of Range to view the data as a percentage of the RFU range
- Select wells in the well selector to focus on subsets of the data
- Select a well group (page 73) to view and analyze a subset of the wells in the plate. Select each well group by name in the Well Group pull-down menu in the toolbar

Data Description for End Point Analysis

Table 34 list the type of information shown in the spreadsheet in the End Point tab.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Fluor</td>
<td>Fluorophore detected</td>
</tr>
<tr>
<td>Content</td>
<td>A combination of the Sample type and Replicate #</td>
</tr>
<tr>
<td>End RFU</td>
<td>RFU at the end point cycle</td>
</tr>
<tr>
<td>Call</td>
<td>Positive or Negative, where positive samples have an RFU value greater than the average RFU of the negative controls plus the Cut Off Value</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample Name loaded in the Plate Editor</td>
</tr>
</tbody>
</table>

Allelic Discrimination Tab

The Allelic Discrimination tab assigns the genotypes to wells with unknown samples using the RFU or C(t) of positive control samples. Use this data to identify samples with different genotypes, including Allele 1, Allele 2, Heterozygote, Unknown, Control 1, or Control 2.

NOTE: The data for allelic discrimination must come from multiplex experiments with at least two fluorophores. Each fluorophore identifies one allele in all samples.

Allelic discrimination analysis requires the following minimal well contents:

- Two fluorophores in each well, except the wells that contain positive controls can contain only one fluorophore
- One fluorophore that is common to all wells in the well group
- NTC (no template control) samples if you want to normalize the data

The software displays allelic discrimination data in these layouts:

- RFU or C(t) chart. View the data in a graph of RFU or C(t) for Allele 1/Allele 2. Each point in the graph represents data from a single fluorophore in one well
- Well spreadsheet. Shows a spreadsheet listing the allelic discrimination data collected in each well of the plate
- Well selector. Select the wells with the end point data you want to show
**Well spreadsheet.** Shows a spreadsheet listing the allelic discrimination data collected in the selected wells.

**Figure 94. Layout of the Allelic Discrimination tab in the Data Analysis window.**

### Adjusting Data for Allelic Discrimination

The software automatically assigns a genotype to wells with unknown samples based on the positions of the vertical and horizontal threshold bars, and then lists genotype calls in the spreadsheet view. To automatically call genotypes, the software uses positive controls (when available), or estimates the thresholds. The software takes an average C(t) or RFU for the positive controls to automatically set the threshold lines for discriminating the alleles.

Adjust the position of the threshold bars by clicking and dragging them, and the software automatically adjusts the calculations to make new genotype assignments:

- If the experiment contains three controls in the plate, then the position of the threshold bars is based on the mean and standard deviation of the RFU or C(t) of the controls.
- If the number of controls is less than three, then the position of the threshold bars is determined by the range of RFU or threshold cycle values in the selected fluorophore.

Adjust allelic discrimination data by following any of these methods:

- Click and drag the threshold bars in the Allelic Discrimination chart to adjust the calls in the spreadsheet.
- Select a fluorophore for each axis in the chart (X: and Y:) in the settings options on the bottom right of the window.
- Change a call manually by highlighting a row in the spreadsheet, and then selecting an option in the Call Selected Alleles list (including Allele 1, Allele 2, Heterozygote, None, Unknown, Control 1, or Control 2)
- Click the Restore Default Thresholds button to restore the vertical and horizontal bars to their original position, which are indicated by the numbers next to the bars
- Select the C(t) Display Mode to view the data as threshold levels. Select RFU Display Mode to view the data in relative fluorescence units at the selected cycle
- Select Normalize Data to normalize the RFU data shown in the chart and spreadsheet

Normalization changes the data on the chart to a range from 0 to 1 on both axes. To normalize the data, the plate must contain wells with “no template control” (NTC) sample types for both Allele 1 and Allele 2. For this plot, the RFU data are normalized to the NTC values as a linear combination of Allele 1- and Allele 2-specific RFUs. This plot is an effective way to present RFU data.

The calculations for normalized RFU follows the formulas presented in Livak et al. (1995).

$$\text{Normalized } A_1 = \frac{A_1}{A_1 + A_2 + \bar{x}(\text{NTC}_{A1+A2})}$$

Where:
- $A_1$ represents RFU for Allele 1
- $A_2$ represents RFU for Allele 2
- $\bar{x}$ represents the mean RFU

$\text{NTC}_{A1+A2}$ represents the sum of RFUs for the NTC sample of Allele 1 and Allele 2

**Allelic Discrimination tab Spreadsheet**

The Allelic Discrimination spreadsheet at the top right side of the Allelic Discrimination tab shows the information shown in Table 35.

**Table 35. Allelic Discrimination spreadsheet contents**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>RFU1 or C(t)1</td>
<td>RFU or C(t) for Allele1</td>
</tr>
<tr>
<td>RFU2 or C(t)2</td>
<td>RFU or C(t) for Allele2</td>
</tr>
<tr>
<td>Call</td>
<td>Identity of the allele, including automatic Allele 1, Allele 2, Heterozygote, None, Unknown, Control 1, Control 2</td>
</tr>
<tr>
<td>Type</td>
<td>Auto (Automatic) or Manual. Describes the way the call was made. Automatic means the software selected the call. Manual means the call was chosen by the user</td>
</tr>
</tbody>
</table>

**QC Tab**

Open the QC tab to quickly assess the quality of the experimental data based on the rules defined in the QC tab in the User Preferences window (see “QC Tab” on page 128).

The software displays QC information in these layouts (Figure 95):
Data Analysis Windows

- **Amplification chart.** Shows the RFU for each well at every cycle. Each trace in the chart represents data from a single fluorophore in one well.
- **QC rules.** Shows the currently applied QC rules and the settings that define each rule.
  NOTE: You can turn on or turn off rules by clicking the check box next to the rule in the Use Rule column.
- **Well selector.** Selects the wells with the fluorescence data you want to show.
- **Rule Description.** Shows the selected QC rule and highlights wells that fail the rule.

![Figure 95. QC tab layout.](image)

**Run Information Tab**

The Run Information tab (Figure 96) shows the protocol and other information about the run for each experiment. Open this tab for the following options:

- View the protocol
- Enter and edit the Notes. Enter or edit notes about the experiment and run by typing in the Notes box
- Enter and edit the data ID for the run by typing in the ID box
- View the **Other** section to see events, such as error messages, that might have occurred during the run. View these messages to help troubleshoot a run.

![Figure 96. Layout of the Run Information tab in the Data Analysis window.](image)

**Figure 96. Layout of the Run Information tab in the Data Analysis window.**

TIP: Right-click the Protocol to copy, export or print it. Right-click the Notes, ID, or Other panes to undo, cut, copy, paste, delete, or select the text.

### Reports for Data Files

The Report window (Figure 97) shows information about the current data file in the Data Analysis window. To open a report, select **Tools > Reports**, or click the **Reports** button on the toolbar in the Data Analysis window.

The Report window shows these three sections:

- **Menu and toolbar.** Select options to format, save and print the report or template
- **Options list (top, left side of window).** Select options to show in the report
- **Options pane (bottom, left side of window).** Enter information about a selected option
• **Preview pane (right side of window).** View the current report in a preview

![Figure 97. Example of a Report window for a data file.](image)

TIP: The layout of the report can define the type of information that appears in any report if you save the report as a template. Select **Template > Save** or **Save As** to save the layout of the current report as a template.

**Create a Data Analysis Report**

To create a report in the Data Analysis window, follow these steps:

1. Make final adjustments to the well contents, selected wells, charts, and spreadsheets in the Data Analysis window before creating the report.

2. Click the **Report** button in the Data Analysis toolbar to open the Report window.

3. Change the options you want to include in the report. The report opens with default options selected. Click the check boxes in the report options list to change whole categories or individual options within a category.

   NOTE: The data that appear in the report are dependent on the current selections within the tabs of the Data Analysis window. For example, a quantitation experiment might not contain a standard curve, and therefore those data do not appear in the Data Analysis window or in the data report.

4. Click the **Update Report** button to update the Report Preview with any changes.

5. Print or save the report. Click the **Print** button in the toolbar to print the current report. Select **File > Save** to save the report as a PDF (Adobe Acrobat Reader file), MHT (Microsoft document), or MHTML (Microsoft document) formatted file and select a location to store the file. Select **File > Save As** to save the report with a new name or in a new location.

6. (Optional) Create a report template with the information you want. To save the current report settings in a template, select **Template > Save** or **Save As**. Then load the report template the next time you want to make a new report.
## Data Analysis Report Categories

A report can include any of the options in each category described in Table 36, depending on the type of data in Data Analysis window.

**Table 36. Data analysis report categories in the options list**

<table>
<thead>
<tr>
<th>Category</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Header</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Report Information</td>
<td>Experiment date, user name, data file name, data file path, and selected well group</td>
</tr>
<tr>
<td></td>
<td>Notes</td>
<td>Notes about the data report</td>
</tr>
<tr>
<td><strong>Experiment Setup</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Run Information</td>
<td>Includes the experiment date, user, data file name, data file path, and the selected well group</td>
</tr>
<tr>
<td></td>
<td>Protocol</td>
<td>Text view of the protocol steps and options</td>
</tr>
<tr>
<td></td>
<td>Plate Display</td>
<td>Show a plate view of the information in each well of the plate</td>
</tr>
<tr>
<td><strong>Quantitation</strong></td>
<td>Analysis Settings</td>
<td>Includes the step number when data were collected, the analysis mode, and the baseline subtraction method</td>
</tr>
<tr>
<td></td>
<td>Amplification Chart</td>
<td>Copy of the amplification chart for experiments that include quantitation data</td>
</tr>
<tr>
<td></td>
<td>Standard Curve Chart</td>
<td>Copy of the standard curve chart</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Spreadsheet listing the data in each well</td>
</tr>
<tr>
<td><strong>Gene Expression</strong></td>
<td>Analysis Settings</td>
<td>Includes the analysis mode, chart data, scaling option, and chart error</td>
</tr>
<tr>
<td></td>
<td>Chart</td>
<td>Copy of the gene expression chart</td>
</tr>
<tr>
<td></td>
<td>Target Names</td>
<td>Chart of the names</td>
</tr>
<tr>
<td></td>
<td>Sample Names</td>
<td>Chart of the names</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Spreadsheet listing the data in each well</td>
</tr>
<tr>
<td><strong>Melt Curve</strong></td>
<td>Analysis Settings</td>
<td>Includes the melt step number and threshold bar setting</td>
</tr>
<tr>
<td></td>
<td>Melt Curve Chart</td>
<td>Copy of the melt curve chart</td>
</tr>
<tr>
<td></td>
<td>Melt Peak Chart</td>
<td>Copy of the melt peak chart</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Spreadsheet listing the data in each well</td>
</tr>
<tr>
<td><strong>Allelic Discrimination</strong></td>
<td>Analysis Settings</td>
<td>Includes display mode, fluorophores, cycle, thresholds, and normalized data</td>
</tr>
<tr>
<td></td>
<td>Chart</td>
<td>Copy of the allelic discrimination chart</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Spreadsheet listing the data in each well</td>
</tr>
</tbody>
</table>
Table 36. Data analysis report categories in the options list (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Point</td>
<td>Analysis Settings</td>
<td>Includes fluorophore, end cycles to average, mode, lowest RFU value, highest RFU value, and cut off value</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Spreadsheet listing the data in each well</td>
</tr>
</tbody>
</table>
9 Gene Expression Analysis

Read this chapter for information about performing Gene Expression Analysis:

- Gene Expression (below)
- Plate setup for gene expression analysis (page 102)
- Gene Expression tab (page 102)
- Experiment Settings window (page 107)
- Gene Study (page 107)
- Gene Study Report window (page 113)
- Gene expression calculations (page 115)

Gene Expression

With the use of stringently qualified controls in your reactions, you can run a gene expression experiment to normalize the relative differences in a target concentration between samples. Typically, message levels for one or more reference genes are used to normalize the expression levels of a gene of interest. Reference genes take into account loading differences or other variations represented in each sample, and they should not be regulated in the biological system being studied.

Open the Gene Expression tab to evaluate relative differences between PCR reactions in two or more wells. For example, you can evaluate relative numbers of viral genomes, or relative number of transfected sequences in a PCR reaction. The most common application for gene expression study is the comparison of cDNA concentration in more than one reaction to estimate the levels of steady state messenger RNA.

The software calculates the relative expression level of a target with one of these scenarios:

- Relative expression level of a target sequence (Target 1) relative to another target (Target 2). For example, the amount of one gene relative to another gene under the same sample treatment
- Relative expression level of one target sequence in one sample compared to the same target under different sample treatments. For example, the relative amount of one gene relative to itself under different temporal, geographical, or developmental conditions
Plate Setup for Gene Expression Analysis

To perform gene expression analysis, the contents of the wells must include the following:

- **Two or more targets.** The two targets that represent different amplified genes or sequences in your samples
- **One or more reference targets.** At least one target must be a reference target for normalized expression. Assign all reference targets in the Experiment Settings window (page 48) to analyze the data in Normalized Expression mode ($\Delta \Delta C(t)$). Experiments that do not contain a reference must be analyzed using Relative Expression mode ($\Delta C(t)$)
- **Common samples.** Your reactions must include common samples (minimum of two required) to view your data plotted in the Gene Expression tab. These samples represent different treatments or conditions for each of your target sequences. Assign a control sample (optional) in the Experiment Settings window (page 48)

The requirements for Gene Expression setup in the Plate Editor depend on whether reaction contents are **singleplex PCR** with one fluorophore in the reactions, or **multiplex PCR** with more than one fluorophore in the reactions.

Figure 98 shows an example of the minimum contents of the wells for a singleplex gene expression experiment.

![Figure 98. Example of well contents in a singleplex gene expression experiment.](image)

Figure 99 shows an example of the minimum contents of the wells for a multiplex gene expression experiment.

![Figure 99. Example of well contents in a multiplex gene expression experiment.](image)

Gene Expression Tab

The Gene Expression tab in the Data Analysis window shows the relative expression of targets in these two views:

- **Gene Expression chart.** Shows the real-time PCR data as normalized expression ($\Delta \Delta C(t)$) or relative quantity ($\Delta C(t)$)
- **Spreadsheet.** Shows a spreadsheet of the gene expression data

TIP: Right-click any chart or spreadsheet for options. Click the View/Edit Plate button to open the Plate Editor, and change well contents in the plate.
Figure 100. Layout of the Gene Expression tab in the Data Analysis window.

TIP: Right-click on the chart to select right-click menu options. Select Sort from this menu to rearrange the order of the Target and Sample names in the chart.

Normalized Gene Expression

To normalize data use the measured expression level of one or more reference genes (targets) as a normalization factor. Reference genes are targets that are not regulated in the biological system being studied, such as actin, GAPDH, or Histone H3.

To set up normalized gene expression (\(\Delta\Delta C(t)\)) analysis, follow these steps:

1. Open a data file (.pcrd extension).

2. Review the data in the Quantitation tab of the Data Analysis window. Make adjustments to the data, such as changing the threshold and the Analysis Mode.

3. Click the Gene Expression tab.

4. Choose a control in the Samples tab of the Experiment Settings window. If a control is assigned, the software normalizes the relative quantities for all genes to the control quantity, which is set to 1.

5. Select reference genes for this experiment in the Target tab of the Experiment Settings window. Gene expression analysis requires one reference among the targets in your samples.

6. Select Normalized Expression (\(\Delta\Delta C(t)\)) if it is not already selected, and then view the expression levels in the Gene Expression tab.
Relative Quantity

By definition, relative quantity ($\Delta C(t)$) data are not normalized. This method is used to quantitate samples that do not include any reference genes (targets). Typically, researchers are confident in one of the following considerations when they set up their experiment:

- Each sample represents the same amount of template in each biological sample, possibly the same mass of RNA or cDNA in each well
- Any variance in the amount of biological sample loaded will be normalized after the run by some method in the data analysis outside of the software. For example, a researcher might choose to simply divide the relative quantity value by the normalizing factor, possibly the mass of nucleic acid loaded for each sample, or the number of cells from which the nucleic acid was isolated.

Select Relative Quantity ($\Delta C(t)$) from the pull-down menu in the chart controls of the Gene Expression tab to run a Relative Quantity ($\Delta C(t)$) analysis.

TIP: To compare results to data from other gene expression experiments, open a new Gene Study (page 111), or add a data file to an existing Gene Study.

Adjusting Gene Expression Data

After selecting your analysis method, adjust the data you view in the Gene Expression tab by changing the settings options to the right of the chart.

Graph Data

Graph data options allow you to present the data in the graph with one of these two options:

- **Relative to control.** Graph the data with the axis scaled from 0 to 1. If you assign a control in your experiment, select this option to quickly visualize upregulation and downregulation of the target
- **Relative to zero.** Graph the data with the origin at zero

X-Axis Options

The X-axis option allows you to select the x-axis data of the Gene Expression graph:

- **Target.** Select this option to graph the target names on the x-axis
- **Sample.** Select this option to graph the sample names on the x-axis

Y-Axis Options

The Y-axis option allows you to show the Gene Expression graph in one of these three scales:

- **Linear.** Select this option to show a linear scale
- **Log 2.** Select this option to evaluate samples across a large dynamic range
- **Log 10.** Select this option to evaluate samples across a very large dynamic range

Scaling Options

Select **Normalized Gene Expression ($\Delta\Delta C(t)$)** to activate the scaling options in the Gene Expression graph. Select one of these scaling options to calculate and present your data in a manner that best suits your experimental design:

- **Unscaled expression.** This option presents the unscaled normalized gene expression
• **Highest expression.** Scale the normalized gene expression to the highest for each target by dividing the expression level of each sample by the highest level of expression in all the samples. This scaling option uses the scaled to highest formula.

• **Lowest expression.** Recalculate the normalized gene expression for each target by dividing the expression level of each sample by the lowest level of expression in all the samples. This scaling option uses the scaled to lowest formula.

**ERROR TYPE**

Select an option for the type of error calculations (error bars) in the Gene Expression graph:

- Standard Error of the Mean (default, SEMs)
- Standard Deviation (Std Devs)

**CHART ERROR BAR MULTIPLIER**

Select a multiplier for the error bars in the Gene Expression graph. Select one of these integers: +/- 1 (default), 2, or 3. The type of multiplier changes when you select the Error Type:

- SEMs for Standard Error of the Mean
- Std Devs for Standard Deviations

**TARGET STABILITY VALUE**

Open this window whenever more than 1 reference gene is used. The software calculates two quality parameters for the reference genes:

- **Coefficient of Variation (CV)** of normalized reference gene relative quantities. Lower CV values denote higher stability.
- **M-value.** A measure of the reference gene expression stability.

**Right-Click Menu Options for Gene Expression Graph**

Right-click on the Gene Expression graph to select the items shown in Table 37.

**Table 37. Right-click menu items**

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copy the chart to a clipboard</td>
</tr>
<tr>
<td>Save as Image</td>
<td>Save the graph in the chart view as an image file. The default image type is PNG. The other selections for image file types include GIF, JPG, TIF, and BMP</td>
</tr>
<tr>
<td>Page Setup...</td>
<td>Select a page setup for printing</td>
</tr>
<tr>
<td>Print...</td>
<td>Print the chart view</td>
</tr>
<tr>
<td>Show Point Values</td>
<td>Display the relative quantity of each point on the graph when you place the cursor over that point</td>
</tr>
<tr>
<td>Set Scale to Default</td>
<td>Set the chart view back to the default settings after magnifying it</td>
</tr>
<tr>
<td>Chart Options...</td>
<td>Open the Chart Options window to adjust the graph</td>
</tr>
<tr>
<td>Sort</td>
<td>Sort the order that samples or targets appear on the chart X-axis</td>
</tr>
<tr>
<td>User Corrected Std Devs</td>
<td>Calculate the error bars using the corrected standard deviation formula</td>
</tr>
<tr>
<td>Use Solid Bar Colors</td>
<td>Display solid bars in the graph</td>
</tr>
</tbody>
</table>
Table 37. Right-click menu items (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-axis labels</td>
<td>Choose to display x-axis labels horizontal or angled</td>
</tr>
</tbody>
</table>

**Gene Expression Spreadsheet**

Table 38 describes the information shown in the Gene Expression spreadsheet.

**Table 38. Description of information in the spreadsheet on the Gene Expression tab**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Target Name (amplified gene) selected in the Experiment Settings window</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample Name selected in the Experiment Settings window</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Control sample, when the Sample Name is selected as a control in the Experiment Settings window</td>
</tr>
<tr>
<td>Expression</td>
<td>Normalized Gene Expression ($\Delta \Delta C(t)$) or Relative quantity ($\Delta C(t)$) depending on the selected mode</td>
</tr>
<tr>
<td>Expression SEM (or SD)</td>
<td>Standard Error of the Mean or Standard Deviation, depending on the selected option</td>
</tr>
<tr>
<td>Corrected Expression SEM (or SD)</td>
<td>Corrected value calculation for Standard Error of the Mean (SEM) or Standard Deviation (SD) of the relative expression, depending on the selected option</td>
</tr>
<tr>
<td>Mean (C(t))</td>
<td>Mean of the threshold cycle</td>
</tr>
<tr>
<td>C(t) SEM (or SD)</td>
<td>Standard Error of the Mean or Standard Deviation of the threshold cycle, depending on the selected option</td>
</tr>
</tbody>
</table>

**Show Details Option**

When you click the Show Details check box, Table 39 also shows this information.

**Table 39. Information in Gene Expression spreadsheet with Show Details selected**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Set</td>
<td>Fluorescence data from one fluorophore in the data file</td>
</tr>
<tr>
<td>Relative Quantity</td>
<td>Calculated relative quantity of samples</td>
</tr>
<tr>
<td>Relative Quantity SD</td>
<td>Standard deviation of the relative quantity calculation</td>
</tr>
<tr>
<td>Corrected Relative Quantity SD</td>
<td>Calculated standard deviation of the corrected relative quantity</td>
</tr>
<tr>
<td>Unscaled Expression</td>
<td>Calculated unscaled expression</td>
</tr>
<tr>
<td>Unscaled Expression SD</td>
<td>Calculated standard deviation unscaled expression</td>
</tr>
<tr>
<td>Corrected Unscaled Expression SD</td>
<td>Calculated standard deviation of the unscaled expression</td>
</tr>
<tr>
<td>Expression</td>
<td>Relative expression level</td>
</tr>
<tr>
<td>Wells</td>
<td>Well number in the plate</td>
</tr>
</tbody>
</table>
Experiment Settings Window

Open the Experiment Settings window by clicking the **Experiment Settings** button in the Gene Expression tab. In this window, view or change the list of Targets and Samples, select reference genes, select control samples or set the Gene Expression Analysis sample group to be analyzed if Collection Names have been added to the wells (Figure 101).

![Experiment Settings window with Targets tab selected.](image)

Figure 101. Experiment Settings window with Targets tab selected.

To adjust the lists in these tabs, use the following functions:

- Add a target or sample name by typing a name in the **New** box, and clicking **Add**
- Remove a target or sample name from the list by clicking the **Remove Name** box for that row, and then clicking the **Remove checked item(s)** button
- Select the target as a reference for gene expression data analysis by clicking the box in the **Reference** column next to the Name for that target
- Select the sample as a control sample for gene expression data analysis by clicking the box in the **Control** column next to the name for that sample

Sample Name Grouping Option

Loading **Collection Names** in the wells enables samples to be analyzed in one of four configurations defined by the Sample Name Grouping Option. These options are available from the pull-down menu in the Experiment Settings tab.

- **Target vs. Sample.** Only the well sample name is used in the gene expression calculations
- **Target vs. Collection.** Only the well collection name is used in the calculations
- **Target vs. Sample_Collection.** The sample name and collection name are combined to make a single name that is used in the calculations
- **Target vs. Collection_Sample.** The collection name and sample name are combined to make a single name that is used in the calculations

Show Analysis Settings in Experiment Settings

Click the **Show Analysis Settings** box in the Experiment Settings window to view or change analysis parameters applied in the Gene Expression tab:

- Click a cell in the **Color** column to change the color of the targets graphed in the Gene Expression chart
• Enter a number for the efficiency of a target. The software will calculate the relative efficiency for a target using **Auto Efficiency** if the data for a target includes a standard curve. Alternatively, type a previously determined efficiency.

Figure 102 shows the efficiency of all the targets, which appear if **Auto Efficiency** is selected.

[Image of targets tab in Experiment Settings window with Analysis Settings selected]

**Figure 102. Targets tab in Experiment Settings window with Analysis Settings selected.**

To adjust the settings for a sample in the Samples tab:

• Click a color in the **Color** column to change the color of the samples graphed in the Gene Expression chart

• Click a box in the **Show Graph** column to show the sample in the Gene Expression chart using a color that is selected in the Color column

Figure 103 shows the samples with the **Show Graph** option selected.

[Image of samples tab in Experiment Settings window with Analysis Settings selected]

**Figure 103. Samples tab in Experiment Settings window with Analysis Settings selected.**
Gene Study

Create a Gene Study to compare gene expression data from one or more real-time PCR experiments using an inter-run calibrator to normalize between the experiments. Create a Gene Study by adding data from one or more data files (.pcrd extension) to the Gene Study, the software groups them into a single file (.mgxd extension).

NOTE: The gene expression data must include a common sample in every data file to create a Gene Study. The software uses the common sample to normalize the data between experiments. Select the sample names in the Experiment Settings window (page 48).

NOTE: The maximum number of samples you can analyze in a Gene Study is limited by the size of the computer's RAM and virtual memory.

Gene Study Inter-Run Calibration

All data within the Gene Study are normalized by inter-run calibrator to calculate the smallest average ΔC(t) value. When the data files within the Gene Study include more than one inter-run calibrator, then the calibrator with the smallest average ΔC(t) value becomes the dominant inter-run calibrator. The dominant calibrator is used to adjust all C(t) values in the Gene Study.

To find the dominant inter-run calibrator, the software calculates the average of the ΔC(t) values for all inter-run calibrators of a given target (gene), and then uses a multitiered algorithm to determine the dominant inter-run calibrator within all the data. The algorithm for finding the dominant inter-run calibrator includes the following hierarchy:

1. Set the dominant calibrator to the target with the highest number of common replicate groups in a given pair-wise comparison.

2. If any target has the same number of common replicate groups, then set the dominant calibrator to the target with the smallest range of ΔC(t) values in pair-wise comparisons.

3. If any target has an identical range as the ΔC(t) values, then set the dominant calibrator to the target with the smallest absolute value of average ΔC(t) for eligible inter-run calibrator samples.

4. If any target has identical average ΔC(t) absolute values, then set the dominant calibrator to the replicate group with the smallest ΔC(t).

NOTE: The first data file imported into the Gene Study will always serve as the “hub” file for pairwise data comparison during inter-run calibration.

Gene Study Window

The Gene Study window includes two tabs:

• Study Setup tab. Click this tab to manage the experiments in the Gene Study. Adding or removing data files in a Gene Study does not change the original data in that file

• Study Analysis tab. Click this tab to view the gene expression data for the combined experiments
Figure 104 shows the Gene Study window, including the Study Setup and Study Analysis tabs.

![Gene Study window](image)

**Figure 104. Gene Study window.**

**Study Setup Tab**

Before importing data into a Gene Study, do the following in the Data Analysis window:

- Check that samples that contain the same content are named with the same name. In a Gene Study, the software assumes that wells with the same Target or Sample name contain the same samples.
- Adjust the baseline and threshold (C(t)) in the Quantitation tab to optimize the data in each experiment before you add them to a Gene Study.
- Select the well group you want to include in the Gene Study.

The Study Setup tab (Figure 104) shows a list of all the experiments in the Gene Study.

- **Add experiments.** Click the Add Data Files button to select a file from a browser window. To quickly add experiments to a Gene Study, drag the data files (.pcrd extension) to the Gene Study window.
  
  **TIP:** In order to show data from one well group in the Gene Study, that group must be selected before importing the Data file.

- **Remove experiments from this Gene Study.** Select one or more files in the list and click Remove.

- **Add notes about the Gene Study.** Type in the Notes box to add comments about the files and analysis in this Gene Study.
The Study Setup tab lists the data files in the Gene Study, as described in Table 40.

### Table 40. Study Setup tab in Gene Study window

<table>
<thead>
<tr>
<th>Column Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Name of the experiment data file (.pcrd extension)</td>
</tr>
<tr>
<td>File Folder</td>
<td>Directory that stores the data file for each experiment in the Gene Study</td>
</tr>
<tr>
<td>Date Created</td>
<td>Date the run data were collected</td>
</tr>
<tr>
<td>Well Group Name</td>
<td>Name of the well group that was selected when the file was added to the Gene Study</td>
</tr>
<tr>
<td></td>
<td>TIP: In order to analyze one well group in the Gene Study, that well group must be selected in the Data Analysis window before importing the data file into the Gene Study</td>
</tr>
<tr>
<td>Step</td>
<td>Protocol step that included the plate read to collect real-time PCR data</td>
</tr>
<tr>
<td>Grid View</td>
<td>Open a plate map of the plate with the data in each of the experiments included in the Gene Study</td>
</tr>
</tbody>
</table>

**Study Analysis Tab**

The Study Analysis tab shows the data from all experiments that are added to the Gene Study. Open this tab to analyze the data, and select these options for the Gene Expression chart:

- **Mode.** Select **Normalized Expression (ΔΔC(t))** or **Relative Quantity (ΔC(t))**
- **Graph Data.** Select **Relative to normal** or **Relative to control** in the graph
- **X-axis options.** Select the labels on the x-axis of the graph, including Sample or Target
- **Y-axis options.** Change the labels on the y-axis of the graph, including Linear, Log 2, or Log 10
- **Scaling Options.** Choose **Highest** value, **Lowest** value, or leave the data **Unscaled.** This option is only available when your samples do not contain controls
- **Graph Error.** Select the multiplier for standard deviation bars in the graph, including ±1, 2, or 3
- **Experiment Settings button.** Choose the show options for targets and samples in the Experiment Settings window
- **Show Details check box.** Click **Show Details** to add more columns of data to the chart
Highlighting a sample in the Gene Expression chart, highlights the corresponding cell in the spreadsheet below the chart (Figure 105).

Figure 105. Study Analysis tab in Gene Study window.

**Gene Study Data Spreadsheet**

The data spreadsheet in the Gene Study window lists information about each target and sample in the Gene Study (Figure 105).

Table 41 describes the information shown in the Gene Study spreadsheet.

**Table 41. Information in the spreadsheet on the Study Analysis tab**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Target Name (amplified gene) selected in the Experiment Settings window</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample Name selected in the Experiment Settings window</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Control sample, when the sample name is selected as a control in the Experiment Settings window</td>
</tr>
<tr>
<td>Expression</td>
<td>Normalized Gene Expression ($\Delta\Delta C(t)$) or Relative Quantity ($\Delta C(t)$) depending on the selected mode</td>
</tr>
<tr>
<td>Expression SEM (or SD)</td>
<td>Standard Error of the Mean or Standard Deviation, depending on the selected option</td>
</tr>
<tr>
<td>Corrected Expression SEM (or SD)</td>
<td>Corrected value calculation for Standard Error of the Mean (SEM) or Standard Deviation (SD) of the relative expression, depending on the selected option</td>
</tr>
<tr>
<td>Mean ($C(t)$)</td>
<td>Mean of the threshold cycle</td>
</tr>
<tr>
<td>$C(t)$ SEM (or SD)</td>
<td>Standard Error of the Mean or Standard Deviation of the threshold cycle, depending on the selected option</td>
</tr>
</tbody>
</table>
Show Details Data

Click the Show Details check box to show additional information (Figure 106).

![Figure 106. Show Details data in the Gene Study tab.](image)

The spreadsheet adds the information in the columns listed in Table 42.

Table 42. Information added to the spreadsheet when Show Details selected

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Set</td>
<td>Fluorescence data from one fluorophore in one data file</td>
</tr>
<tr>
<td>Relative Quantity</td>
<td>Calculated relative quantity of samples</td>
</tr>
<tr>
<td>Relative Quantity SD</td>
<td>Standard deviation of the relative quantity calculation</td>
</tr>
<tr>
<td>Corrected Relative Quantity SD</td>
<td>Calculated standard deviation of the corrected relative quantity</td>
</tr>
<tr>
<td>Unscaled Expression</td>
<td>Calculated unscaled expression</td>
</tr>
<tr>
<td>Unscaled Expression SD</td>
<td>Calculated standard deviation unscaled expression</td>
</tr>
<tr>
<td>Corrected Unscaled Expression SD</td>
<td>Corrected standard deviation of the unscaled expression</td>
</tr>
<tr>
<td>Expression</td>
<td>Relative expression</td>
</tr>
<tr>
<td>Wells</td>
<td>Well number in the plate</td>
</tr>
</tbody>
</table>

Gene Study Report Window

Open the Gene Study Report window to arrange the Gene Study data into a report. To create a gene study report, follow these steps:

1. Adjust the Gene Study report data and charts as needed before creating a report.
2. Select **Tools > Reports** to open the Gene Study report window.
3. Click the check boxes in the report options list to select and remove options to choose the data to display. Select the options shown in Table 43.

Table 43. Categories for a Gene Study report

<table>
<thead>
<tr>
<th>Category</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Report Information</td>
<td>Date, user name, data file name, data file path, and the selected well group</td>
</tr>
<tr>
<td></td>
<td>Gene Study File List</td>
<td>List of all the data files in the Gene Study</td>
</tr>
<tr>
<td></td>
<td>Notes</td>
<td>Notes about the data report</td>
</tr>
<tr>
<td>Analysis Parameters</td>
<td></td>
<td>A list of the selected analysis parameters</td>
</tr>
<tr>
<td>Chart</td>
<td></td>
<td>Gene Expression chart showing the data</td>
</tr>
<tr>
<td>Target Names</td>
<td></td>
<td>List of targets in the Gene Study</td>
</tr>
<tr>
<td>Sample Names</td>
<td></td>
<td>List of samples the Gene Study</td>
</tr>
<tr>
<td>Data</td>
<td></td>
<td>Spreadsheet that shows the data</td>
</tr>
</tbody>
</table>
4. Fill in the text for the report by entering text and images in option panes (Figure 107).

![Image of Header and Logo options in a Gene Study report](image.png)

**Figure 107. Example of Header and Logo options in a Gene Study report.**

5. Click the **Update Report** button to update the report preview pane. The report preview pane shows a view of the Report.

6. Print or save the report. Click the **Print** button in the toolbar to print the current report. Select **File > Save** to save the report as a PDF (Adobe Acrobat Reader file), MHT (Microsoft document), or MHTML (Microsoft document) formatted file and select a location to store the file. Select **File > Save As** to save the report with a new name or in a new location.

7. Create a report template once you create a report with the content you want to include in all reports. To create a template, select **Template > Save** or **Save As** and save the current report as a template.

### Frequently Asked Questions

The following list is a series of questions (Q) and answers (A) about gene expression analysis in CFX Manager software.

**Q:** Why should I normalize my data?

**A:** Relative quantity data that is not normalized by some means is difficult to interpret. Imagine the case where you load 1 μg of RNA in one well and 10 ng in the other well. If you perform a relative quantity analysis on the results from such an assay, then the fact that the 10 ng sample has a smaller relative quantity value is irrelevant. It is likely the result of using less RNA and not the result of some biological response.

**Q:** Why does the formula for relative quantity when a control is selected vary from that outlined in the geNorm web site?
A: This is where the CFX Manager software calculations differ from those outlined on the geNorm web site. In the example on that web site, the results are not scaled to the control until normalized expression is calculated. This is referred to as re-scaled normalized expression in the spreadsheet.

Q: How does normalized expression, as calculated by CFX Manager software, compare to the model introduced by M. Pfaffl (2001)?

A: If you only evaluate one reference gene and one gene of interest, you will get exactly the same results using the CFX Manager software as you would using the model introduced in M. Pfaffl (2001). However, standard deviations might be slightly different.

Q: How does normalized expression as calculated by this software compare to the model outlined by Dr. Jo Vandesompele on the geNorm web site?

A: The CFX Manager software uses the models outlined on the geNorm web site and will give you the same results.

Q: Why would I have to assign Target Names (genes) in the Gene Expression tab?

A: If you have not assigned Target Names in your initial plate setup or if you are studying more than five genes, click the View/Edit Plate button to open the Plate Editor and assign target names to the wells in the plate.

Q: Can I customize my target (gene) and sample (condition) names?

A: Yes. Open the Experiment Settings window (page 48) to add names to the Targets or Samples tabs, where you can also enter or remove the full names from the lists. Alternatively, permanently add long lists of names to the Libraries for target and sample names in the Plate tab in the User Preferences window (page 125). These names appear on the axis in various chart views, including gene expression.

Q: How do I determine efficiencies?

A: Typically the efficiency for each primer (or primer/probe) set is evaluated and recorded during assay development. Generate a standard curve using serial dilutions of a representative sample across a relevant dynamic range, and then record the efficiency for subsequent gene expression analysis.

Gene Expression Calculations

CFX Manager software calculates formulas automatically and displays the resulting information in the Data Analysis tabs.

Reaction Efficiency

Evidence suggests that using accurate measure of efficiencies for each primer and probe sets will give you more accurate results when analyzing gene expression data. The default value of efficiency used in the gene expression calculations is 100%. To evaluate the reaction efficiency, generate a standard curve using serial dilutions of a representative sample across a relevant dynamic range, and then record the efficiency for subsequent gene expression analysis. If your experiment includes a standard curve, then the software automatically calculates the efficiency and displays it under the Standard Curve on the Quantitation tab when Auto Efficiency is checked in the Targets tab in the Experiment Settings window.
The efficiency (E) in the efficiency formulas refers to the “efficiencies” as described by Pfaffl (2001) and Vandesompele et al. (2002). In these publications, an efficiency of 2 (perfect doubling with every cycle) is equivalent to 100% efficiency in this software. You have the option to convert your efficiency calculations to those used in the software by using the following mathematical relationships:

- \( E = (\% \text{ Efficiency} \times 0.01) + 1 \)
- \( \% \text{ Efficiency} = (E - 1) \times 100 \)

**Relative Quantity**

The relative quantity (\( \Delta C(t) \)) for any sample (GOI) is calculated with this formula:

\[
\text{Relative Quantity}_{\text{Sample (GOI)}} = E^{\left(C_{T(\text{MIN})} - C_{T(\text{sample})}\right)}
\]

Where:
- \( E = \) Efficiency of primer and probe set. This efficiency is calculated with the formula \((\% \text{ Efficiency} \times 0.01) + 1\), where 100% efficiency = 2
- \( C_{T(\text{MIN})} = \) Average C(t) for the Sample with the lowest average C(t) for GOI
- \( C_{T(\text{sample})} = \) Average C(t) for the Sample
- \( \text{GOI} = \) Gene of interest (one target)

**Relative Quantity When a Control Is Selected**

When a control sample (control) is assigned, then the relative quantity (RQ) for any sample (GOI) with a gene of interest is calculated with this formula:

\[
\text{Relative Quantity}_{\text{Sample (GOI)}} = E^{\left(C_{T(\text{control})} - C_{T(\text{sample})}\right)}
\]

Where:
- \( E = \) Efficiency of primer and probe set. This efficiency is calculated with the formula \((\% \text{ Efficiency} \times 0.01) + 1\), where 100% efficiency = 2
- \( C_{T(\text{control})} = \) Average C(t) for the control sample
- \( C_{T(\text{sample})} = \) Average C(t) for any samples with a GOI
- \( \text{GOI} = \) Gene of interest (one target)

**Standard Deviation of Relative Quantity**

The standard deviation of the relative quantity is calculated with the following formula:

\[
\text{SD Relative Quantity} = \text{SD C(t) GOI} \times \text{Relative Quantity}_{\text{Sample X}} \times \text{Ln (EGOI)}
\]

Where:
- \( \text{SD Relative Quantity} = \) standard deviation of the relative quantity
- \( \text{SD C(t) sample} = \) Standard deviation of the C(t) for the sample (GOI)
- \( \text{Relative Quantity} = \) Relative quantity of the sample
- \( E = \) Efficiency of primer and probe set. This efficiency is calculated with the formula \((\% \text{ Efficiency} \times 0.01) + 1\), where 100% efficiency = 2
- \( \text{GOI} = \) Gene of interest (one target)
Normalization Factor

The denominator of the normalized expression equation is referred to as the normalization factor. The normalization factor is the geometric mean of the relative quantities of all the reference targets (genes) for a given sample, as described in this formula:

\[
\text{Normalization Factor}_{\text{sample (GOI)}} = \frac{1}{\sqrt[n]{RQ_{\text{sample (Ref 1)}} \times RQ_{\text{sample (Ref 2)}} \times \ldots \times RQ_{\text{sample (Ref n)}}}}
\]

Where:
- \( RQ \) = Relative quantity
- \( n \) = Number of reference targets
- \( \text{GOI} \) = Gene of interest (one target)

Normalized Expression

Normalized expression (\( \Delta\Delta C(t) \)) is the relative quantity of your target (gene) normalized to the quantities of the reference targets (genes or sequences) in your biological system. To select reference targets, open the Experiment Settings window and click the reference column for each target that serves as a reference gene.

The calculation for normalized expression is described in the following formula, which uses the calculated Relative Quantity (RQ) calculation:

\[
\text{Normalized Expression}_{\text{sample (GOI)}} = \frac{RQ_{\text{sample (GOI)}}}{(RQ_{\text{sample (Ref 1)}} \times RQ_{\text{sample (Ref 2)}} \times \ldots \times RQ_{\text{sample (Ref n)}})^{\frac{1}{n}}}
\]

Where:
- \( RQ \) = Relative Quantity of a sample
- \( \text{Ref} \) = Reference target in an experiment that includes one or more reference targets in each sample
- \( \text{GOI} \) = Gene of interest (one target)

Provided that reference targets do not change their expression level in your biological system, the calculation of normalized expression will account for loading differences or variations in cell number that is represented in each of your samples.

Normalized Expression When a Control Is Selected

When you select a control sample in the Experiment Settings window, the software sets the expression level of the control sample to 1. In this situation, the software normalizes the relative quantities of all target (gene) expression to the control quantity (a value of 1). This normalized expression is equivalent to the unscaled normalized expression analysis when a control is chosen.
Standard Deviation for the Normalized Expression

Re-scaling the normalized expression value is accomplished by dividing the standard deviation of the normalized expression by the normalized expression value for the highest or lowest individual expression levels, depending on the Scaling Option you choose. The standard deviation (SD) of the normalization factor is calculated with this formula:

\[
SD_{NF_n} = \frac{NF_n \times \left( \frac{SD\ RQ_{\text{sample (Ref 1)}}}{n \times RQ_{\text{sample (Ref 1)}}} \right)^2 + \frac{SD\ RQ_{\text{sample (Ref 2)}}}{n \times RQ_{\text{sample (Ref 2)}}} + \cdots + \frac{SD\ RQ_{\text{sample (Ref n)}}}{n \times RQ_{\text{sample (Ref n)}}} }{\left( \frac{RQ_{\text{sample (Ref 1)}}}{n} \right)^2 + \left( \frac{RQ_{\text{sample (Ref 2)}}}{n} \right)^2 + \cdots + \left( \frac{RQ_{\text{sample (Ref n)}}}{n} \right)^2}
\]

Where:
- \( RQ = \) Relative quantity of a sample
- \( SD = \) Standard deviation
- \( NF = \) Normalization factor
- \( Ref = \) Reference target
- \( n = \) Number of reference targets

When a control sample is assigned, you do not need to perform this re-scaling function on the standard deviation, as shown in the following formula:

\[
SD_{NE_{\text{sample (GOI)}}} = \frac{NE_{\text{sample (GOI)}} \times \left( \frac{SD\ NF_{\text{sample (GOI)}}}{RQ_{\text{sample (GOI)}}} \right)^2 }{\left( \frac{RQ_{\text{sample (GOI)}}}{n} \right)^2}
\]

Where:
- \( NE = \) Normalized Expression
- \( RQ = \) Relative quantity of a sample
- \( SD = \) standard deviation
- \( GOI = \) Gene of interest (one target)

Normalized Expression Scaled to Highest Expression Level

When the experiment does not include controls, scale the normalized expression (NE) for each target (gene) by dividing the expression level of each sample by the highest level of expression in all the samples. The software sets the highest level of expression to a value of 1, and re-scales all the sample expression levels. The highest scaling is calculated by this formula:

\[
\text{Scaled Normalized Expression}_{\text{sample (GOI)}} = \frac{\text{Normalized Expression}_{\text{sample (GOI)}}}{\text{Normalized Expression}_{\text{Highest sample (GOI)}}}
\]

Where:
- \( GOI = \) Gene of interest (target).
Normalized Expression Scaled to Lowest Expression Level

When the experiment does not include controls, scale the normalized expression (NE) for each target (gene) by dividing the expression level of each sample by the lowest level of expression in all the samples. The software sets the lowest level of expression to a value of 1, and re-scales all the sample expression levels. The lowest scaling is calculated by this formula:

\[
\text{Scaled Normalized Expression}_{\text{sample (GOI)}} = \frac{\text{Normalized Expression}_{\text{sample (GOI)}}}{\text{Normalized Expression}_{\text{Lowest sample (GOI)}}}
\]

Where:
- GOI = Gene of interest (target).

Standard Deviation for the Scaled Normalized Expression

Re-scaling the scaled normalized expression (NE) value is accomplished by dividing the standard deviation (SD) of the normalized expression by the normalized expression value for the highest (MAX) or lowest (MIN) expression level, depending on which scaling option you choose.

**NOTE:** When a control sample is assigned, you do not need to perform this rescaling function on the standard deviation.

The formula for this calculation is shown here:

\[
\text{SD Scaled NE}_{\text{sample (GOI)}} = \frac{\text{SD NE}_{\text{sample (GOI)}}}{\text{NE}_{\text{MAX or MIN (GOI)}}}
\]

Where:
- NE = Normalized expression
- SD = Standard deviation
- GOI = Gene of interest (target)
- MAX = Highest expression level
- MIN = Lowest expression level

Corrected Values Formulas

A difference between corrected values and noncorrected values is only seen if a standard curve is created as part of the real-time PCR experiment. The software uses three equations in determining the error propagation:

- Standard Error
- Standard Error for Normalized Expression
- Standard Error for the Normalized Gene of Interest (target)

The formula for standard error is shown here:

\[
\text{Standard Error} = \frac{\text{SD}}{\sqrt{n}}
\]

Where
- n = Number of reference targets (genes)
- SD = Standard deviation
Gene Expression Analysis

The standard error for the normalization factor in the normalized expression formula is shown here:

\[
\text{SE}_{\text{NF}_n} = \frac{\text{NF}_n \times \sqrt{\sum \left( \frac{\text{SE RQ}_{\text{sample} \ (\text{Ref} \ 1)}^2}{n \times \text{SE RQ}_{\text{sample} \ (\text{Ref} \ 1)}} \right)^2 + \left( \frac{\text{SE RQ}_{\text{sample} \ (\text{Ref} \ 2)}^2}{n \times \text{SE RQ}_{\text{sample} \ (\text{Ref} \ 2)}} \right)^2 + \cdots + \left( \frac{\text{SE RQ}_{\text{sample} \ (\text{Ref} \ n)}^2}{n \times \text{SE RQ}_{\text{sample} \ (\text{Ref} \ n)}} \right)^2}}{\sqrt{n}}
\]

Where:
- \( n \) = Number of reference targets
- \( \text{SE} \) = Standard error
- \( \text{NF} \) = Normalized expression
- \( \text{RQ} \) = Relative quantity

The standard error for normalized gene of interest (GOI) formula is shown here:

\[
\text{SE}_{\text{GOI}_n} = \frac{\text{GOI}_n \times \sqrt{\left( \frac{\text{SE NF}_n}{\text{NF}_n} \right)^2 + \left( \frac{\text{SE GOI}}{\text{GOI}} \right)^2}}{\sqrt{n}}
\]

Where:
- \( \text{SE} \) = Standard error
- \( \text{GOI} \) = Gene of interest (one target)
- \( \text{NF} \) = Normalization factor
- \( n \) = Number of reference targets
10 Users and Preferences

Read this chapter to learn more about managing software users and their preferences:
- Log in or Select User (below)
- User Preferences window (page 122)
- Configuring email notification (page 123)
- User Administration (page 129)

Log in or Select User

CFX Manager software manages multiple users and their preferences. The current, logged in software user is displayed at the top of the main software window (Figure 108).

![Figure 108. User name displayed.](image)

CFX Manager software manages who logs in to the software through the Login dialog box (Figure 109). When you start the software, the Login dialog box opens automatically if there are two or more users listed in the User Administration window.

![Figure 109. Login dialog box.](image)

Log in to the software, or switch users by following these steps:
1. Open the Login dialog box, if it is not already open, by clicking the Select User button in the toolbar or selecting User > Select User in the menu bar.
2. Select a name from the User Name pull-down list. The default is “Admin” (administrator).
3. Type a password in the Password box.
4. Click OK to close the Login dialog box and open the software.
5. To add a new user name and password, contact your software administrator.

**Change a Password**

Change a password by following these steps:

1. Select **User > Change Password** from the main software window menu to open the Change Password dialog box (Figure 110).
2. Enter the old password in the Old Password box.
3. Enter the new password in the New Password and the Confirm New Password boxes.
4. Click **OK** to confirm the change.

![Figure 110. The Change Password window.](image)

**User Preferences Window**

CFX Manager software tracks the preferences of each user that logs in to the software. To change user preferences, open the User Preferences window using one of these methods:

- Click the **User Preferences** button in the main software window toolbar
- Select **User > User Preferences** in the main software window menu bar
- Click one of the tabs (Figure 111) to view or change preferences

![Figure 111. User Preferences window with tabs.](image)
Email Tab

Select the Email tab (Figure 111) to enter the email addresses where you want to receive confirmation of the completion of the run. The software can send an attached data file or report file with the email when the check boxes next to these options are checked.

Configure Email Notification

Click the Configure Outgoing Email button to open the Options window (Figure 112) to configure the SMTP server and send a test email from the computer. Input the following:

- **SMTP Server Name.** The name of the SMTP server as provided by your ISP
- **Port.** The port number of your SMTP server, as provided by your ISP; this is usually 25
- **Use SSL.** Whether to use Secure Sockets Layer. Some SMTP servers require this to be used, others require that it not be used
- **Use Default “From” Address.** This can usually be left in the default checked state. However, some SMTP servers require all sent email to have a “from” address that is from a certain domain, i.e. <name>@YourCompany.com. If that is the case, this checkbox must be unchecked, and a valid “from” email address must be supplied in the box labeled “From” Address:
- **Authentication Required.** Many SMTP servers require authentication. If so, this checkbox must be checked, and a User Name and Password must be supplied.
- **Test email.** To test the email settings, enter one or more email addresses in Test Email Address text box. Multiple email addresses can be separated by a comma. Then click the Test Email button

![Figure 112. Options to configure email.](image)

NOTE: Some SMTP servers do not allow attachments, and others allow attachments only up to certain sizes. If you will use CFX Manager software to email...
Data Files and/or Reports, you may want to test your server's ability to email attachments by checking the Test Attachment box, and setting the Attachment Size in MB with up to 5 megabytes (MB) or more.

**Files Tab**

Select the **Files** tab to list the default locations for opening and saving files.

- **Default Folder for File Creation.** Select a default folder where you want to save new files. Select a location for each file type (Protocol, Plate, Data, or Gene Study file)
- **File Selection for Experiment Setup.** Select the default protocol and plate files that appear when you open the Experiment Setup window
- **Data File Prefix.** Define the beginning text of the file name for data files. The default setting instructs the software to create a file name that starts with the User (user name of the user who is currently logged on to software), Date (file creation date), and Instrument Name (instrument serial number or name

![Figure 113. Files Preferences tab in the User Preferences window.](image)

TIP: Click the “...” button to the right of each box to open a browser window and locate a folder.

**Protocol Tab**

Select the **Protocol** tab in the User Preferences window to specify the default settings for a new protocol file in the Protocol Editor window:

- **Protocol Editor.** Set the default settings that appear in the Protocol Editor. Select a default Sample Volume to describe the volume of each sample in the wells (in μl), and select a Lid Shutoff Temperature at which the lid heater turns off during a run
• **AutoWriter.** Selects default settings that appear in the Protocol AutoWriter, including default Annealing Temperature for experiments that use iProof, iTaq, or Other polymerases and the default amplicon length

![User Preferences](image)

**Figure 114. Protocol Preferences tab in the User Preferences window.**

**Plate Tab**

Select the **Plate** tab in the User Preferences window (Figure 115) to specify the following default settings for a new Plate file in the Plate Editor window:

- **Plate Type.** Select the default plate well type from the list
- **Plate Size.** Select the default plate size from the list
- **Units.** Select the units used to describe the concentration of the starting template for wells that contain standards. The software uses these units to create a standard curve in the Data Analysis Quantitation tab
- **Scientific Notation.** Select scientific notation to view concentration units in that notation
- **Scan Mode.** Select a default scan mode to set the number of channels to scan during a run
- **Fluorophores.** Click check boxes to select the default fluorophores that appear in the Plate Editor well loading controls
- **Libraries.** Enter the target and sample names that you typically use in your experiments. Enter target names to list genes and sequences, and enter sample names to list conditions for experiment samples. These names appear in the lists of in the Targets tab and Samples tab in the Experiment Settings window
Data Analysis Tab

Select the Data Analysis Tab in the User Preferences window to change the default settings for data that appear in the Data Analysis window.

For the quantification data, select the following settings:
• **Analysis Mode.** Select the default base lining method for the analysis mode. Choose Baseline Subtracted Curve Fit, No Baseline Subtraction, or Baseline Subtracted

• **C(t) Determination Mode.** Select between Regression mode or Single Threshold mode to determine how C(t) values are calculated for each fluorescence trace

• **Log View.** Select On to show a semi-logarithmic graph of the amplification data. Select Off to show a linear graph

For the allelic discrimination data, select the following settings:

• **Display Mode.** Select RFU to show the data as a graph of the RFU, or select Threshold Cycle to show a graph of threshold cycles

• **Normalize Data.** This selection is only available when RFU is selected. Select No to show unnormalized data. Select Yes to normalize the data to the control sample

For the end point data, select the following settings. Select the number of end cycles to average when calculating the end point calculations:

• **PCR.** Enter a number of cycles for PCR to average the end cycles for quantitation data (default is 5)

• **End Point Only Run.** Enter a number of cycles for End Point Only Run to average the end cycles for end point data (default is 2)

### Gene Expression Tab

Select the **Gene Expression** tab in the User Preferences window to specify the default settings for a new Gene Expression data file.

![Gene Expression Tab](image)

**Figure 117. Gene Expression tab in the User Preferences window.**

Specify the default settings for a new Gene Expression data file:

• **Relative to.** Select a control or zero. To graph the gene expression data originating at 1 (relative to a control), select Control. When you assign a control sample in the Experiment Setup window, the software automatically defaults to calculate the data relative to that control. Select Relative to zero to instruct the software to ignore the
control, which is the default selection when no control sample is assigned in the Experiment Settings window

- **X-Axis.** Graph the Target or the Sample on the x-axis
- **Y-Axis.** Graph Linear, Log 2, or Log 10 scale on the y-axis
- **Scaling.** Select a scaling option for the graph. Leave the graph unscaled. Alternatively, choose a scaling option to scale to the Highest value or to the Lowest value
- **Method.** Set the default analysis mode, including normalized expression ($\Delta\Delta Ct$) or relative expression ($\Delta Ct$)
- **Error Bar.** Select Std Dev. for standard deviation, or Std. Error Mean for the standard error of the mean
- **Std Devs.** Select the standard deviation multiplier to graph the error bars. The default is 1. Change the multiplier to either 2 or 3

**QC Tab**

Select the QC tab in the User Preferences window to specify QC rules to apply to data in Data Analysis Module. The software validates the data against the enabled tests and the assigned values (page 128).

NOTE: Wells that fail a QC parameter can easily be excluded from analysis in the QC module of the Data Analysis Window using the right-click menu option.

![Figure 118. QC tab in User Preferences.](image)

Specify to add cut off values and to enable the following QC rules:

- Negative control with a C(t) less than XX. Input a C(t) cut-off value
- NTC (no template control) with a C(t) less than XX. Input a C(t) cut-off value
- NRT (no reverse transcriptase control) with a C(t) less than XX. Input a C(t) cut-off value
- Positive control with a C(t) greater than XX. Input a C(t) cut-off value
- Unknown without a C(t)
- Standard without a C(t)
• Efficiency greater than XX. Input a reaction efficiency cut-off value that is calculated for the standard curve
• Efficiency less than XX. Input a reaction efficiency cut-off value that is calculated for the standard curve
• Std Curve R^2 less than XX. Input a cut-off R^2 value for the standard curve
• Replicate group C(t) Std Dev greater than XX. Input a cut-off standard deviation that is calculated for each replicate group

User Administration

Open the User Administration window in the main software window:
• Select Users > User Administration
• Click the User Administration button in the menu bar

If you log in as an Administrator, open the User Administration window to manage users and user rights:
• Manage Users. Add or remove Users, and assign each user a Role
• Manage Rights. Change rights for user roles (Principal, Operator, or Guest)

NOTE: Only users who are Administrators can edit this window. Other users can only view it.

To assign a role to each user, select from the list of roles in the User Administration window (Figure 119). In this example, the Guest user is given the added right to save files.

Figure 119. User Administration window with three users.

Adding and Removing Software Users

Only a software Administrator can add and remove users. To add software users in the Manage Users pane, follow these steps:
1. Enter a User Name for the new software user.
2. Select a user Role. These roles restrict the rights of each user. The default is Principal.
3. (Optional) Enter a Full Name and Password for the new software user.
4. Click **OK** to open a dialog box and confirm that you want to close the window.

5. Click **Yes** to close the dialog box and window.

To remove a software user, follow these steps:

1. In the Manage Users pane, click the box in the Delete list for each software user you want to remove.

2. Click **OK** to open a dialog box and confirm that you want to close the window.

3. Click **Yes** to close the dialog box and window.

   **NOTE:** The list of software users must always include one Administrator.

### Assign Rights for User Roles

The User Administration window provides access to user roles and rights. The software includes these four roles:

- **Administrator (required).** Each Administrator has all rights, and you cannot change those rights. The Administrator can also add and remove software users, and change the rights for each role

- **Principal.** By default each Principal has all rights

- **Operator.** By default each Operator has all rights except skipping cycles and creating a Gene Study

- **Guest.** By default each Guest has no additional rights, and can only read files

To specify the rights for each role, follow these steps. Only a software Administrator can change the rights for any role:

1. In the Manage Rights pane, click a box under the name of the role to add or remove that right. Click one or more rights in the list. To change all the rights for all the roles to the default list, click **Restore Default Rights**.

2. Click **OK** to open a dialog box and confirm that you want to close the window.

3. Click **Yes** to close the dialog box and window.

To view your current user role and rights, select **User > User Administration.** Contact a software administrator to modify the user settings, rights, and roles listed in the User Administration window. A Principal, Operator, or Guest user can only view their user settings, rights, and roles.
11 Resources

Read this chapter to learn more about resources for the CFX96 system or the CFX384 system:

- Calibration Wizard (below)
- Instrument maintenance (page 133)
- Application Log (page 135)
- Software Help tools (page 135)
- Troubleshooting (page 136)
- References (page 139)

Calibration Wizard

The CFX96 system is factory calibrated for commonly used fluorophores in white-welled and clear-welled plates. The CFX384 system is factory calibrated for the same fluorophores in white-welled plates only (Table 44).

Table 44. Factory calibrated fluorophores, channels, and instruments

<table>
<thead>
<tr>
<th>Fluorophores</th>
<th>Channel</th>
<th>Instrument</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAM, SYBR® Green I</td>
<td>1</td>
<td>CFX96 and CFX384</td>
</tr>
<tr>
<td>VIC, HEX, TET, CAL Gold 540</td>
<td>2</td>
<td>CFX96 and CFX384</td>
</tr>
<tr>
<td>ROX, TEXAS RED, CAL Red 610</td>
<td>3</td>
<td>CFX96 and CFX384</td>
</tr>
<tr>
<td>CY5, Quasar 670</td>
<td>4</td>
<td>CFX96 and CFX384</td>
</tr>
<tr>
<td>Quasar 705</td>
<td>5</td>
<td>CFX96 only</td>
</tr>
</tbody>
</table>

The CFX96 system or the CFX384 system also include a channel dedicated for FRET chemistry; this channel does not require calibration for specific dyes.

To open the Calibration Wizard to calibrate the CFX96 or CFX384 real-time PCR system:

1. Select an instrument in the Detected Instruments pane.

2. Select Tool > Calibration Wizard to open the window and calibrate new dye and plate combinations (Figure 120).
Calibrating the CFX96 or CFX384 System

To calibrate the CFX96 system or CFX384 system in the Dye Calibration window:

1. In the Calibrate New or Existing Fluorophores pane, select the fluorophore you want to calibrate from the pull-down list. If the fluorophore name is not included in the list, type the name in the box to add it to the list.

2. Select the Plate Type. If the plate type is not included in the list, type the name in the box to add it to the list.

3. Select a Channel for the fluorophore.

4. Click the Add to List button to add the fluorophore. To clear the plate, click Clear List to remove all the fluorophores.

5. (Optional) Repeat steps 1-6 to add each fluorophore you plan to calibrate for the plate.

6. When you finish adding fluorophores, click View Plate to open the Dye Plate Display. Use this window as a guide for loading dyes into the plate.

7. Begin preparing a 96- or 384-well plate for dye calibration by pipetting dye solution into each well, following the pattern shown in the Pure Dye Plate Display. For each fluorophore, fill 4 wells with 50 μl (96-well plate) or 30 μl (384-well plate) of 300 nM dye solution. Notice that at least half the plate contains blank wells.

8. Seal the plate using the sealing method you will use in your experiment.

9. Place the calibration plate in the block and close the lid. Then click Calibrate, and click OK to confirm that the plate is in the block.

10. When the CFX Manager software completes the calibration run, a dialog box appears. Click Yes to finish calibration and open the Dye Calibration Viewer.

11. Click OK to close the window.
Instrument Maintenance

Your CFX96 system or CFX384 system includes a sensitive optical shuttle system that moves quickly during data collection and a sample block that must heat and cool very fast. Contamination of these components can interfere with thermal cycling and data collection.

**WARNING!** Never allow a reaction to run with an open or leaking sample lid. The reagents could escape and coat the block, inner lid, and optical head in the shuttle system. Excessive dirt can dim the signal, and fluorescence contamination can create excessive background signal. The shuttle system cannot be cleaned, except by trained Bio-Rad service engineers.

Avoid contaminating the CFX96 or CFX384 system by following these suggestions:

- Always clean the outside of any containers before placing them in the block
- Never run a reaction with a seal that is open, loose, punctured, or otherwise damaged because you could contaminate the block, inner lid, and optical system
- Never run a PCR or real-time PCR reaction with volatile reagents that could explode and contaminate the block, inner lid, and optical system
- Clean the block and inner lid periodically to prevent the buildup of dirt, biohazardous material, or fluorescent solutions (page 133)
- Never clean or otherwise touch the optical system behind the heater plate holes that are in the inner lid (Figure 121 on page 134)
- Clean the outer lid and C1000 base on a regular schedule (for details see C1000 thermal cycler instruction manual)

Cleaning the Optical Reaction Module

The block of the optical reaction module should be cleaned, along with the C1000 thermal cycler base, on a regular schedule to remove any debris or dirt that might interfere with proper function. Clean as soon as you discover debris and spilled liquids with a soft, lint-free cloth that is dampened with water. Cleaning the instrument allows precise instrument function. For more detailed information about cleaning the C1000 base, see the C1000 thermal cycler instruction manual.

**WARNING!** Never use cleaning solutions that are corrosive to aluminum. Avoid scratching the surface of the C1000 reaction module bay. Scratches and damage to this surface interfere with precise thermal control.

**WARNING!** Never pour water or other solutions in the C1000 reaction module bay. Wet components can cause electrical shock when the thermal cycler is plugged in.

Clean the CFX96 or CFX384 optical reaction module as soon as you discover debris, dirt, or contamination in the block or on the inner lid. Any dirt can interfere with the ability of the block to change temperature quickly and collect accurate fluorescent data. To clean the reaction module, follow these guidelines. Follow these suggestions for cleaning:

**WARNING!** To prevent electrical shock, always remove the reaction module from the thermal cycler base, or unplug the base before cleaning the instrument.
WARNING! Never touch or allow solutions to touch the optical system that is located behind the heated plate holes in the inner lid (Figure 121).

Never touch anything beyond these holes

Figure 121. Heating plate holes in the inner lid.

TIP: For instructions on handling and cleaning radioactive or biohazardous materials, consult the guidelines for radiation safety and biosafety provided by your institution. These guidelines include cleaning, monitoring, and disposal methods for hazardous materials.

- **Clean the outer surface.** Use a damp cloth or tissue to clean spills off the outside case. If needed, use a mild soap solution, and then rinse the surface with a damp cloth. Cleaning the cover will prevent corrosion.

- **Clean the cooling fins.** Remove dust with a soft brush or damp cloth. Remove any heavy dust that is deep in the vents with a vacuum cleaner. Use water and a soft, lint-free cloth to remove debris that is stuck to the fins. Avoid scratching the surface. If needed, use a mild soap solution and rinse well to remove residue completely. Cleaning the fins improves precise sample heating and cooling.

  NOTE: Never use cleaning solutions that are corrosive to aluminum, such as bleach or abrasive cleansers.

- **Use of oil in the wells is not recommended.** If oil is used, the wells must be cleaned thoroughly and often. Remove the oil when it is discolored or contains dirt. Use a solution of 95% ethanol to clean oil. Do not allow oil to build up in the block.

- **Clean the wells in the block.** Clean spills immediately to prevent them from drying. Use disposable plastic pipets with water (recommended), 95% ethanol, or a 1:100 dilution of bleach in water. Also use a soft, lint-free cloth or paper towel and water to clean the block. Always rinse the wells with water several times to remove all traces of cleaning reagents.

  WARNING! Never clean the block with strong alkaline solutions (strong soap, ammonia, or high-concentration bleach). Never use corrosive or abrasive cleaning solutions. These cleaning agents can damage the block and prevent precise thermal control.

  WARNING! Bleach, ethanol, or soap that is left in the blocks could corrode the block and destroy plastics during a run. After cleaning, always rinse the wells thoroughly with water to remove all traces of cleaning reagents.
WARNING! Never heat the block after adding a cleaning solution. Heating the block with cleaning solution will damage the block, reaction module, and thermal cycler base.

- **Clean the inner lid.** Use a soft, lint-free cloth and water to remove debris and solutions from the inner lid surface. Never use abrasive detergents or rough material that will scratch the surface. Cleaning the inner lid improves precise sample heating and cooling.

**Application Log**

Before starting a new run, an instrument initiates a self-diagnostic test to verify that it is running within specifications. The software records results of this test in the Run log and Application log file. If you notice a problem in one or more experiments, open the run and application logs to find out when the problem started happening.

CFX Manager software tracks information about the state of an instrument during a run in the **Application Log** (Figure 122). Use these logs to track events that occur on instruments and in the software and for troubleshooting.

To open the Application log in the main software window, select **View > Application Log**.

**Figure 122. Example of an Event Log file.**

**Software Help Tools**

This CFX Manager software provides Help with the following tools:

- Select the **Search** or **Index** tabs in this Help site to search for more information
- Open the **Glossary** to look up words that are specifically used in this software. For widely used words, consult a PCR dictionary or glossary
- Press the **F1** key on your keyboard to open software help about topics in many of the software windows
- Print any Help page by right-clicking on it and selecting **Print**
- Click the [www.bio-rad.com](http://www.bio-rad.com) link at the bottom of each Help page to open the Bio-Rad website for links to information and resources
Troubleshooting

Typically, software and instrument communication problems can be resolved by restarting your computer and the system. Be sure to save any work in progress before restarting.

NOTE: Check that your computer has sufficient RAM and free hard drive space. The minimum RAM is 2 GB, and the minimum hard drive space is 20 GB.

Installing the Software Manually

If needed, install the software manually by following these instructions:

1. Insert the software CD.

2. Right-click the software CD icon, and select Explore to open the CD window.

3. Double-click the CFX_Manager folder to open the folder, and then double-click setup.exe to start the software installation wizard.

4. Follow the instructions on the wizard to install the software, and then click Finish.

Installing the Drivers Manually

If needed, install the drivers manually by following these instructions:

1. Insert the software CD. If the CD is not available, then locate the drivers folder in the file path C:\Program Files\Bio-Rad\Drivers on your hard drive.

2. Click the Drivers button software installation screen (Figure 124).

3. Click the BaseUnit folder to open it.

4. For computers with Windows XP, double-click BioRadC1000DriverInstall.exe to launch the installation window. For computers with Windows Vista, right-click BioRadC1000DriverInstall.exe and select Run as Admin to launch the installation window.

When installation is complete, the installation window closes.

NOTE: If the drivers do not install with manual installation, please contact the technical support team in your local Bio-Rad office (page 1).
Power Failure Options

In a power failure, the instrument and computer will shut down. If the power failure is short, then the instrument will resume running a protocol, but the Application log will note the power failure. Depending on the computer settings and the length of time that the power is off, the instrument and software attempt to continue running depending on the protocol step:

- If the protocol is in a step with no plate read, then the protocol continues running as soon as the instrument gets power again
- If the protocol is in a step with a plate read, then the instrument waits for the software to restart and resume communication to collect the data. In this situation, the protocol only continues if the software is not shut down by the computer. When the computer and software start up again, then the protocol continues

If you want to open a locked motorized lid on a reaction module to remove your samples during a power failure, follow these steps to remove the locking plate:

1. Remove the reaction module from the C1000 chassis by pushing down on the locking bar of the C1000.

2. Position the module on the front of a desk, so that the front of the module extends 2 inches over the edge of the desk as shown in Figure 125.

3. With an allen wrench, remove the two large screws from under the front edge of the reaction module (below the button for opening the lid). Do not remove the two small screws that are located at the front edge of the module. You should hear the locking latch release from inside the module. Figure 126 shows the two large screws.
4. Push the reaction module lid open. Notice that the latch (dark plastic) is no longer attached. Remove your samples from the block.

5. Reassemble the reaction module with the lid open by replacing the locking latch and securing it with the large screws. Figure 127 shows the locking latch in place.

![Figure 127. Optical module locking latch.](image)

**Instruments, Parts, and Accessories**

Bio-Rad offers the 1000-series instruments, software, and accessories listed in Table 45.

<table>
<thead>
<tr>
<th>Catalog Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Instruments and Reaction Modules</strong></td>
<td></td>
</tr>
<tr>
<td>185-5096</td>
<td>CFX96 Real-Time PCR Detection System</td>
</tr>
<tr>
<td>185-5034</td>
<td>CFX384 Real-Time PCR Detection System</td>
</tr>
<tr>
<td>185-1096R</td>
<td>C1000 Thermal Cycler With 96-Well Fast Reaction Module</td>
</tr>
<tr>
<td>185-1048R</td>
<td>C1000 Thermal Cycler With Dual 48/48 Fast Reaction Module</td>
</tr>
<tr>
<td>185-1384R</td>
<td>C1000 Thermal Cycler With 384-Well Reaction Module</td>
</tr>
<tr>
<td>185-2096R</td>
<td>S1000 Thermal Cycler With 96-Well Fast Reaction Module</td>
</tr>
<tr>
<td>185-2048R</td>
<td>S1000 Thermal Cycler With Dual 48/48 Fast Reaction Module</td>
</tr>
<tr>
<td>185-2384R</td>
<td>S1000 Thermal Cycler With 384-Well Reaction Module</td>
</tr>
<tr>
<td><strong>Software and Accessories</strong></td>
<td></td>
</tr>
<tr>
<td>184-5000</td>
<td>CFX Manager Software</td>
</tr>
<tr>
<td>184-5001</td>
<td>CFX Manager Software, Security Edition, 1 user license</td>
</tr>
<tr>
<td>184-5005</td>
<td>CFX Manager Software, Security Edition, 5 user licenses</td>
</tr>
<tr>
<td>184-5010</td>
<td>CFX Manager Software, Security Edition, 10 user licenses</td>
</tr>
<tr>
<td>184-8000</td>
<td>USB Cable*</td>
</tr>
<tr>
<td><strong>Reagents for Reverse Transcription</strong></td>
<td></td>
</tr>
<tr>
<td>170-8890</td>
<td>iScript™ cDNA Synthesis Kit, 25 reactions</td>
</tr>
<tr>
<td>170-8896</td>
<td>iScript™ Select cDNA Synthesis Kit, 25 reactions</td>
</tr>
<tr>
<td>170-8892</td>
<td>iScript™ One-Step RT-PCR Kit With SYBR® Green, 50 reactions</td>
</tr>
<tr>
<td>170-8894</td>
<td>iScript™ One-Step RT-PCR Kit for Probes, 50 reactions</td>
</tr>
<tr>
<td><strong>Real-Time PCR Supermixes</strong></td>
<td></td>
</tr>
<tr>
<td>172-5848</td>
<td>iQ™ Multiplex Powermix, 50 reactions</td>
</tr>
</tbody>
</table>
To prevent data loss, use a sufficiently shielded USB cable (catalog #184-8000) when connecting instruments to the computer or to another instrument.

### References


### Minpack Copyright Notice (1999) University of Chicago. All rights reserved

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment:

   "This product includes software developed by the University of Chicago, as Operator of Argonne National Laboratory."
Resources
# Index

## A

Add Repeats, 27  
Adding  
  Beep, 37  
  Extend, 37  
  Increment, 37  
  Ramp rate, 37  
  Repeats in run, 27  
Adjusting  
  Allelic Discrimination data, 94  
  Data analysis charts, 78  
  End point data, 93  
  Gene expression data, 104  
  Melt Curve Data, 88  
  Threshold, 74  
  Trace color, 82  
  Trace style, 82  
All Channels scan mode, 45, 60  
Allelic Discrimination, 93  
  Adjusting data, 94  
  RFU, 93, 96  
  Spreadsheet, 95  
Amplicon length, 38, 39  
Analysis Mode, 75  
Annealing temperature  
  Protocol AutoWriter, 38, 39  
Auto Efficiency, 50, 108  
  Tube strips, 10  
  Baseline  
    Window, 74  
  Baseline Subtracted  
    Curve Fit mode, 75  
    Baseline Subtracted mode, 75  
    Baseline Threshold window, 74  
  Beep, 37  
  Bio-Rad Laboratories  
    Contact, ii  
    Resources, ii  
    Web site, ii  
  Block, 3  
    Mode, 37  
Button, 27  
  Clear Replicate #, 48  
  Clear Wells, 48  
  Close lid, 3, 26  
  Delete step, 37  
  Experiment Settings, 48  
  Flash Block Indicator, 27  
  Open lid, 26  
  Pause, 27  
  Protocol AutoWriter, 37  
  Protocol Editor, 33  
  Resume, 27  
  Show Analysis Settings, 50, 107  
  Skip Step, 27

## B

Back panel, 3  
Balance  
  Cut microplates, 10  
  How to, 10

## C

C1000 Control Panel, 53  
Cable, catalog number, 138  
Calculated mode, 37  
Calibration
Index

Inter-run in a Gene Study, 109
Cancelling a run, 27
Catalog numbers
  Instruments, 138
  PCR supermixes, 138
  Reaction modules, 138
  Reverse transcriptase, 138
  Software, 138
  USB cable, 138
CFX Manager
  Files, 20
CFX96 system, 2
  Overview, 2
Changing
  Baseline, 74
  Sample volume, 23, 33
  Thresholds, 74
Chart
  Data analysis, 78
Clear Replicate #, 48
Clear Wells button, 48
Closing wells in Plate Editor, 78
Close button for lid, 3
Close Lid button, 26
Closing the lid, 26
Coefficient of Variation, 105
Collection Name, 48, 107
Color, 45, 50, 108
Components in shipment, 1
Concentration, 46, 47
Contact Bio-Rad Laboratories, ii
Control
  Relative quantity with, 116
Creating
  Data report, 98
  Protocol, 39
  Well groups, 50

D
-d(RFU)/dT
  Spreadsheet, 91
Data
  Files, 20
Data analysis
  About, 69
  Adjusting, 69
  Charts, adjusting, 78
  Clearing wells, 78
  Data analysis, 93
  End Point, 91
  Excluding wells, 76
  Formula, 115
  Gene Expression, 101
  Melt Curve, 87
  Menu bar, 71
  Plate content, 69
  Toolbar, 70
  Well contents, 69
  Well groups, 50
  Well selector, 75
Data file
  Report, 97
Data report
  Creating, 98
  Delete Step button, 37
  Deleting a step, 37
  Detected Instruments, 12
  Dilution Series, 48

E
Email function on the C1000, 62
Email Setup in CFX Manager, 123
Email setup on the C1000, 65
Email Tab, 123
End Point
  Adjusting data, 93
  Changing sample volume in protocol, 23
  RFU data analysis, 91
  Spreadsheet, 93
  Tab, 92
End Point Only Run protocol, 22
Enzyme type, 38, 39
Exclude well using right click option, 76
Excluding wells
  Plate Editor, 76
Experiment Settings, 48
  Auto Efficiency, 50, 108
  Button, 48
  Color, 50, 108
  Show Analysis Settings button, 50, 107
  Show Graph, 50, 108
  Targets tab, 49, 107
Export All Data Sheets to Excel, 71
Export Template, 52
Exporting Stand-Alone Data, 61
Express Load
  Protocol, 22, 23
  Extend, 37

F
Files
  Data, 20
Gene Study, 20
Plate, 20
Protocol, 20
Software, 20
Flash Block Indicator button, 27
Fluorophores, 46
Formula, 116
Data analysis, 115
E (see reaction efficiency), 84
Normalized expression, 117, 119
Normalized expression, scaled, 118
Reaction Efficiency (E), 84
Relative quantity, 116
SD normalized expression, 119
Standard error, 119
Standard error normalized expression, 119
FRET, 45, 60
Front view, 2

G
Gene expression
Adjusting data, 104
Data analysis, 101
Graph data, 104
Normalizing data, 103
Relative quantity, 104
Right-click for graph, 105
Scaling options, 104
Spreadsheet, 106
Tab, 102
Gene Expression Gateway, ii
Gene Study, 109
Files, 20
Inter-run calibration, 109
Preparing data, 110
Report, 113
Show Details, 113
Study Analysis tab, 109, 111
Study Setup tab, 110
Glossary
Software, 135
GOI
Normalization factor, 117
Normalized expression, 117, 118, 119
Relative quantity, 116
SD Normalized expression, 119
GOTO
Adding repeats, 27
Inserting, 35
Gradient
Inserting, 34
Step, 34
Gradient Calculator, 32
Guides
Quick Guides, 11
Software Help, 11

H
Heated plate, 3
Help tools, 135
Software, 135

I
Import Template, 52
Increment, 37
Inner lid, 2
Instruments
Safety, iii
Warning labels, iii
Inter-run calibration, 109

L
Layout
Quantitation tab, 72, 82
LED on lid, 2
Library, 46
Lid
Green LED, 2
Opening, 26
Life Science Research web site, ii

M
Magnification in Plate Editor, 44
Main software window, 11
Melt Curve
Adjusting data, 88
Data analysis, 87
Inserting, 35
Opening tab, 87
RFU data, 87
Spreadsheet, 88
Melt Curve Data, 90
Amplification Data (RFU), 90
Plate, 90
Tab, 89
Melt Peaks
Spreadsheet, 89
Index

Menu bar
  Data analysis, 71
  Main software, 11, 12
  Plate Editor, 43
  Protocol Editor, 32
Mode
  Analysis, 75
  Baseline Subtracted, 75
  Baseline Subtracted Curve Fit, 75
  Not Baseline Subtracted, 75
  Temperature control, 37
Multiple instruments
  Viewing, 18
  M-value, 105

N
  Normalization factor
    Relative quantity, 117
  Normalized expression
    Formula, 117
    Formula for GOI, 119
    Scaled to highest, 118
    Scaled to lowest, 119
    Standard deviation (SD), 119
    Standard deviation formula, 118
  Normalized GOI formula, 119
  Normalizing
    Gene expression, 103
  Not Baseline Subtracted mode, 75
Notes
  Well, 46

O
  Open Lid button, 26
  Opening
    Lid, 26
    Melt Curve tab, 87
    Protocol AutoWriter, 37
    Protocol Editor, 31
  Operation requirements, 1
  Overview of CFX96 system, 2

P
  Pause
    Button, 27
    Run, 27
  PCR
  Supermixes, 138
  Plastic Consumables, 9
Plate
  Contents of wells, 46
  Files, 20
  Melt Curve Data, 90
  Size, in Plate Editor, 43
  Spreadsheet, 51, 90
  Spreadsheet in Plate Editor, 42
  Type, 43
  Well contents, 46
Plate Editor
  Clear Replicate #, 48
  Clear Wells button, 48
  Clearing wells, 78
  Concentration, 47
  Dilution Series, 48
  Excluding wells, 76
  Experiment Settings, 48
  Export plate spreadsheet, 52
  Import plate spreadsheet, 52
  Layout, 42
  Magnification, 44
  Menu bar, 43
  Plate size, 43
  Plate Type, 43
  Replicate #, 47
  Replicate Group, 47
  Replicate series, 47
  Sample Name, 47
  Sample Type, 46
  Scan Mode, 44, 45
  Scientific notation, 43
  Selecting fluorophores, 45
  Spreadsheet, 43, 51
  Target Name, 47
  Toolbar, 42, 43
  Units, 43
  Well Groups Manager, 44
  Well Notes, 48
Plate Editor window, 42
Plate Loading Guide, 42
Power
  Input, 3
  Switch, 3
Protocol
  Block mode, 37
  Calculated mode, 37
  End point, 22
  Express load, 22, 23
  Files, 20
  Steps, temperature, 31
Protocol AutoWriter, 39
  Amplicon length, 38, 39
Annealing temperature, 38, 39
Button, 37
Creating a protocol, 39
Examples of protocol, 39
Run time, 38
Protocol Editor
Buttons, 32, 33
Delete step, 37
Inserting GOTO, 35
Inserting gradient, 34
Inserting melt curve, 35
Menu bar, 32
Toolbar, 32
Window, 31
Resume button, 27
Resuming a run, 27
Reverse transcription
Reagents, 138
RFU
Allelic Discrimination, 93, 96
End Point tab, 91, 92
Melt Curve tab, 87
Right-click
Gene expression graph, 105
Selected Block(s) list, 25
RT_Data Folder, 61
Run
Adding repeats, 27
Cancelling, 27
Flash block, 27
Pausing, 27
Skipping a step, 27
Stopping, 27
Run Details
Real-Time Status tab, 27
Run Status, 26
Time Status tab, 28
Window, 25
Run Information
Tab, 96
Run Status
Tab, 26
Run time, 38
Safe use specifications, iv
Safety
Instruments, iii
Warning labels, iii
Warnings, ii, iii
Sample
Name, 46, 47
Type, 46
Sample Name Grouping, 50, 107
Sample Volume
Changing in end point, 23
Sample volume
Changing, 33
Scaling option in gene expression, 104
Scan Mode
All Channels, 45, 60
FRET, 45, 60
Plate Editor, 44, 45
SYBR/FAM only, 45, 60
Scientific notation, 43
Select Fluorophores
Color, 45
Selected check box, 45
Selecting
Analysis mode, 75
Fluorophores in plate, 45
Shipping
List, 1
Screw, 5
Show Analysis Settings, 50, 107
Show Details
Gene Study, 113
Show Graph, 50, 108
Single Threshold Mode, 73
Skip Step button, 27
Skipping a step, 27
Software
Glossary, 135
Main window, 11
Tips and tricks, 20
Specifications
Regulatory compliance, iv
Safe use, iv
Spreadsheet
Allelic Discrimination, 95
Amplification Data for Melt Curve, 90
-d(RFU)/dT for Melt Curve, 91
End Point, 93
Gene expression, 106
Melt Curve, 88
Melt Peaks, 89
Plate Editor, 42, 43
Plate in Melt Curve Data, 90
RFU for Melt Curve, 90
Stand-alone mode, 53
Standard Curve
Well groups, 50
Standard deviation
Formula for normalized expression, 119
Normalized expression, 118, 119
Relative quantity, 116
Standard error, 119
Formula, 119
Normalized expression formula, 119
Startup Wizard, 11, 15
Step
Temperature, 33
Stop button, 27
Stopping a run, 27
Study Analysis tab, 109, 111
Study Setup tab, 109, 110
Support
Bio-Rad representatives, ii
Technical, ii
Technical Notes, ii
SYBR/FAM only, 45, 60

T
Tab
End Point, 92
Gene Expression, 102
Melt Curve Data, 89
Quantitation, 70, 72
Real-Time Status, 27
Run Information, 96
Study Analysis in Gene Study, 109, 111
Study Setup in Gene Study, 110
Time Status, 28
Target Name, 46
Targets
Experiment Settings, 49, 107
Reaction efficiency (E), 84
Technical
Notes, ii
Specialists, ii
Temperature
Step, 33
Temperature Control
Mode, 37
Temperature control
Block mode, 37
Mode, 37
Threshold
Adjusting, 74
Thresholds
Window, 74
Time Status tab, 28
Toolbar
Data analysis, 70
Main software, 14
Main window, 11
Plate Editor, 42, 43
Protocol Editor, 32
Trace
Adjusting, 82
Color, 82
Style, 82

U
Units, 43
Unpacking instrument, 1
USB
Cable, 138
Connections, 3
USB Key Port, 61
Warning

- Instruments, iii
- Labels, iii
- Labels, safety, iii
- List in manual, ii
- Risk of burning, iii
- Risk of explosion, iii
- Risk of harm, iii
- Safety, iii

Web site, ii
- Gene Expression, ii

Well

- Concentration, 46
- Contents, 46
- Fluorophores, 46
- Groups, 44
- Notes, 46, 48
- Sample Name, 46
- Sample Type, 46
- Target Name, 46

Well groups, 50

- Creating, 50
- Data analysis, 50
- Standard Curve, 50

Well Groups Manager, 44

Well Notes, 48

Well selector

- Data analysis, 75

Window

- Baseline, 74
- Gene Study, 109
- Plate Editor, 42
- Protocol AutoWriter, 37
- Protocol Editor, 31
- Run Details, 25
- Threshold, 74
- Well Groups Manager, 44

Writing conventions, ii